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Installation Guide
Brand and product names mentioned in this manual may be trademarks, registered 
trademarks or copyrights of their respective holders. All brand and product names 
mentioned in this manual serve as comments or examples and are not to be understood as 
advertising for the products or their manufactures.

Software License Agreement and Warranty Information
Contact Miranda for details on the software license agreement and product warranty.

Important Safeguards and Notices
This section provides important safety guidelines for operators and service personnel. 
Specific warnings and cautions appear throughout the manual where they apply. Please 
read and follow this important information, especially those instructions related to the risk 
of electric shock or injury to persons.

Restriction on Hazardous Substances (RoHs)
Miranda is in compliance with EU Directive RoHS 2002/95/EC governing the restricted use of 
certain hazardous substances and materials in products and in our manufacturing 
processes.
Miranda has a substantial program in place for RoHS compliance that includes significant 
investment in our manufacturing process, and a migration of Miranda product electronic 
components and structural materials to RoHS compliance.
It is our objective at Miranda GVD to maintain compliance with all relevant environmental 
and product regulatory requirements. Detailed information on specific products or on the 
RoHS program at Miranda is available from Miranda Customer Support at 
1-800-719-1900 (toll-free) or
1-530-265-1000 (outside the U.S.).

WARNING 

Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any service other than that contained in the operating 
instructions unless you are qualified to do so.
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Symbols and Their Meanings 

General Warnings
A warning indicates a possible hazard to personnel which may cause injury or death. 
Observe the following general warnings when using or working on this equipment:

•  Heed all warnings on the unit and in the operating instructions.
•  Do not use this equipment in or near water.
•  This equipment is grounded through the grounding conductor of the power cord. To 

avoid electrical shock, plug the power cord into a properly wired receptacle before con-
necting the equipment inputs or outputs.

•  Route power cords and other cables so they are not likely to be damaged.
•  Disconnect power before cleaning the equipment. Do not use liquid or aerosol clean-

ers; use only a damp cloth.
•  Dangerous voltages may exist at several points in this equipment. To avoid injury, do 

not touch exposed connections and components while power is on.
•  Do not wear rings or wristwatches when troubleshooting high current circuits such as 

the power supplies.
•  To avoid fire hazard, use only the specified fuse(s) with the correct type number, voltage 

and current ratings as referenced in the appropriate locations in the service instruc-
tions or on the equipment. Always refer fuse replacements to qualified service person-
nel.

•  To avoid explosion, do not operate this equipment in an explosive atmosphere.
•  Have qualified service personnel perform safety checks after any service.

The lightning flash with arrowhead symbol within an equilateral triangle alerts the 
user to the presence of dangerous voltages within the product’s enclosure that 
may be of sufficient magnitude to constitute a risk of electric shock to persons.

The exclamation point within an equilateral triangle alerts the user to the presence 
of important operating and maintenance/service instructions.

The ground symbol represents a protective grounding terminal. Such a terminal 
must be connected to earth ground prior to making any other connections to the 
equipment.

The fuse symbol indicates that the fuse referenced in the text must be replaced 
with one having the ratings indicated.

The presence of this symbol in or on Miranda equipment means that it has been 
designed, tested and certified as complying with applicable Underwriter’s Labora-
tory (USA) regulations and recommendations.

The presence of this symbol in or on Miranda equipment means that it has been 
designed, tested and certified as essentially complying with all applicable Euro-
pean Union (CE) regulations and recommendations.
iv
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General Cautions
A caution indicates a possible hazard to equipment that could result in equipment damage. 
Observe the following cautions when operating or working on this equipment:

•  When installing this equipment, do not attach the power cord to building surfaces.
•  To prevent damage to equipment when replacing fuses, locate and correct the problem 

that caused the fuse to blow before re-applying power.
•  Use only the specified replacement parts.
•  Follow static precautions at all times when handling this equipment.
•  This product should only be powered as described in the manual. To prevent equip-

ment damage, select the proper line voltage on the power supply(ies) as described in 
the installation documentation.

•  To prevent damage to the equipment, read the instructions in the equipment manual 
for proper input voltage range selection.

•  Some products include a backup battery. There is a risk of explosion if the battery is 
replaced by a battery of an incorrect type. Dispose of batteries according to instruc-
tions.

•  Products that have (1) no on/off switch and (2) use an external power supply must be 
installed in proximity to a main power output that is easily accessible.
v
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Preface
Chapter 1 is an introduction to the Master Control Installation Guide. 

Topics
Chapter Structure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
The PDF Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
Terms, Conventions and Abbreviations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
Document Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3

Chapter Structure 
This guide provides installation guidelines for the Miranda master control system. It includes the 
following chapters: 

• Chapter 1, Preface (this chapter) outlines effective ways to use this guide, presents an over-
view of the installation guide. 

• Chapter 2, Introduction (this chapter) outlines effective ways to use this guide, presents an 
overview of the installation guide. 

• Chapter 3, Software Installation, provides information about installation of configuration 
software and the optional GUIs (software control panels).

• Chapter 4, Hardware Installation for MCEs and MCPMs, provides information about the 
mounting and connection of the various pieces of equipment in your system.

• Chapter 5, Configuration for MCEs and MCPMs, provides information about the configura-
tion of master control switchers (MCEs and MCPMs) and control panels, and to some degree, 
the configuration of a connected NV9000 system.

• Chapter 6, Installing and Configuring Imagestore 750s, describes the installation and config-
uration of Imagestore 750s.

• Chapter 7, Maintenance, provides information about maintenance of Master Control equip-
ment.

• Appendix A, References, provides useful reference sections, include a list of “caveats” — limi-
tations, incompatibilities, system requirements, etc., that you must take into consideration. 

An Index and Glossary are also provided.

The PDF Document 
This guide is provided in PDF format, allowing you to use Acrobat’s “bookmarks” to navigate to 
any desired location. You can also easily print a hardcopy. Please note:

• Use the Table of Contents bookmarks to jump to any desired section. 

• Many hyperlinks are provided within the chapters.
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• Use the Index to jump to specific topics within a chapter. Each page number in the index is a 
hyperlink.

• Use Acrobat’s ‘Go to Previous View’ and ‘Return to Next View’ buttons to retrace your com-
plete navigational path. 

Use the ‘First Page’, ‘Previous Page’, ‘Next Page’, and ‘Last Page’ buttons to go to the first, pre-
vious, next, or last page within a PDF file. 

• Use Acrobat’s extensive search capabilities, such as the ‘Find’ tool and ‘Search’ tool to per-
form comprehensive searches as required. 

Terms, Conventions and Abbreviations 
The following conventions are used throughout this guide: 

• The symbol  denotes either an example or a special message.

• Entries written in a bold-face font, in Capital Letters, or enclosed in single quotation marks 
(‘ ’) denote the names of GUI menus and buttons, and on occasion, physical control panel 
buttons and knobs. For example: 

Click ‘Apply’ to . . . 

Press Transition to . . .

• Double quotation marks (“ ”) denote colloquial or informal language. Single and double 
quotes do not have the same meaning.

• Entries written in a monospaced font denote pathnames, parts of your file system, or items 
that you must select or enter, within the scope of Windows XP (or Vista): 

C:\Program Files\Miranda\Master Control\...
• The term “iMC” is the name of the integrated master control system. 

• “MCPM” stands for Master Control Processing Module — a “transition processor” that installs 
in the NV5100MC or NV5128-MC frame. One MCPM provides one master control channel.

• “MCE” stands for Master Control Engine. An MCE is a specific type of MCPM. One MCE also 
provides one master control channel.

• The terms “panel” and “control panel” refer to master control panels, either hardware or soft-
ware. The term “GUI” usually means the iMC-Panel-GUI software control panel.

• The terms “low-tally” and “high-tally” mean low illumination and high illumination for but-
tons and indicators. High-tally generally means selected or active; low-tally means the oppo-
site.

• The term “MC” is an abbreviation for “master control.” The term “MFR” is an abbreviation for 
“multi-format router.” 

Other terms, used occasionally, include the following:

• Intuition XG is a single- or dual-channel graphics processor. The term “Intuition XG” can 
encompass all the hardware and software involved in the Intuition XG component of master 
control.

Note

To display the Acrobat navigation buttons, right-click the Tool Bar area, and check 
‘Navigation’.
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• XMedia is a term that includes different software applications that create and manage 
images, keyers, logos, etc. used by Intuition XG.

• Xplay and the XG Dashboard are software applications under XMedia. Both of these are used 
to configure the Intuition XG processor.

• Oxtel is a division of Miranda. Its name is used to identify certain ports of the Intuition XG 
hardware. A reason for this is probably unobtainable.

• The term “DC21” identifies the master control device controller used for machine control. 
“DC21” is trademark of DNF Controls. 

Document Usage
There are several manuals and user’s guides in the master control documentation set: 

Note the following:

• Control panel operators should read the operator’s guide (for instructions) and the iMC Ref-
erence Manual (to understand system features).

• An iMC-Panel-GUI operator need not read the iMC-Panel-300 manual.

• Operators who control Imagestore 750s should read the Imagestore 750 Reference Manual.

• Administrators should read the documentation for all installed equipment. Although it is a 
large amount of reading, it is essential. 

Configuration Guides and Information

UG0061 MasterConfig User’s Guide How to configure MCPMs and MCEs.

UG0062 MasterDiag User’s Guide How to initialize and update MCPMs and MCEs.

UG0063 MasterLogo User’s Guide How to convert graphic files to the format required by 
MCPM logos and send logos to the MCPMs.

UG0064 iMC Installation Guide How to install, connect, and configure MC equipment.

UG0065 iMC Reference Manual Architectural and functional detail regarding Miranda mas-
ter control systems.

UG0066 MCS Panel Configuration Editor 
User’s Guide

How to use MCS Panel Configuration Editor software to con-
figure control panels.

UG0067 Device Controller User’s Guide How to use and configure the master control device control-
ler.

UG0068 Tally Processor User’s Guide How to use and configure the master control tally processor.

Panel Operator’s Guides

UG0069 iMC-Panel-100 Operator’s Guide for Imagestore 750 3RU control panel

UG0053 iMC-Panel-GUI Operator’s Guide for Imagestore 750 Software control panel

UG0054 iMC-Panel-200 Operator’s Guide for Imagestore 750 Compact panel

UG0055 iMC-Panel-300 Operator’s Guide for Imagestore 750 Full-size panel

UG0070 iMC-Panel-100 Operator’s Guide for MCEs and MCPMs 3RU control panel

UG0057 iMC-Panel-GUI Operator’s Guide for MCEs and MCPMs Software control panel

UG0058 iMC-Panel-200 Operator’s Guide for MCEs and MCPMs Compact panel

UG0059 iMC-Panel-300 Operator’s Guide for MCEs and MCPMs Full-size panel
3



Preface
Document Usage
• The documents do not address the installation or configuration of an NV9000 router control 
system or the installation or configuration of an automation system. 

• If your master control system is to include machine control, configurers should read the 
DC21 Device Controller User’s Guide.

• If your master control system is to support Intuition XG functions, administrators should 
obtain and distribute all Intuition XG documentation and related documents from Miranda.

• The Imagestore 750 is a 1RU “channel branding processor.” It provides one master control 
channel, as do MCPMs and MCEs. For brevity, the term “Imagestore 750” also represents the 
LGK-3901, DSK-3901, and ISM-3901, all of which perform some subset of the Imagestore 
750’s functions.

The terms used here (MCPM, GUI, etc.) will become clearer if you read the introduction to this 
installation guide or the iMC Reference Manual.
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Introduction
Chapter 2 is a broad introduction to the installation of an iMC master control system. 

Topics
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It is important to have an understanding of the capabilities and interactions (and limits) of all 
components in your system before you can properly configure (or for that matter, plan) your 
system. That would include the NV9000 router control system if it is present.

By the time you receive your system and are ready to install it, you (or someone in your 
organization) will have made many of the design decisions already.

This chapter is an overview. For architectural details, refer to the iMC Reference Manual. You can 
skip this chapter if you are already familiar with Miranda’s master control products.

Objective
This document presents installation guidelines because there is no one way to install a master 
control system. Each system is unique and there are many variables. 

There are a few constraints and limits that are not obvious to the uninitiated. This guide points 
out those constraints in the appropriate sections. See Things to Consider on page 204.

One of the many master control options is whether to couple the master control system to an 
NV9000 router control system. This guide will address those issues and address NV9000 configu-
ration to the extent it applies to master control.

If you have used the iMC Quickstart Guide to perform a quick installation, you can use this instal-
lation guide to complete the job and to adjust some of the more advanced features.

After you have performed initial installation tasks, the remainder of the job is configuration. This 
guide is not a configuration manual, but presents some configuration tasks that are important 
during installation. To carry out more detailed or advanced configuration (using the configura-
tion software) you will want to read the configuration manuals.
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Summary 
A master control system is moderately complex, involving a number of hardware components, 
software applications, documentation, computers, networks, and several options. One such 
option is whether to operate the master control switcher in conjunction with an NV9000 router 
control system. 

Figure 2-1 represents the components of a iMC master control system. 

Fig. 2-1: An iMC Master Control System

Master control transition processors are the heart of the master control system. There are three 
broad categories: 

• MCPMs — master control processing modules.

• MCEs — master control engines (called “next generation” master control). 

• Imagestore 750s — “channel branding processors.”

We include the LGK-3901, DSK-3901, and ISM-3901 in the category with Imagestore 750s. 
These processors perform a subset of the functions of an Imagestore 750 and are configured 
the same way. 
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Each MCPM, MCE, Imagestore 750, or -3901 processor is considered a channel. The output of a 
channel is called “program output.” An MCPM or MCE can also produce “preset output” and 
audio monitor output, among other things. MCEs can also produce “preview output” and “aux 
output.” Imagestore 750s can also produce “preset output.” (In the Imagestore 750 Configurator, 
it is called “preview” output.)

Frames
MCPMs and MCEs reside in a master control frame. Imagestore 750s are independent 1RU 
processors and do not require a frame. The LGK-3901, DSK-3901, and ISM-3901 each fit in 2 slots 
of a 3RU Densité frame. 

An iMC master control system can include one or more master control frames. The two types of 
master control frames, NV5100MC, and the older NV5128-MC, are nearly identical, the main 
difference being the midplane. The NV5100MC is the newer frame and provides higher 
throughput. Each frame has 8 input card slots, 8 output card slots, and two control card slots. 
MCPMs and MCEs occupy output card slots. 

Master control frames can also contain relatively small multi-format routers (MFRs). The MCPMs 
and MCEs can work closely in conjunction with the MFR. 

Master control frames have I/O backplanes. Each input card and output card has a corre-
sponding backplane module. The backplane module presents the I/O connectors for the I/O 
card. All I/O backplanes provide 16 signal connections. An SD input card, for instance, has 16 
BNCs. An analog audio card has 4 DB25s. MCPMs and MCEs also have corresponding backplane 
modules.

The master control backplane can receive inputs from (1) local devices such as VTRs, (2) an 
external router controlled by an NV9000 system, or (3) from an MFR in the master control frame, 
or a combination of all of these types of input. 

Panels 
Master control operators use control panels to control transition processors. The transition 
processors and control panels communicate on an Ethernet LAN. The master control product 
line includes both software control panels (GUIs) and hardware control panels. 

Automation 
MCPMs, MCEs, and Imagestore 750s can also be controlled by an automation system. For MCEs 
and MCPMs, that is NVISION Serial Protocol for Master Control (NP0024-00, rev G), and for Imag-
estore 750s, it is the Oxtel automation protocol.

NV9000
A master control system can operate in the context of a NV9000 router control system. The 
routers in the NV9000 system can supply (some of ) the inputs to the master control system via 
the backplane. The NV9000 can be subject to automation. Generally, an NV9000 system has one 
or more router control panels (such as an NV9641).

If the master control system includes an Imagestore 750, an NV9000 system is a requirement.
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An NV9000 control system includes one or two NV9000 system controllers. The NV9000 system 
controller can be connected to the master control frame. It communicates with the control 
card(s) in the master control frame. A NV9000 controller must be connected if the frame contains 
an MFR. Router automation can also control the MFR in the frame. 

Master control can rely on the NV9000 system for 3 elements: salvos, router outputs (and device 
categories and indexes for “router pre-select” functions), and router sources (for “external router 
source” functions and Imagestore 750 inputs). The NV9000 can also act as an SNMP agent for 
the MCPMs and MCEs in your master control system. It is not (yet) an agent for Imagestore 750s. 

Emergency Bypass
All MCPMs and MCEs have an emergency bypass component. This is a switch that can route alter-
nate programming to output when the MCPM or MCE detects a critical problem.

The product family includes an emergency bypass control panel (EBCP) that can be used to 
force an emergency switch. The EBCP provides what could be regarded as a “panic button.” 

See EBCP on page 33 for more information. 

See Linking Two MCPMs as Primary and Backup on page 192 for a way to use the emergency 
bypass inputs.

Intuition XG
Miranda’s Intuition XG processor (with its associated Xmedia software) can be integrated with 
the master control system. An Intuition XG processor can be used by MCEs and can also be 
connected to Imagestore 750s.

The Intuition XG subsystem includes a graphics processor that stores, and plays out, video keys 
on two channels. It can access “live” data including feeds from wire services. 

For MCEs 
The Intuition XG processor delivers from one to four XG media clips simultaneously to one MCE. 
Additional Intuition XG subsystems might be required for multiple MCEs. The Intuition XG 
processor, further, can control an MCE’s squeezeback function and audio overs, and can select 
main sources. 

Intuition XG is not supported by MCPMs.

Intuition XG requires at least one SWB input card in the frame of the MCE with which it 
communicates. 

See Intuition XG on page 78 for hardware installation information and Intuition XG on page 106 
for configuration information. 

For Imagestore 750s
The Intuition XG processor delivers from one to eight XG media clips simultaneously to one 
Imagestore 750. Each Imagestore 750 can potentially be connected to more than one Intuition 
XG processor. 
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Device Controller
MCEs can perform machine control and pre-roll operations. Control panels correspondingly 
might have several machine control and pre-roll buttons. Machine control and pre-roll functions 
are carried out by a DC21 Device Controller on the master control network. The device controller 
can control up to 4 VTRs (or similar devices) with a serial protocol and has the capability of 
controlling up to 16 other devices with start and stop pulses. 

See Device Controllers on page 77 for hardware installation information and Device Controller 
on page 105 for configuration information.

Kaleido-X 
Master control can be integrated with a Kaleido-X multi-viewer (or monitor wall) in such a way 
that master control can trigger a Kaleido-X re-layout. The Kaleido system defines rooms (in which 
a multi-viewer exists) and layouts (the organization of views on the multi-viewer) for each room.

Panel operators can have available ‘Kaleido-X Layout’ buttons that trigger multi-viewer re-
layout. A channel change can also trigger a multi-viewer re-layout. 

Control panels, when they are controlling Imagestore 750s, can cause the source content of a 
monitor wall to change when the operator changes the current source group. In contrast, a 
multi-viewer re-layout changes the organization of the sources on the display. 

Frames 
The NV5100MC master control frame is a metal enclosure that has the following functions:

• It holds MCPMs, MCEs, and I/O cards.

• It communicates with the NV9000 (if present).

• It provides a place to connect inputs and outputs.

• It distributes input signals to the outputs, MCPMs, and MCEs. 

There are two frames available: the NV5100MC and the older, obsolete NV5128-MC. Both are 
8RU (14″) and approximately 18.75″ deep. Each has 16 slots for I/O, MCPMs, and MCEs. Each has 
2 control card slots. 

The NV5100MC frame accepts the same control cards and power supplies, and to some extent 
accepts the same I/O cards as the older frame. The NV5100MC frame has an enhanced mother-
board that allows multiple (single-slot) SWB output cards and provides additional throughput 
for up to 8 HD MCEs. 

You can use a router control card (EM0374) or a simple clock card (EM0414) in either or both of 
the control card slots. A router control card is required if the frame hosts a router (an MFR). You 
can use 2 control cards (or clock cards) for redundancy. If one fails, the other takes over. 

All frames have control system connectors (Ctrl1, Ctrl2, Diagnostic) and AES reference, video 
reference, system alarm, and power supply alarm connectors. They also have aux bus and time 
code reference connectors. The aux bus connector is used when the frame is controlled by an 
SMS7000 system. The time-code reference connector does not apply under master control, but 
might be used by the MFR.

An SMS7000 requires a mezzanine addition to the router control card.

Refer to Control Connections on page 53 for details.
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Each frame has two power supply bays. One power supply is sufficient. Use two for power 
supply redundancy. The power connectors are AC jacks. Each supports 90–130 V, 180–250 V, 
50/60 Hz. The frame may draw 660 W maximum. Customer-replaceable fuses are present on the 
power supply modules (PS6000s). A heavy-duty ground lug is present for safety or regulatory 
compliance.

Each frame has fan unit at top that draws air up through the grill in the door of the frame and 
out through the grill at the rear, top. 

Card Slots
Figure 2-2 is a schematic view of the frame from the top, showing the relative position of the I/O 
cards, control cards, and backplanes, and their relationship to the motherboard. 

Fig. 2-2: NV5128-MC or NV5100MC Frame, Top View, Showing Module Locations

Frames have 8 input slots and 8 output slots. The input slots occur in the middle of the frame. 
The output slots are divided into two groups of four. Each I/O slot handles 16 I/Os. 
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The numbering of the slots is sequential, from 1 to 16, but the connector numbers in slots 13–16 
are in reverse order. These are the connectors numbers, as seen from the rear: 

The various backplane modules differ in their connectors. I/O connectors are DB25s, Phoenix 3-
pin quick-release, or BNCs. All backplane connectors are numbered from 1 at the top to 16 at the 
bottom. This is true regardless of the type of connectors. For example, certain audio backplanes 
have 4 DB25s. The top DB25 presents inputs (or outputs) numbered 1–4, the bottom connector, 
13–16. 

Audio signals are pairs, often stereo pairs. A DB25 connector presents 4 pairs whereas a BNC 
presents one pair.

Connector Numbering Formulas

The “input” number I (1–128) assigned to any input connector C is 

I = (slot – 5) × 16 + C where slot = 5–12. 

The “output” number O (1–128) assigned to any output connector C is 

O = (slot – 1) × 16 + C where slot = 1–4

O = (16 – slot) × 16 + 64 + C where slot = 13–16

The Inverse Formula

Given G (in the range 1–128), any connector C (in the range 1–16) is 

C = [ (G – 1) mod 16] + 1 

MCPMs and MCEs have a variety of connector types, including 1.0/2.3 coax, RJ-45, and D-type 
connectors. Their connectors do not follow any particular sequence and are not numbered. 

Slots

16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

Output Input Output

65 81 97 113 113 97 81 65 49 33 17 1 49 33 17 1

66 82 98 114 114 98 82 66 50 34 18 2 50 34 18 2

67 83 99 115 115 99 83 67 51 35 19 3 51 35 19 3

68 84 100 116 116 100 84 68 52 36 20 4 52 36 20 4

69 85 101 117 117 101 85 69 53 37 21 5 53 37 21 5

70 86 102 118 118 102 86 70 54 38 22 6 54 38 22 6

71 87 103 119 119 103 87 71 55 39 23 7 55 39 23 7

72 88 104 120 120 104 88 72 56 40 24 8 56 40 24 8

73 89 105 121 121 105 89 73 57 41 25 9 57 41 25 9

74 90 106 122 122 106 90 74 58 42 26 10 58 42 26 10

75 91 107 123 123 107 91 75 59 43 27 11 59 43 27 11

76 92 108 124 124 108 92 76 60 44 28 12 60 44 28 12

77 93 109 125 125 109 93 77 61 45 29 13 61 45 29 13

78 94 110 126 126 110 94 78 62 46 30 14 62 46 30 14

79 95 111 127 127 111 95 79 63 47 31 15 63 47 31 15

80 96 112 128 128 112 96 80 64 48 32 16 64 48 32 16
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Motherboard 
The motherboard distributes the 128 input signals from the backplane to the router output 
cards (if any) and to the MCPMs and MCEs (which always go in output slots). Figure 2-3 is a 
simplified block diagram of a sample master control frame. In this example, the MCPM and MCE 
occupy two output slots each, leaving room for 4 router output cards. 

Fig. 2-3: Typical Master Control Frame 

Master control’s input signal formats can be a mix of AES audio, analog audio, analog video, SD 
video, and HD video. The MFR can route time-code signals and machine-control signals. The 
master control (MC) system does not accept signals of these types. 

Each I/O card handles 16 signals. Because audio signals are generally stereo pairs, each audio 
card handles 32 audio channels.

Output cards, MCPMs, and MCEs all share — and compete for — the output slots. A 16-output SD 
video output card consumes one slot. An MCPM-HD requires 4 output slots (an entire output 
bay). Trade-offs must be made during the allocation of slots. Other MCPMs and MCEs require 
fewer slots.

All I/O modules, MCPMs, and MCEs, and their backplanes are “hot-swappable.”

An MFR crosspoint matrix, if present, is distributed through the 128×16 crosspoints of the 
output cards. Please refer to the application notes AN0004 (Routing and Master Control Integra-
tion) and AN0013 (NV9000 System Configurations) for more information. 

Please note:

The MCPM-MK-HD does not receive inputs from the motherboard, but from its own back-
plane. No other MCPM or MCE can use those inputs. 

The MCPM-HD and -HD2 each have an additional crosspoint that, in conjunction with an 
MFR, distribute SWB1 inputs to 32 SWB outputs. SWB output cards fit in the two “wings” of 
the MCPM-HD (or -HD2).
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The MCPM-SDHD has an additional crosspoint that, in conjunction with an MFR, can 
distribute SWB inputs to 16 SWB outputs. SWB output cards fit in the single “wing” of the 
MCPM-SDHD.

Refer to Transition Processors on page 13 for more information. 

Local Input and Router Input 
There are several ways to connect video and audio devices to the frame’s inputs:

• Static, direct or local connection. The video and audio outputs of a device (such as a camera 
or VTR) are cabled to connectors on the frame’s backplane.

• Static, indirect connection. Video and audio outputs of a device have a dedicated connec-
tion, via one or more router(s), to the frame’s backplane.

• Dynamic, router pre-select connection. A large number of router sources are available for 
explicit selection. The connection requires that a router destination (one or more router out-
puts) be cabled to the frame. (Control connections to the NV9000 system are also required.)

The master control operator must actively browse router sources to choose a source. The 
operator must also “take” the source to the destination connected to the frame.

The operator can select from potentially thousands of router sources.

• Dynamic, external router source connection. Specific router sources are available for transpar-
ent selection. An MCPM configuration designates some video or audio sources as external 
(i.e., from the NV9000) and others as local (i.e., connected at the frame’s backplane). All exter-
nal sources reach the MCPM through a specifically configured set of the frame’s ports. 

A master control operator need not know which sources are external and which are not. The 
mechanism for accessing the router source is automatic and hidden from the operator.

The operator can select from a limited number of router sources.

See Router Pre-Select on page 69 and External Router Sources on page 70 for more information.

Connectors
At the rear of the frame are a variety of connectors:

Refer to Control Connections on page 53 for details.

Some of the connectors are used when a router is present in the frame and are not necessarily 
useful for master control. 

There is (for the most part) one of each type of connector for each of the 2 possible control card. 

Transition Processors
Transition processors include MCEs, MCPMs, and Imagestore 750s. MCEs and MCPMs require a 
master control frame. Imagestore 750s are independent 1RU devices and do not require a frame.

Serial Ports Video Reference System Alarms

Ethernet Ports Aux Bus Power Supply Alarms

AES Reference Time Code Reference Power
13
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Transition Processors
MCEs and MCPMs
There are several models: 

All MCPMs and MCEs have common characteristics, such as audio meter/monitor outputs, 
general-purpose I/O, and emergency bypass capability. 

Refer to MCPM Comparison on page 176 for a table of differences. 

Notes
Use MasterConfig to configure MCPMs and MCEs. 

Use MasterDiag to assign an MCPM or MCE its IP address. (MasterDiag requires a straight-
through DE9 male-female cable for MCPMs and requires a custom cable for MCEs.) See MCEs on 
page 73 for the MCE cable diagram.

An MCPM has two parts: the processing module itself and its “backplane module” which 
presents the I/O connectors. MCEs have one backplane module for each card (up to 3) in the 
MCE.

The MCPM-MK-HD receives video input from its backplane module. All other MCPMs receive 
video (and audio) input from motherboard of the frame in which the MCPM is placed.

If an MCPM-HD, -HD2, or -SDHD contains a wing output card, each output card also requires a 
backplane module. 

Each MCPM or MCE is functionally independent. Each has its own network port, automation 
port, and video reference port. However, all MCPMs and MCEs share the frame’s motherboard 
and input modules.

MCEs have internally terminated reference connectors. MCPM reference connections are not 
internally terminated and provide loop through to other devices. MCPM reference connec-
tions require external termination.

MCPMs and MCEs occupy output slots. You can have as many as you can fit in a frame. (For 
example, an MCPM-HD takes 4 slots. You can have two MCPM-HDs in a frame.) 

MCEs range from 1 to 3 cards. A 3-card MCE takes 3 slots. You can have two in a frame, with one 
slot remaining for some other module in each output bay. 

The NV5100MC frame allows eight 1-slot MCEs. 

MCPM-SD SD video, 3 keyers, 2 logos, 1 squeezeback generator, 2 slots. 

MCPM-HD, 
MCPM-HD2

HD video, 3 keyers, 2 logos, 1 squeezeback generator, 4 slots. Supports 2 
wing output cards.

MCPM-SDHD HD or SD video, field-programmable. 3 keyers, 2 logos, 1 enhanced squee-
zeback generator, 4 slots. Supports 1 wing output card.

MCPM-MK-SD SD video, 3 keyers, 1 logo, no squeezeback, 1 slot. These modules are also 
called “mixer/keyers” or “branding engines.”

MCPM-MK-HD HD video, 3 keyers, 1 logo, no squeezeback, 2 slots. These modules are also 
named “mixer/keyers” or “branding engines.”

MCE HD or SD video, field-programmable. 3 keyers, 2 logos, squeezeback, 1–3 
slots. The availability of “next generation” features depend on the number 
of modules present. 
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MCEs
MCEs are advanced MCPMs. MCEs perform all the functions of the earlier MCPMs and provide 
additional capabilities. The most prominent added features are the preview bus and the aux bus 
and 16-channel audio. The preview bus and aux bus give an operator freedom to experiment 
without affecting the delivered program output.

MCEs are also modular, comprising from 1 to 3 circuit boards and a number of optional daughter 
cards. There are 5 modules in the MCE card set: 

• MCE-CORE. The minimum MCE comprises this single (full-size) card that performs core mas-
ter control functions.

• MCE-PVW. The preview module supports the preview bus. 

• MCE-AXM. The audio expansion module provides Dolby E decoders for the program and 
preset buses and presents Dolby E metadata and AES output (the 8 channels for each of the 
program and preset buses and 8 channels for monitor A) at its backplane. 

• Main sources in MCEs can be configured with or without Dolby E encoding, and with dual 
Dolby encoding. The MCE can be configured with dual Dolby decoders in two ways:

• Dual decoders for program and preset main sources and for program and preset overs.

• Dual decoders for program, preset, and preview main sources.

• This of course depends on the number of Dolby decoders in the MCE-AXM card:

• MCE-DVE. The digital video effect cards are small mezzanine cards that can be added to the 
core and to the preview boards for video effects. 

• Dolby E. These are third-party Dolby E processors. Up to 8 Dolby cards mount on the MCE-
AXM board, depending on your needs. 

MCEs have features that work in conjunction with the iMC-Panel-200, iMC-Panel-300, iMC-Panel-
GUI, and with older panels such as the CECP. MCEs also work in conjunction with the (new) video 
and audio timing page of MasterDiag.

MCEs have inputs and outputs similar to those of other MCPMs, such as audio meter outputs, 
GPIO, clean-feed outputs, and emergency bypass inputs. All MCEs have a reset switch, a bypass 
toggle (for the emergency bypass relay) and an diagnostic port at their front. 

Differences 
Notable differences between the MCEs and MCPMs include:

• MCE audio and video connectors are coax (1.0/2.3 DIN) connectors; MCPM audio and video 
connectors are BNCs.

DIN-to-BNC breakout panels are available. The part number for these 1RU panels is 
NV5100MC-BOP. Each BNC connector on the panel is coupled to a 2 m cable with a DIN 
connector.

• MCEs have 2 clean feed outputs; MCPMs have 1 clean feed output.

• MCEs have 2 aux outputs and 2 (video) source inputs; MCPMs do not have these.

• Most MCE outputs (video or audio) carry 16 embedded audio channels. The exception to 
this is that the MCE-AXM backplane provides 24 AES outputs (12 pairs). MCPM audio output 
varies depending on the output. Certain MCPMs offer analog audio monitoring output.

• MCEs have preview and aux buses. MCPMs do not. 
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• The diagnostic port (for MasterDiag) uses 3 pins of a 6-pin Phoenix connector. The diagnos-
tic port of an MCPM is a DE9 connector.

• MCEs support machine control, pre-roll, and audio macros. MCPMs do not.

• MCEs can be integrated with an Intuition XG subsystems, and play out XG media clips. Intu-
ition XG is not available for MCPMs.

There are other minor differences. 

Imagestore 750s
The Imagestore 750 is an independent transition processor (also called a “channel branding 
processor”) that can operate as a stand-alone unit with or without automation, or as part of the 
iMC master control system. In the context of the combined master control system, it operates in 
conjunction with an NV9000 router control system that provides video and audio sources and 
one or more master control panels, such as the iMC-Panel-200, that provide commands. The 
Imagestore 750 issues switching instructions to the NV9000 when it receives commands from a 
master control panel.

The Imagestore 750 is essentially an A/B transition processor that inserts video effects (DVEs and 
DSKs) and voice-overs into its output. It has many configuration options. The software used is 
the “Imagestore 750 Configurator.” 

Note that a particular version of this software is required for operation in the context of an 
iMC master control system: at present, it is v4.5. 

Version 4.5 of the Imagestore 750 is required. 

Inputs and outputs of the Imagestore 750 include: 

• Four SDI inputs, A, B, C, and D. These accept HD and SD input.

• Two external keyer pairs (fill and key). Inputs C and D can be used for a third keyer pair.

• A GPIO connector that supports 16 GPIO ports (each configurable as an input or an output), 
LTC, and Dolby metadata.

• 16 AES inputs and 16 AES outputs.

• Four SDI outputs (program, preview, clean-feed, and monitor).

There are also 4 COM ports and 2 Ethernet ports.

Features
The Imagestore 750 has two video processing paths, program and preview. The program path 
has an A/B mixer, 4 downstream keyers (DSKs) and an optional DVE processor. The preview path 
has all these modules except the A/B mixer. 

After audio is disembedded, the audio processing path includes an A/B mixer for 16 audio chan-
nels and two voice-over processors, also for the 16 channels. Audio is re-embedded in program 
and preview audio after processing. 

The model also includes a clean-feed (video) output and a (video) monitor output. There are 
many selectable tap locations for these outputs. 

Details
Each input (A, B, C, D, Fill1, Key1, Fill2, and Key2) can be individually selected as an SDI input or 
one of 5 test signals. (Each SDI input can be subject to a rectangular clipping mask.) 
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Both the A and B side of the A/B mixers can connect to any of the inputs (A, B, C, D, Fill1, Key1, 
Fill2, and Key2). Similarly, any of the DVEs can connect to any of those inputs.

The DVEs can also accept the output of the A/B mixer. The DVE output (either DVE1 or DVE2) can 
be inserted in the processing path in one of 3 places: before DSK1, before DSK2, or before DSK3. 
The DVE processing section is a purchase option. The DVE processor can be bypassed if it is 
installed.

The Imagestore 750 has storage supporting internal keyers (logos, etc.). Inputs C and D can be 
used as external keyer (fill3, key3) inputs. 

The preview output can present video from one of several different tap points. Similarly, the 
clean-feed (CLN) output and the monitor (MON) outputs can present video from several 
different tap points.

Audio is disembedded from SDI sources, sent to the audio processing section, and re-
embedded on output. The audio is re-embedded in the PGM, PVW, CLN, and MON outputs.

LGK-3901, DSK-3901, and ISM-3901
The iMC master control system can control the LGK-3901, DSK-3901, and ISM-3901. These are 
transition processors that fit in a 3RU Densité frame. These units provide a subset of the func-
tions of an Imagestore 750. The iMC master control system treats these units as if they were 
Imagestore 750s and the documentation includes them in discussions of the Imagestore 750. 
They are configurable using the Imagestore 750 Configurator and each has a browser applica-
tion (for remote management) that is similar to the browser application for the Imagestore 750.

Control Panels
Presently there are 3 hardware control panels and 1 software control panel (GUI): 

In most cases, a panel’s function buttons have dynamic legends and change color and bright-
ness as required to indicate the function state. For example, a source selection button turns red 
if the source is disconnected or LOS. A source button turns bright (generally green) when its 
source is selected.

iMC-Panel-GUI A software control panel, also called the “GUI.” This panel runs on a PC and 
has a graphical user interface. The GUI is a software emulation of the iMC-
Panel-200. The GUI is designed to operate with (or without) a touch-sensi-
tive screen.

iMC-Panel-100 A 3RU rack-mountable button panel with a separate display. The button 
panel is slim (less than 4″ in depth). The display is third-party equipment. 
The panel’s firmware supports the Planar PT1945R touchscreen and other 
VGA non-touchscreen displays. 

iMC-Panel-200 A compact hardware control panel that has a large LCD touchscreen, many 
function buttons, and a joystick. The iMC-Panel-200 mounts on a desktop 
or work surface. All buttons have LCD legends and color-coding. 

iMC-Panel-300 A “full-size” control panel that has a large LCD touchscreen, many function 
buttons, and a joystick. The iMC-Panel-300 mounts on a desktop or work 
surface. All but 2 buttons have LCD legends and color-coding. 
17



Introduction
NV9000
The iMC-Panel-GUI emulates the iMC-Panel-200. The GUI has no physical controls and no GPI 
terminals (obviously) but it can be used on touch-screen PCs as well as traditional PCs (or laptop 
PCs) that use keyboards and pointing devices such as a mouse. 

The panels usually have fewer than 16 physical source buttons. The GUI and the iMC-Panel-200 
have a set of 16 “virtual buttons” that can be mapped to physical buttons by the use of a “bank 
selection” button. The iMC-Panel-300 does not.

The panels, when controlling an Imagestore 750, can have ‘Group Select’ buttons which support 
a number of source groups defined in the Imagestore 750 configuration. When a source group is 
selected, the Imagestore 750 can switch a monitor wall to display those sources. The panel must 
be configured to support the monitor wall. 

Both the control panel and an MCE or MCPM under control must be configured to support 
router pre-select if the operator is to be able to perform router pre-select. See the iMC Reference 
Manual for more information.

See Panel Comparison on page 177 for additional information.

GUIs
An important point — easily overlooked — is the way GUI configurations are “loaded.” A hard-
ware panel requires its configuration to be uploaded to the panel. The GUI requires a specifically 
named configuration file in the same folder as the GUI executable program.

Three GUIs, the iMC-Panel-GUI, the older CECP GUI, and the older Aux/Preview GUI, share the 
same file name: cecp_gui.exe. The three GUIs also share the same configuration file: 
cecp_gui.uicfg. The name of this file must not change. 

If you are to run multiple GUIs on the same PC, or even multiple copies of the same GUI, you 
must keep the instances in separate folders. Each folder would contain the executable file and 
the configuration file. The configuration file name must always be named cecp_gui.uicfg. 

NV9000
A master control system can operate in the context of a NV9000 router control system. If your 
master control system does not, you can ignore this topic.

An NV9000 system is required if your master control system includes Imagestore 750s.

An NV920 — a member of the NV9000 family of system controllers — is also suitable. 

NV9000 Control System
The control system itself is software. This software receives commands from NV9000 control 
panel operators, sends them to the routers in the system, and forwards the status responses 
back to the control panel operators. 

The software executes on an NV9000 (or NV920) system controller, either in a stand-alone system 
or on one of the two system controllers in a redundant system. 

The configuration that the NV9000 system uses is maintained as an SQL database. Master 
control configurations reference the source devices, destination devices, and salvos defined in 
the NV9000 configuration by their SQL record numbers (IDs). When you view an NV9000 config-
uration in NV9000-SE Utilities, you will see the IDs in almost every table. 
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The IDs are important when a master control system is connected to a NV9000 system.

NV9000 System Controller
The NV9000 system controller is a 2RU device that has multiple connectors at the rear. There are 
3 versions of the NV9000. The -00 version is obsolete now, and typically has its Ethernet NICs at 
the top. The -02 and -10 versions are newer and have their Ethernet NICs at the bottom. 

It is possible to reconfigure the function of the Ethernet NICs and their IP addresses. Therefore, 
this guide refers to the default NIC functions and addresses. 

This diagram identifies the default NIC ports in the -02 and -10 versions: 

This diagram identifies the default NIC ports in the obsolete -00 version: 

There are stand-alone or redundant systems. A redundant system includes a primary controller 
and a secondary controller. (A redundant pair is cross-connected on the control net.) 

(The -10 version also has several other internal features that are of little concern.)

Panel/Router 1

NV9000 System

Master Control
Panel/Router 2

Control Net

House Net

COM1 (RS-232)

NV9000 System

Master Control

Panel/Router 2
Panel/Router 1

Control Net

House Net

COM1 (RS-232)
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NV920 System Controller
The NV920 resides in a 1RU frame that contains one or two NV920 system controllers. Each 
system controller has a set of connectors: 

Typically you would use one network port for routers and router control panels, the second for 
master control, and the third for your house network. 

MFR
An MFR (multi-format router, in the frame) can stand alone or be used as an integral part of the 
master control system.

Refer to the NV5128 MFR User’s Guide for additional information. 

Also refer to the application notes AN0004 (Routing and Master Control Integration) and 
AN0013 (NV9000 System Configurations). 

“Glue”
Typical systems include many miscellaneous devices, such as distribution amplifiers, sync gener-
ators, signal converters, etc. This document does not address such equipment and assumes that 
you will have provided it when and where it is needed.

SNMP 
The NV9000 system has an agent that can handle a master control MIB. The master control 
processors (MCEs and MCPMs) report to the master control MIB. The NV9000 agent would 
report to your SNMP manager (if you have one). The master control MIB is licensed software 
(EC9610) that can be unlocked if you choose to purchase the license. Refer to the NV9000-SE Util-
ties User’s Guide for information regarding SNMP. 

The NV9000 is not (yet) an agent for Imagestore 750 SNMP.

UniConfig and MRC
UniConfig and MRC (Miranda Router Configurator) are the applications for configuring routers 
and router partitions either in the MFR in the master control frame or in external routers 
controlled by the NV9000 system. 

If you understand NV9000 architecture (and know what you want to accomplish), using 
UniConfig takes about a minute for each router and thereafter need not be used. 

Net 1

Net 2
Net 3Monitor 

Port
USB Ports

(Keyboard,
Mouse)
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MRC is a larger application and handles many complex router issues, but only for the 
NV8500 family hybrid routers.

MFR 
You may skip this section if you have no MFR in your NV5100MC frame. If you have an MFR, you 
must also have a router control card (EM0374) in the frame.

This is the recommended procedure for using UniConfig to set up your router control card:

1 Connect a COM port of your configuration PC to the DE9 port at front of the router control 
card. (The port is RS-232 at 9600 Baud.)

2 Launch UniConfig. Choose serial mode. 

(The Uniconfig installer is on Miranda’s SB0033 software and documentation CD. Contact 
Miranda if you need to obtain this CD.)

3 In UniConfig, set the IP address and subnet mask of the control card. It is simple to do. Read 
the UniConfig documentation if you need it. The IP address you assign must be unique on 
the NV9000’s panel/router network you have chosen to use for the MFR. 

Remember to first read the data from the control card and then to write the new data to the 
control card.

4 In UniConfig, define the partitions and switchpoint settings of the MFR. 

For the MFR, Uniconfig supports 8 partitions (not 4) and allows mono partitions.

Use UniConfig if you want to change the video reference between redundant and dual-refer-
ence modes. The option is useful only if your frame has two video reference signals. If it has 
only a single video reference, the choice in Uniconfig does not matter.

Thereafter, it is possible to use UniConfig through the card’s Ethernet port which is at the rear of 
the master control frame. Your configuration PC must be assigned an IP address on the MFR’s 
panel/router network and it must be connected to the panel/router network while you are 
performing the control card configuration. 

Other Routers
You (or someone in your organization) will use UniConfig (or MRC) to set up and configure the 
video and audio routers in your NV9000 system. Router setup is mostly outside the scope of this 
document. 

The process for setting up any router (in UniConfig) is similar to the process described above for 
an MFR. 

NV9000-SE Utilities
NV9000-SE Utilities (SE, for short) is the software for configuring the NV9000 system itself. 
Portions of the NV9000 configuration must match the partition information set up in UniConfig. 

You (or someone in your organization) will use SE to define source and destination devices, 
device categories and indexes, level sets, and salvos, among other things. Master control 
systems that communicate with an NV9000 system controller make use of source and destina-
tion IDs, device categories and indexes, and salvo IDs. 
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Master control can use up to 10 NV9000 device categories and the indexes within those 
categories. It does not recognize category suffixes. The NV9000 configuration must accom-
modate this minor limitation of the master control software. 

I/O Cards
Master control frames contain video- and audio-format input cards. Its MCPMs and MCEs are its 
output modules. Some MCPMs (-HD, -HD2, -SDHD) accommodate “wing” output cards. A multi-
format router (MFR) uses output cards and the wing output cards of MCPMs that have them. See 
the MCPM chapter of the iMC Reference Manual for a discussion of wing output cards.

This table lists the I/O cards and backplanes related specifically to master control. 

SWB cards support both HD and SD video. 

The input cards in group A work in all input slots of NV5128-MC frame. They do not work in slots 
5–8 of the NV5100MC frame. (Keep in mind that frame slots 5–12 are input slots 1–8.)

The SWB input card in group B works in all input slots of the NV5100MC frame. Any cards in slots 
5–8 must be SWB input cards. These cards consume more power (25W) than the SD video cards 
(17W), so it would be prudent to use the SD video cards in slots 9–12 if you require additional SD 
video. 

The MCPM-HD, -HD2, MCPM-SDHD, and MCE require video in slots 5–8 and audio in slots 9–16. 
These processors are consistent with the division of the input slots. It is only when you are using 
an MCPM-SD or MCPM-MK-SD that any complication occurs. That is because the SD processors 
allow audio in any slot and video in any slot. 

The MCPM-MK-HD does not receive input from the motherboard and so does not use any 
input cards. Its 16 BNCs support HD (and not SD or 3Gig) video for its exclusive use. 

The NV5100MC frame allows multiple (single-slot) SWB output cards. The NV5128-MC frame 
allows one. 

The NV5100MC frame provides throughput for up to 8 HD MCEs. The throughput of the 
NV5128-MC is less. 

Group Card Part No Backplanes

A Analog Audio NV5000-AA-IN IO5000-AA-IN (DB25)

AES Audio NV5000-SA-IN IO5000-AES-IN-TP / IO5000-AES-IN-BNC

Analog Video NV5000-AVC-IN IO5000-AVC-IN

SD Video NV5000-SD-IN IO5000-SD-IN

SWB Video (input) NV5000-HD-IN IO5000-HD-IN

SWB Video (output) a

a. This SWB output card fits in the wing slots of an MCPM-HD or -HD2 or MCPM-SDHD. 

NV5000-HD-OUT IO5000-HD-OUT

B SWB Video (input) NV5100MC-SWB-IN IO5100MC-SWB-IN

SWB Video (output) b

b.Any output cards belong to the MFR, if it is present in the frame.

NV5100MC-SWB-OUT IO5100MC-SWB-OUT
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Summary for NV5100MC
Use only SWB cards in slots 5–8. 
Use any card in slots 9–12.
The frame supports up to 8 HD MCEs. 

Summary for NV5128-MC
The NV5128-MC can have at most 1 SWB card. 
SD input cards and audio cards for SD can go in any slot. 
HD input cards go in slots 5–8. Audio cards for HD and for MCEs must go in input slots 9–12.

MFRs can use other types of cards (in NV5128-MC frames only), including those that would inter-
fere with master control. Avoid using such cards. See the NV5128 MFR User’s Guide for 
information.

Cases 
Case 1: An MCPM-SD with 128 SD inputs all having embedded audio. 

The frame must be an NV5128-MC.
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Case 2: An MCPM-HD with 64 HD inputs, an MCPM-SD with 32 inputs, and 32 audio inputs. The 
frame may be an NV5128-MC or an NV5100MC. 

Case 3: An MCE with 64 HD or SD inputs, and 64 audio inputs. The frame must be an NV5100MC. 
Audio may be embedded or discrete as required. 

Other arrangements are possible. 
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MCPM-SDMCPM-HD 2 SD 
Input 
Cards

2 Audio Input Cards

Note that the MCPM-HD is a 
4-slot module but its back-
plane module occupies only 
two slots. The other two 
backplane slots would be 
used for SWB output back-
planes if the MCPM-HD 
were to include wing out-
put cards. 
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Analog Audio 
Master control (and the MFR) route only AES audio, at 48 kHz with 24-bit sample values. Each 
analog audio card (and its backplane) converts analog audio to AES format and processes 16 
stereo (i.e., 32 mono) signals.

Analog Audio Input Module 
The module is designed for balanced analog audio signals. 

On-board DIP switches allow the gain of each channel to be raised +6dB to accommodate low-
level or single-ended input channels. See Analog Audio Switches and Jumpers on page 179.

System clocks are supplied by the frame’s control card. The conversion rate is nominally 48 kHz. 
The frame can be locked to an external AES reference. 

The backplane module for analog audio input has 4 DB25 connectors. Each connector handles 4 
stereo pairs or 8 mono signals. 

Each connector requires a DB25 breakout cable (WC0053, or your own).

Analog Audio Output Module 
The analog audio output card is the matching analog audio output card. It is used with the MFR, 
but is not used for master control. 

The backplane module for analog audio output also has 4 DB25 connectors. Each connector 
handles 4 stereo pairs or 8 mono signals. 

Each connector requires a DB25 breakout cable (NV5000-CABLE1, or your own).

AES Audio 
Master control requires synchronous AES audio. An MFR can use asynchronous AES cards. 

AES input cards provide 16 AES channels of input.

AES backplanes are available in two types: BNC, for unbalanced signals on BNC cable, and 
Phoenix 3-pin quick-release connectors for balanced, shielded twisted-pair signals. 

Synchronous AES Input Module 
AES signals, balanced or unbalanced, arrive at the input card from the appropriate backplane 
module. The card extracts timing information from the signals on the input receivers. The card 
uses the timing information to format the data and to correct timing errors. The card can accom-
modate nearly synchronous input signals by either deleting or repeating samples to bring the 
signal into synchronization. 

One of the AES input backplane modules has 16 Phoenix connectors for balanced signals. The 
other has 16 BNC (75Ω) connectors for unbalanced signals.

Synchronous AES Output Module 
The AES output card is the matching synchronous AES output card. It is used with the MFR, but 
is not used for master control.

One of the AES output backplane modules has 16 Phoenix connectors for balanced signals. The 
other has 16 BNC (75Ω) connectors for unbalanced signals.

Asynchronous AES input cards exist for the MFR but are not used under master control.)
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Analog Video 
The Analog Video Conversion (AVC) input card converts incoming composite analog video 
signals (NTSC or PAL) to SD video. 

MCEs do not accept analog video input (even though it is converted to SD at the input card). 
SD MCPMs do. Because analog video input is not defined for HD, HD MCPMs also do not. 

Analog Video Conversion Input Module
Each of the 16 composite video inputs from the backplane module is received by a differential 
input amplifier. The single-ended outputs of these amplifiers are passed to anti-aliasing filters 
before being processed by a video converter. The outputs of the converters are then passed to 
an SMPTE 259M formatter. A PLL locked to the video converter reduces jitter in the data format-
ting process.

See Analog Video Conversion (AVC) Card Switches on page 182.

The input processing delays the signal by approximately 1.25 lines. AVC modules are 
intended for use in applications where signal timing is not critical. 

The AVC input backplane module has 16 BNC connectors.

Analog Video Converter Output Module 
This card is the “inverse” of the AVC input module. It is used with MFR, and not for master 
control. The AVC input backplane module also has 16 BNC connectors.

SD Video 

SD Video Backplane and Input Module 
The backplane performs cable equalization for up to 300 m of Belden 1694A or equivalent cable. 
The equalizer also has a muting function that prevents digital noise in the output in the absence 
of a valid signal. Inputs are self-terminating. 

The SD input backplane has 16 BNC connectors. 

SD Output Module
This card is the “inverse” of the SD input module. This older cards reclock at several SD rates, 
including 270 Mps. 

The SD output backplane has 16 BNC connectors. 

SWB Video 
The NV5128-MC and NV5100MC frames differ in their support for SWB video.

The NV5100MC frame is newer and provides more throughput for HD channels. It supports any 
number of SWB cards. The limit is the number of input or output slots which is 8.

The NV5128-MC frame supports up to 4 of the older SWB output cards that mount in the wings 
of MCPM-HDs, -HD2s, and -SDHDs (and the old SWB output modules). The NV5128-MC frame 
also allows 1 (only) new SWB output card. 

(Without the MFR, there is no reason to have output cards of any kind.) 
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Old SWB 16-Input Backplane and Input Modules 
The SWB input card accepts a wide range of data rates, both HD and SD. 

The SWB backplanes contain active circuitry that performs cable equalization (up to 150 m).

SWB input cards support 16 inputs. An SWB input card buffers the automatically equalized 
inputs from the backplane and feeds the 16 input signals to the motherboard.

New SWB 16-Input Backplane and Input Modules
The SWB input card accepts a wide range of data rates, both HD and SD. 

The SWB backplanes contain active circuitry that performs cable equalization (up to 150 m).

SWB input cards support 16 inputs. An SWB input card buffers the automatically equalized 
inputs from the backplane and feeds the 16 input signals to the motherboard.

The new SWB input cards can feed more than one MCE. 

At least one SWB input card (and backplane) is required for Intuition XG integration.

Old SWB Output Module 
This module is a special card that plugs into a wing slot of an MCPM-HD, -HD2, or -SDHD. The 
module also fits in the wing slots of an NV5000-HD-XPT/OUT output module (when an MFR is 
present).

In either case — master control or MFR — the output card is part of the MFR’s crosspoint matrix. 
The old SWB output card supports a number of reclocking rates. 

When an MFR is present, it can use the SWB output card for routing HD, SD, and even asyn-
chronous AES signals. 

The MCPM-HD and -HD2 provide 2 wing slots; the MCPM-SDHD provides 1 wing slot. 

The SWB output backplanes have 16 BNC connectors. Even though the SWB output cards plug 
into the wing slots of another module, they require backplanes.

New SWB Output Module 
The NV5100MC-SWB-OUT is a newer output card designed to work especially well in the 
NV5100MC frame. Any number of these output cards can be used in an NV5100MC frame. Only 
one of these cards can be used in an NV5128-MC frame. The card does not plug into an MCPM 
wing slot.

The output card is, as previously stated, part of the MFR crosspoint matrix. The new SWB output 
card reclocks at 270 Mbps, 1.485 Gbps, and 1.5 Gbps.

When an MFR is present, it can use the SWB output card for routing HD, SD, and asynchro-
nous AES signals. 

The SWB output backplanes have 16 BNC connectors.
27



Introduction
Control Cards
Control Cards
A master control frame requires one or two control cards. Control cards can be of two types: 

• EM0374 router control card. 

• EM0414 clock generator card. 

The EM0374 is required only if you have an MFR in the frame. The frame has two control card 
slots. One of the slots for a redundant (or secondary) control card.

In all case, the control cards provide clocks and AES reference signals to the MCPMs. 

The MFR (if present) receives commands from a router control system through the router control 
card. 

MCPMs and MCEs receive instructions directly from control panels or automation and not 
through the control card. They are independent modules and, although they receive clocking 
from the control card and video and audio from the motherboard, they are controlled 
independently.

EM0374
The EM0374 includes a backup battery. The battery may be replaced with the control card 
powered on without affecting the operation of the system.

Flash memory stores FPGA code and application program(s), including protocols for communi-
cating with the external control system. Using UniConfig to program the control system 
protocol is a quick and relatively easy process. 

A pair of EEPROMs are located on the motherboard — one for each control card. The EEPROMs 
store UniConfig settings and other system parameters. Thus, any control card can be installed in 
the frame without reconfiguration. The configuration stays with the frame.

The control card includes processing circuitry for the video and AES reference inputs. 

Its Ethernet NIC is auto-negotiating. All ports of the control card may be used simultaneously.

See EM0374 Jumpers on page 178 for more information.

EM0414
The EM0414 is an AES clock generator card. It also includes processing circuitry for the video and 
AES reference inputs. It does not perform any router control functions. It does not have an 
Ethernet circuit. It requires no configuration other than jumper settings.

See EM0414 Jumpers on page 179 for more information.

Power Supply 
The PS61002 power supply module accepts a wide range of AC input voltages and produces five 
identical outputs. The power supply senses the AC input voltage (90–130 or 180–250VAC, 50 or 
60 Hz) and adjusts itself to maintain a relatively constant DC output. You do not have to make a 
voltage selection.

2. Some master control frames in the field might still use PS6000 power supplies.
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The five regulated outputs are directed to the various modules in the frame where on-board 
regulators produce the DC voltages required by the local circuits. Each 48V output powers one 
of the five green LEDs and output test points on the front of the power supply. 

Under normal operation, all five LEDs should be on. When the power supply output voltages are 
measured at the test points, the voltage should be approximately +48VDC under a full load. If 
power supply modules have been removed from the frame or options are not installed, some or 
all of the test point voltages could be somewhat higher than +48 VDC.

There are four low-speed fans located along the front edge of the power supply. They are 
intended to pull a small quantity of air across the internal heat sinks.

Fuse
A replaceable AC fuse cartridge is used on the PS6100 power supply modules. The correct fuse is 
15A (1.25″ × 0.25″ fast-blow). 

The correct fuse for the older PS6000 power supply is given in this table: 

Figure 2-4 shows the location of the fuse on either power supply module.

Fig. 2-4: Fuse Location, PS6000 or PS6100 Power Supply

Replacing the fuse without determining what caused it to fail could cause equipment 
damage or fire by restoring power to an already damaged unit.
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Power LEDs GND Test Points

90–130VAC 8.0A, 5×20 mm, slow-blow fuse

180–250VAC 6.3A, 5×20 mm, slow-blow fuse
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Intuition XG with MCEs and MCPMs 
Intuition XG is a master control option. Intuition XG systems can stand on their own indepen-
dently. Master control is enhanced by it but does not require it. 

The Intuition XG system is an “advanced HD/SD graphics processor.” 

When it is integrated with an iMC master control system, the Intuition XG processor feeds HD or 
SD keys (fill and key video inputs with up to 16 audio channels) to MCEs. It is a single- or dual-
channel graphics processor that provides multi-level character generation, and animation, still, 
and clip playout with multi-channel audio. The Intuition XG processor can also control an MCE’s 
squeezeback functions, audio overs, and main sources. 

With these features, Intuition XG adds what can be called “rich branding” to the MCE.

Intuition XG is associated with a set of configuration tools and graphics generation applications. 
These tools generally belong to Miranda’s ‘Xmedia’ product series.

One of the most significant aspects of the Intuition XG processor is that it can process “live” data:

• Multiple databases files, RSS feeds, and web data. 

• Proprietary data feeds, including Reuters, AP, SportsTicker, and Bloomberg.

Intrinsic Features 
• HD and SD character generator.

• Text and graphics on multiple layers.

• Large capacity storage.

• Simultaneous playout of multiple clips.

• One or two outputs. SD output as NTSC or PAL. HD output as 1080i, 720p or 480p.

• Full integration with the Xmedia suite for graphics automation.

• 16-channel audio.

• Automation. 

Integration with MCE
The XG processor delivers two channels of HD or SD video (each with fill and key and up to 16 
audio channels) to the MCE. Audio reaches the MCE through the keyer fill input dedicated to the 
XG channel. The audio from the keyer input is handled internally (and can be selected by panel 
operators) as a special audio over named “XG over.” The program XG over uses the same BNC 
input as the keyer used for the XG layers on the program bus. The preset (or preview) XG over 
uses the same BNC input as the keyer used for the XG layers on the preset (or preview) bus.

The MCE configuration can specify that the XG over turns on (or off ) when the keyer assigned to 
the XG channel turns on (or off ) — unless the XG over was selected independently. 
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The MCE can control up to 4 XG layers. Each layer corresponds to an XG media clip (identified by 
a recall ID). In general, recall IDs must be in the range 1–65535. However, if you are using a 
legacy M2100 automation protocol, recall IDs must be in the range 1–255 (a single byte). 
Miranda’s NVEP automation protocol can use the full range 1–65535.

Master control does not recognize recall IDs that are blank or zero, or that include any char-
acter other than 0–9 or that contain leading zeroes.

The clips in the XG processor can also send control messages to the MCE that do the following: 

• Select a main source.

• Select and control the position, size (and opacity) of squeeze images. 

• Select audio overs and control their over-to-main ratios.

The control messages are entered in the timeline of a media clip developed in Xstudio. There is a 
set of 18 control messages from which to choose. See Xstudio Functions, following.

Automation
Your automation system (if any) can be configured to control XG layers — by sacrificing other 
video effects layers. In brief, the MCE will substitute an XG layer for, say, a logo under automa-
tion. The choices are MasterConfig options, made in the RS-422 configuration page. Thus, the 
choices cannot be overridden by the automation system. You can make changes only by recon-
figuring the MCE. 

Xstudio Functions
There are 18 MCE add-on functions you can choose in Xstudio. 

The add-on functions are built into non-standard XML files that must be obtained either 
from the installation CD (SB0221) or from Miranda technical support. See Xstudio Add-On 
Functions on page 110 for instructions. 

Connections
This diagram shows the Intuition XG connections: 

The Intuition XG processor and the MCE communicate on the master control network. The Intu-
ition XG processor delivers one or two (fill, key) pairs to the master control system through an 
SWB card (a requirement). The MCE configuration identifies the ports through which the signals 
enter the master control system.
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The Intuition XG processor provides the XG configuration, video storage, and access to a 
network of graphics tools, information databases, and so on. 

Operators at master control panels use (and choose) the XG “layers” created or stored within the 
Intuition XG processor as they would choose any other video effect.

Video cables connect to the Intuition XG processor with an 8-BNC breakout connector. One of 
those cables is video reference (Analog Ref In). Note that the required reference is tri-level 
(1080i/59.94). The MCE can use tri-level, NTSC, or PAL reference. There are timing requirements if 
the MCE does not use tri-level. 

The 4 video cables on the breakout connector are labeled: 

(Program) (Preset)
SDI out A SDI out B “fill”
SDI out C/key SDI out D/key “key” 

On panels that are configured for Intuition XG, there is an ‘Int XG’ button and a ‘Preview Int XG’ 
button in the main menu where the operator can choose XG layers to place on air. Those panels 
have up to 4‘XG layer’ buttons in the program button row and matching ‘XG layer’ buttons in 
either the preset button row or the preview button row. The ‘XG layer’ buttons place the 
selected XG layers on the preset (or preview) bus and the program bus. 

A panel can have an optional ‘XG Keyer Control’ button. That button turns the keyers that 
support the XG layers on and off when the panel operator presses it. It is intended as an emer-
gency kill switch. (The button does affect the Intuition XG processor.)

Intuition XG with Imagestore 750s 
An Intuition XG processor can provide clips to an Imagestore 750.

The Intuition XG processor has either 1 or 2 output channels. Each channel is a (fill, key) video 
connection. Connect the paired cables from the Intuition XG processor to the Fill 1/Key 1, Fill 
2/Key 2, or Fill 3/Key 3 inputs of the Imagestore 750. 

Note that the Imagestore 750 can receive one input pair from the Intuition XG. 

Many configuration steps are required for the Imagestore 750s in your system, some of which 
involve a connected Intuition XG processor (sometimes called a “slave” processor). This figure 
illustrates the basic connections: 

See Intuition XG Options on page 146 for configuration details. Also refer to the Imagestore 750 
Reference Manual. 
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Ancillary Hardware 

EBCP 
The EBCP is obsolete as of May 2, 2012. EBCPs in the field are still supported.

All MCPMs have emergency bypass capability. Under certain conditions (e.g., malfunction, 
power-up, external switch) an MCPM or MCE enters bypass mode with this effect: alternative 
video and audio signals are switched to program output. When the MCPM or MCE leaves bypass 
mode, normal output resumes. 

The mechanism is reasonably reliable: the bypass relays are in the backplane module and the 
MCPM or MCE is bypassed almost entirely if the MCPM or MCE fails. The MCPM or MCE boots in 
bypass mode and switches to normal operating mode only if it is functioning properly. 

The emergency bypass control panel (EBCP) is a 1RU panel that has two large button switches. 
One button’s legend is “Main” and the other’s is “Bypass.” Pressing the red “Bypass” button 
places an MCPM or MCE in bypass mode. Pressing the green “Main” button enables normal 
mode. (The panel controls only the MCPM or MCE to which it is connected.) 

Refer to the iMC Reference Manual for connection details and other information. 

The green button is also a status lamp: it lights when the MCPM is in normal mode. Similarly, the 
red button lights when the MCPM is in bypass mode. Because the buttons are large, the MCPM 
state is obvious from a distance. The bypass button functions as a “kill switch” or a “panic 
button.” Because it is large, it is easy to find and press quickly. 

(A bypass switch and bypass LED are situated at the front of each MCPM and each MCE, but they 
are enclosed in the frame and might not be readily accessible.)

Emergency bypass operations are configured in MasterConfig. 

See Linking Two MCPMs as Primary and Backup on page 192 for a sample application.

Tally Processor
Miranda offers a third-party3 “tally processor”— a 1RU device that provides 32 optically isolated 
inputs and 32 relay outputs, also optically isolated. Through Miranda’s Ethernet protocol 
(NVEP4), the tally processor can sense master control events such as main source selections and 
transitions. It can also trigger master control events.

Multiple tally processors can be added to a master control network. The product includes a self-
contained configuration utility program that operates as a browser application. 

The tally processor functions as if it were a control panel and the presence of one or more 
tally processors limits the number of actual panels that can control a single MCPM or MCE. 
(An MCPM or MCE can communicate with a maximum of 4 panels.)

See Tally Processor Connectors on page 185 for more information.

3. DNF Controls (www.dnfcontrols.com).
4. NVEP stands for “NVISION Ethernet Protocol.”
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Device Controller 
Miranda offers a third-party “device controller”— a 1RU device that can control 4 VTRs or other 
devices using a serial protocol and up to 16 devices using start and stop pulses. Like the tally 
processor from the same company,2 the device controller also provides 32 optically isolated 
inputs which are not used by Master Control, but can be used for any purpose. The device 
controller receives commands from MCEs under Miranda’s Ethernet protocol (NVEP).

Multiple device controllers can be added to a master control network. The product includes a 
self-contained configuration utility program that operates as a browser application. 

See Device Controller Connectors on page 186 for more information.

Other Topics 

GPIO for MCEs and MCPMs
MCPMs and MCEs have two GPI inputs and two GPI outputs (solid-state relay contacts). They are 
optically isolated. 

Hardware control panels also have two optically isolated GPI inputs and two GPI outputs (SPDT 
relay contacts). Software control panels (GUIs) do not have GPI connections.

A GPI input device might be something as simple as a pushbutton or toggle switch — it is 
customer-defined in any case. GPI inputs must be of relatively low power, typically TTL levels. 

GPI output devices are switched by relay outputs (NO, NC, and COM). GPI outputs can drive rela-
tively large loads including AC. A panel’s alarm outputs are the same, electrically, as the GPI 
outputs and on the same connector. See GPI on page 73 for connection details.

A limited set of events can cause an MCPM’s GPI output relay transition. An MCPM’s GPI inputs, if 
enabled, control its emergency bypass relay. An MCPM’s outputs can be controlled from a panel. 
An MCPM’s GPI inputs can be assigned to a panel’ buttons. The buttons reflect the state of the 
GPI input in high or low illumination.

A control panel’s GPI output is triggered when an operator presses a button configured for GPI 
output. The state of a control panel’s GPI input is reflected on a button in high or low 
illumination. 

The GPI functions of an MCPM or MCE are configured in MasterConfig. A panel’s GPI functions 
are configured in the MCS Panel Configuration Editor.

Miranda offers a third-party tally processor that extends the GPIO functions of the master 
control system.

GPIO for Imagestore 750s
The master control system does not use the Imagestore 750’s GPIO. Customers may use it for any 
purpose. Panel operators can execute GPI macros defined in the Imagestore 750.

Reference for MCEs and MCPMs
A master control frame’s router control cards can receive video reference signals for the MFR. 
Individual MCPMs accept video reference also. 

The frame can accept an AES reference for the MFR and for master control. 
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Video Reference 
Video reference to the frame applies only when there is an MFR in the frame. You can have 
redundant or dual-standard references for the frame. See Video Reference on page 58.

MCPMs and MCEs usually require a video reference signal. MCEs terminate video reference inter-
nally and you’ll need a DA (or similar device) to distribute reference signals to more than one 
MCE. MCPM reference connectors are loop-through: MCPMs can “daisy-chain” reference signals 
to other devices. An MCPM reference signal chain must be terminated at some point. Use 75Ω 
BNC terminators.

MCE video reference must be analog (NTSC or PAL) only. MCPM video reference can be HD tri-
level as well as NTSC or PAL. 

Audio Reference
You may supply a house reference signal to the frame and master control will use it. If you do 
not, the control card (EM0374 or EM0414) generates a 48 kHz reference internally. That will 
suffice unless you have more than one master control frame and you want to synchronize AES 
signals across frames. 

Reference for Imagestore 750s
The Imagestore 750 accepts tri-level (HD) or bi-level (SD) analog reference.

The reference source can be selected at the Imagestore 750 front panel. It can be ‘External Ref’, 
‘SDI A’, ‘Free Running’ or ‘Unknown’. Do not use ‘SDI A’ because it is a main source input. We 
recommend using ‘External Ref’.

Video Timing for MCEs 
MasterDiag has a timing page that lets you see (although not change directly) the timing points 
of an MCE’s video (and audio) inputs. The timing page cannot be used with other MCPMs.

Inputs that are out of the allowable timing range are termed “non-synchronous.” MCPMs and 
MCEs bypass internal processing for non-sync inputs. Under bypass conditions, program output 
is the same as the input. The MCPM or MCE applies no video effects or audio overs. Transitions 
to or from non-sync sources can only be cuts.

Refer to the MasterDiag User’s Guide for more detail. 

Automation for MCEs and MCPMs
Router automation uses the ‘Ctrl’ ports of the master control frame. Master control automation 
uses the automation port (DE9) on the MCPM and MCE backplanes. Router automation and 
master control automation are two independent concepts. 

This guide does not address either form of automation. 

Automation can control XG layers. See the RS-422 configuration page in the MasterConfig User’s 
Guide for details.
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Monitoring for MCEs and MCPMs
MCPMs, MCEs, and master control panels provide a number of monitoring ports for video and 
audio. There are differences among the various models. Use this chart as a guideline: 

An MCPM’s preset output is labeled “PVW OUT.” Please do not be tempted to think this is the 
same as the PVW (Preview) output available from MCEs. 

An MCPM’s program output includes 8 channels of embedded audio. Its emergency bypass 
input does also. An MCE’s program output includes 16 embedded audio channels and its emer-
gency bypass input also includes 16 embedded audio channels.

MCEs present video and audio outputs on coax (1.0/2.3) connectors. MCPMs use BNCs. 

MCE audio monitor and meter outputs carry 16 embedded channels of audio also on coax 
connectors. Your audio metering subsystem must include a disembedder. (Note that CECPs, 
FECPs, iMC-Panel-200s, and iMC-Panel-300s have audio metering inputs that can accept the 
output from an MCE.)

MCEs can be configured to present program video, preset video, or black on the audio monitor 
and meter channels. 

MCPMs present audio monitor and meter output (4 AES channel pairs each) on DB25 connec-
tors. Some MCPMs also present analog metering output. The analog output is the same as the 
AES output, except that it has been converted to analog and can drive analog speakers.

Connector
-HD, -HD2, 
-SD, -SDHD

-MK-SD
-MK-HD MCE

Program Out Y Y Y

Bypass Video In Y Y Y 

PGM Monitor Y N N (can use aux bus)

Preset Out Y Y Y

Clean-feed Out 1 1 2

Program AES Out 4 (pairs) N Yes, if AXM card installed

Preset AES Out N N Yes, if AXM card installed

Preview AES Out N N Yes, if AXM card installed

Bypass AES In 4 (pairs) N (embedded in the bypass video input) 

Audio Meter Out 4 (pairs) 4 (pairs) 1 coax (16 embedded ch.)

Audio Monitor Out 4 (pairs) with additional 
analog outputs

4 (pairs) 2 coax (16 embedded ch. in 
each) Additional outputs on 
AXM card

Video Ref. In 2 2 1 (terminated)

Misc output mixed mixed mixed

Special HD inputs -na- (-MK-HD only) -na-

Preview bus output N N 2 if PVW card installed 

Aux bus output N N 2 

Metadata output on “aux” conn N 8 if AXM card installed 
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MCPMs (and MCEs in older releases) present an A/B mix of AES output to the audio monitors. 
MCEs, at 6.0.0 and later, do not mix audio monitors A and B and produce 16 audio channels on 
each monitor. MCEs also produce 16 audio channels on the metering output.

MCEs that include preview cards can present preview output (video plus 16 embedded audio 
channels). Presently, preview port B is a replica of the single preview output that appears on 
port A.

MCEs have two clean-feed outputs A and B. MCPMs have one. There are 7 clean-feed taps in the 
processing pipeline. You can choose the tap in MasterConfig.

An MCE’s aux outputs (A and B) can be configured to follow program or preset video or program 
or preset audio, or to follow a control panel’s aux button selections. 

Following the aux buttons works when the aux buttons have aux delegate buttons assigned 
to the MCEs’ aux output and one of these is selected. Otherwise, the aux outputs might not 
carry any signal.

NV9000 Ports
If your master control system is part of an NV9000 control system, you must connect the master 
control port of the NV9000 system controller to the Ethernet switch that supports the master 
control network. (The NV9000 expects its master control port to be 192.168.7.1 or .2 but you can 
set up the MC network as you wish. Your master control net should not conflict with other 
NV9000 networks.)

The default IP addresses of the NV9000 controller’s network ports are as follows: 

NV920 Ports
Each of the NV920’s three ports has a unique IP address, fixed internally. The IP addresses 
depend on whether the system controller is stand-alone or redundant: 

You may change any of these addresses to match your facility’s networks. 

Network Primary IP Address Secondary IP Address

Control net 172.16.1.1 172.16.1.2

Panel and Router Net 1 192.168.1.1 192.168.1.2

Panel and Router Net 2 192.168.2.1 192.168.2.2

(Panel and Router Net n) 192.168.xxx.1a

a. The value of xxx is arbitrary for any additional panel and router networks.

192.168.xxx.2b

b.The number of networks is limited by the number of NIC ports. To have more than 2 panel 
and router networks, you might add a NIC or reassign existing network ports.

NV9000 System Net 192.168.3.1 192.168.3.2

Master Control Net 192.168.7.201 192.168.7.202

House Net 192.168.20.1 192.168.20.2

Port Single Controller Redundant Controller 1 Redundant Controller 2

NVNET1 192.168.1.1 192.168.1.1 192.168.1.2

NVNET2 192.168.2.1 192.168.2.1 192.168.2.2

NVNET3 192.168.3.1 192.168.3.1 192.168.3.2
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Preset Tally 
Panel configurations have an option that applies to panels when they are controlling Imag-
estore 750s. This option governs the way a panel’s preset button row tallies before, during, and 
after transitions. 

Some operators like the “PresStation” method of arming DVEs, DSKs, and voice-overs on the 
preset bus. Other operators like the traditional method (which is used for MCEs and MCPMs). 

The option —‘Enable Traditional PST Tally’— is specified in the ‘Advanced’ configuration page of 
the MCS Panel Configuration Editor. If you enable the option, the panel will operate using the 
traditional method. Otherwise, the panel will use the “PresStation” method.

If you do enable the option, it is imperative that the ‘Active Preview Keyers’ parameter of the 
Imagestore 750 configuration be set to true. See Preset Tally Option on page 167. Refer also to 
the Imagestore 750 Reference Manual for details.

Installation Process in Brief
The installation process follows these basic steps:

1 Unpack your Miranda equipment, checking for contents, damage, or defects. Gather 
together all your other equipment, software, and tools. 

2 Load the configuration software onto your configuration PC(s). If you have GUI software, 
load that onto one or more GUI PC. The GUI PC may the same as the configuration PC.

3 Establish how you want to connect everything. This means compiling very detailed lists. 
Included in the lists are 

• Relevant NV9000 sources, destinations, and salvos.

• Which signals use which master control port numbers.

Do not neglect this step.

4 Put the master control frame(s) into place. We assume that you are using 19″ racks but this is 
not a requirement. If you have a control panel, put it in place.

5 Connect your MCPMs, MCEs, Imagestore 750s, control panels, and PCs on an Ethernet LAN. 
This LAN is the master control network. Assign IP addresses to all the devices on the net-
work.

6 Connect optional equipment on the master control network: DC21 device controllers for 
machine control, Intuition XG hardware, and tally processors.

7 Connect video and audio cabling at the back of the master control frame.

8 Create a configuration file for each MCPM and MCE and upload it.

9 Create configuration file(s) for each Imagestore 750.

10 Create a configuration file for each control panel and upload it. (The upload for hardware 
control panels is different from the upload for software control panels.) 

11 Power up the equipment. Test your setup. “Installation” is complete if it passes your test.

12 Adjust and complete your configurations as you see fit. This begins the maintenance phase.

Please note:

You do not have to specify a complete configuration to get started. You can always add to, or 
change, configurations any time.

Leave yourself the option to expand or change.
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Chapter 3 describes software installation. 

Topics
Preliminary Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39
Installing Configuration Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Installing Documentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Installing the GUI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Other Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Preliminary Steps
Obtain and set up a Windows PC (XP, Vista, or Windows 7) for configuration. If you intend to use 
a software control panel (GUI), obtain and set up a Windows PC for the GUI. It can be the same 
PC. 

The PC(s) you use must be connected on the master control network. The PCs must be config-
ured with IP addresses on that network. See PCs on page 75.

Master control users’ accounts on your PCs must not be set to ‘Restricted User’. ‘Standard User’ 
or ‘Administrator’ is recommended: 

When the setting is restricted, the master control software will not function properly. 

Go to ‘User Accounts’ under the Windows control panel to change the settings. 

Windows 7

Windows XP
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Installing Configuration Applications 
There are several configuration applications. 

NV5100MC
• MasterConfig — configures MCEs and MCPMs.

• MasterDiag — sets up communication with MCEs and MCPMs.

• MasterLogo — converts graphics into logos that can be used by MCEs and MCPMs. This util-
ity also uploads the logos to the MCE or MCPM.

• MCS Panel Configuration Editor — creates and manages panel configurations for Imagestore 
750s, MCEs, and MCPMs.

These applications are bundled in one installer named InstallConfig.msi that comes on the 
SB0243 CD that ships with the iMC master control products. Actually, the installer is a directory 
of several files, all of which are essential for installation.

Imagestore 750
• Imagestore 750 Configurator — creates and manages Imagestore 750 configurations. The 

Imagestore 750 also has a set of built-in web pages that support configuration, restart, and 
status.

• Several other configuration applications come with the Imagestore 750: 

These applications come bundled on the MCS CD that ships with the Imagestore 750.

MCE and MCPM Configuration Software
Follow these steps to install configuration software on the configuration PC:

1 You can obtain the installer(s) from Miranda or from the SB0243 CD. 

If you get the installers from Miranda, load the installers on each PC that you want to be able 
to execute configuration programs. Double-click the installer icon to launch the installer. 

If you are using the SB0243 CD, insert the CD in your CD drive and wait the for the CD to 
“autoplay.” 

Audio Builder

Clip Builder

Clock Builder

Batch Converter

Animation Builder

DVE Editor
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You will see this window: 

Click the ‘Installer’ button to launch the installer.

2 If you already have MC software installed, you will see an add/remove message: 

Click ‘OK’ and go to the Windows “control panel” to delete the existing software. 

Then repeat step 1 and proceed to step 3.

3 The Welcome screen displays: 

Click ‘Next’ to proceed. 
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4 The NV9000 Integration screen displays: 

If you are integrating an NV9000 router control system with your NV5100MC, enter the IP 
address of the NV9000’s primary system controller (and secondary system controller, if appli-
cable). A stand-alone system controller is considered the primary, in this instance. 

If your NV9000 system has a virtual IP address, use that for the primary IP address.

This integration lets you configure router pre-select, external router sources, and salvos. 

If you do not have an NV9000, leave these fields empty. If you add an NV9000 at a later date, 
you will have to remove and re-install this software. Specify these IP addresses during re-
installation.

Click ‘Next’ to proceed. 

5 The “Select Installation Folder” screen displays: 

The default folder for the installation is C:\Program Files\Miranda\Master Control\. Browse to 
choose another folder. We recommend that you select “Everyone” so that everyone who 
uses the PC can access the software.

Click ‘Disk Cost’ if you wish to see how much disk space you need.

Click ‘Next’ to proceed. 
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6 The confirmation screen displays: 

Click ‘Next’ to proceed. Click ‘Cancel’ to cancel the installation. Click ‘Back’ to change your 
installation parameters.

7 When the actual installation begins, a progress indicator displays: 

Click ‘Cancel’ to terminate the installation before it completes or wait for the installation to 
complete. (The installation takes only a few seconds.)
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8 The completion notice displays: 

Click ‘Done.’ You will be returned to the main CD screen. 

Barring errors, the installation is complete. The installer has created a master control folder, with 
entries in the Windows XP Start menu. The Start menu path is:

Start > Programs > Miranda > Master Control > ...

The default names of the four configuration programs are:

MasterConfig.exe
MasterDiag.exe
MasterLogo.exe
MCSPanelConfig.exe

in the default folder

C:\Program Files\Miranda\Master Control\bin\

Miranda recommends that you create shortcuts on your PC’s desktop: 

To launch any of the applications, (1) choose the application from the Start menu, (2) double-
click the application in its folder, or (3) double-click its desktop shortcut.
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Installing Documentation 
There are several manuals and user’s guides in the master control documentation set: 

These documents are available on the SB0243 master control CD. 

Other documentation, including the Imagestore 750 Reference Manual, is also available Miranda. 

Installing the GUI 
Miranda provides the GUI software as a separate purchase item. 

The GUI installer comes on the SB0244 CD and is named InstallCECP_GUI.msi. Actually, the 
installer is a directory of several files, all of which are essential for installation.

Ensure that your PC is running Windows XP, Vista, or Windows 7. 

For optimal GUI performance, your PC should have a video card capable of 1280×1024 (or 
better) resolution. The GUI is optimized for a touchscreen, but you can use a conventional 
monitor, keyboard, and mouse if you want.

The GUI does not scroll. If your screen is too small, it overflows the screen. It is possible, 
however, to drag the GUI around to use different sections.

The GUI will not run properly until you have established your master control network, with 
the GUI PC on that network.

Configuration Guides and Information

UG0061 MasterConfig User’s Guide How to configure MCPMs and MCEs.

UG0062 MasterDiag User’s Guide How to initialize and update MCPMs and MCEs.

UG0063 MasterLogo User’s Guide How to convert graphic files to the format required by 
MCPM logos and send logos to the MCPMs.

UG0064 iMC Installation Guide How to install, connect, and configure MC equipment.

UG0065 iMC Reference Manual Architectural and functional detail regarding Miranda mas-
ter control systems.

UG0066 MCS Panel Configuration Editor 
User’s Guide

How to use MCS Panel Configuration Editor software to con-
figure control panels.

UG0067 Device Controller User’s Guide How to use and configure the master control device control-
ler.

UG0068 Tally Processor User’s Guide How to use and configure the master control tally processor.

Panel Operator’s Guides

UG0069 iMC-Panel-100 Operator’s Guide for Imagestore 750 3RU control panel

UG0053 iMC-Panel-GUI Operator’s Guide for Imagestore 750 Software control panel

UG0054 iMC-Panel-200 Operator’s Guide for Imagestore 750 Compact panel

UG0055 iMC-Panel-300 Operator’s Guide for Imagestore 750 Full-size panel

UG0070 iMC-Panel-100 Operator’s Guide for MCEs and MCPMs 3RU control panel

UG0057 iMC-Panel-GUI Operator’s Guide for MCEs and MCPMs Software control panel

UG0058 iMC-Panel-200 Operator’s Guide for MCEs and MCPMs Compact panel

UG0059 iMC-Panel-300 Operator’s Guide for MCEs and MCPMs Full-size panel
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Follow these steps to install the GUI software:

1 Insert the SB0244 CD in your CD drive and wait the for the CD to “autoplay”: 

Click the ‘Installer’ button to launch the installer.

2 If you already have the GUI software installed, you will see an add/remove message: 

Click ‘OK’ and go to the Windows “control panel” to delete the existing software. Then click 
the ‘Installer’ button again, as in step 2, and proceed.

3 The Welcome screen displays: 

Click ‘Next’ to proceed. 
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4 The “Select Installation Folder” screen displays: 

The default folder for the installation is C:\Program Files\Miranda\Master Control\. 
Browse if you want to choose another folder. We recommend that you select “Everyone” so 
that everyone who uses the PC can access the software.

Click ‘Disk Cost’ if you wish to see how much disk space you need. 

Finally, click ‘Next’ in the “Select Installation Folders” window to proceed. 

5 The confirmation screen displays: 

Click ‘Next’ to proceed. Click ‘Cancel’ to cancel the installation. Click ‘Back’ to change your 
installation parameters.
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6 When the installation begins, a progress indicator displays: 

Click Cancel to terminate the installation before it completes or wait for the installation to 
complete. 

7 The completion notice displays: 

Click ‘Done’.

Barring errors, the installation is complete. The installer has placed the GUI software in the 
master control folder, with an entry in the Windows XP Start menu. The Start menu path is:

Start > Programs > Miranda > Master Control > Master Control iMC-Panel-GUI

The default pathname is:

C:\Program Files\Miranda\Master Control\bin\cecp_gui.exe 

(If you intend to run multiple instances of the GUI on the same PC, copy the executable file and 
the configuration file, cecp_gui.uicfg, to a separate folder. Create a separate folder for each 
instance of the GUI.)
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Miranda recommends that you create a shortcut on your PC’s desktop: 

To launch the GUI, (1) choose the application from the Start menu, (2) double-click the applica-
tion in its folder, or (3) double-click its desktop shortcut.

If you have multiple instances of the GUI, create a shortcut for each one.

Other Software
NV9000-SE Utilities, UniConfig, and MRC (Miranda Router Configurator) are available. Contact 
Miranda if you need to obtain that software. 

If you have an SNMP manager, you will want to know that your NV9000 system (if you have one) 
contains a master control subagent and MIB. You can unlock this software if you purchase the 
license. (The part number for the license is EC9610.)

The Imagestore 750 also supports SNMP. The NV9000 does not have a subagent for it.
49



Software Installation
Other Software
50



Hardware Installation for MCEs and MCPMs
Chapter 4 describes hardware installation for MCEs and MCPMs in NV5100MC frames. 

Topics
Preliminary Thoughts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
Control Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
Alarm Connections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
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Local Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63
NV9000 Sources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  67
Master Control Network  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71
Intuition XG  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  78
Kaleido-X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80

Preliminary Thoughts
Hardware installation means (1) placing equipment and (2) interconnecting equipment. Config-
uration is, in a real sense, part of hardware installation, but it is covered in Chapter 5, 
Configuration for MCEs and MCPMs, on page 81. 

This guide cannot address placement. However, you will need to consider cabling limitations. 
SD signals require cables of 300 m or less. HD signals require cables of 150 m or less. Signals at 
3Gig require cables of 100 m or less. Analog audio or analog video cables should be 300 m or 
less. Ethernet cables should be 300 m or less. 

If your master control system is part of an NV9000 system, you will (probably) be connecting 
your master control backplane(s) to one or more router outputs. If your master control system 
contains an MFR, your NV9000 will (probably) control the MFR through the frame’s control ports. 

If your master control system is part of an NV9000 system, you might wish to enable its 
NV5100MC SNMP reporting service to monitor MCEs and MCPMs in your system. (The service is 
available by license. The part number for the license is EC9610.)

If your master control system is to support machine control or pre-roll, it must have at least one 
MCE and your automation system (if any) must capable of executing pre-roll transitions with the 
appropriate timing and you will need at least one DC21 device controller.

If your master control system is to include an Intuition XG subsystem, it must have at least one 
MCE and at least one SWB input card (and backplane module). In many cases, it will already have 
such a card.

Control panels, MCEs, and MCPMs must communicate on an Ethernet LAN. The NV9000 will 
probably communicate with master control devices on that LAN (providing salvos, router prese-
lect functions, and “external router sources”).
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Note that master control also has this restriction: up to 4 control panels may control any 
single MCE or MCPM. 

If you have many MCEs, you will probably need a DA to supply video reference to each one.

Monitor walls, re-routing, and obscenity control, and “glue” devices are other issues you will 
face. This guide cannot address those topics. We refer you to Miranda’s application notes 
AN0004 and AN0013 that discuss some of these ideas. 

Miranda offers a third-party tally processor that might be of use in your system. A tally processor 
is counted a control panel in the number of control panels accessing an MCE or MCPM.

We recommend that, before you begin cutting cable and configuring MCPMs and panels, you 
know everything about all connections in detail. Know what will work and what will not work. 
Know what your configuration software supports. It is advisable to make detailed lists of all your 
router sources, destinations, salvos, master control inputs, and MFR inputs and outputs. 

If you have an MCPM-MK-HD, its video sources are connected at its backplane. It does not 
receive video signals through the motherboard. The -MK-HD video inputs cannot be used by 
other MCPMs or MCEs.

NV9000 devices that serve as external router sources for master control must be defined, under 
NV9000-SE Utilities, in a level set with 1 video level and up to 4 AES levels. If the source has 
embedded audio, then it must be defined as a level set with a single level. 

External router sources require A and B connections for main sources and for audio over 
sources, and 3 connector groups for keyer sources, unless those source groups are not 
enabled.

As of software version 6.0.0, external router sources (of any kind) are not supported for MCEs 
that have preview enabled. This will change. 
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Control Connections
The control connectors (including reference connectors) are at the left at the rear of the frame: 

The master control frame (NV5100MC or NV5128-MC) has two control card slots and therefore 
two control cards potentially. The second control card is for redundancy. A control card can be 
either an EM0374 router control card or an EM0414 clock card. The EM0374 is required if the 
frame contains a router. Otherwise, the clock card is sufficient.

The control cards have switch settings. See Control Card Jumpers on page 178 for how to set 
the switches.

If the frame contains a router, any external router control system must communicate with the 
router through its control card(s). A third-party control system (or automation system) will 
generally communicate with the router control card using Miranda’s NVISION serial protocol. 

If the router control system is an NV9000, it can use Miranda’s Ethernet protocol. The NV9000 
system might have a single stand-alone controller or two NV9000 controllers for redundancy. 

(The two control cards in a master control frame are never in use at the same time. One is always 
the active control card and the other is stand-by. The same is true of a redundant NV9000 router 
control system: one controller is active and the other is stand-by.)

Serial Ports
At the top left portion of the rear of the frame are 6 serial connectors, and below that are 2 
Ethernet connectors. If you are connecting an NV9000 control system, Ethernet control is 
preferable. 
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The CTRL1 and CTRL2 ports are DE9, RS-422. 

You can use these connectors for control using a serial protocol from (1) a primary or secondary 
NV9000 router control system, (2) a primary or secondary third-party router control system, or 
(3) a router automation system. 

The CTRL connectors are needed only when a router is present in the frame and a serial 
control protocol is in use. 

If your NV9000 uses serial protocol, you will probably want to add a serial card in its PCI bay. 
Miranda offers a number of serial cards from 8 to 32 ports. 

Cases:

1 If you are using an NV9000 system controller with a serial protocol, connect the primary 
CTRL1 port to a COM port on the system controller. Connect the secondary CTRL1 port to 
another COM port of the system controller if your frame has a secondary control card.

2 If you are using a third-party control system (that is not an SMS7000), connect the primary 
CTRL1 port to a COM port of that device. If your frame has a secondary control card, connect 
the secondary CTRL1 port to a COM port of the device. 

3 (SMS7000 systems connect at the ‘Aux’ ports.) 

4 If you have a redundant (secondary) NV9000 system controller (with a serial protocol), con-
nect the primary CTRL2 port to a COM port on the redundant system controller. Similarly 
connect the secondary CTRL2 port if your frame has a secondary control card. 
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5 If you do not have a redundant control system, but have an automation system, connect the 
primary CTRL1 or CTRL2 port to a COM port of the automation system. Similarly connect the 
secondary CTRL1 or CTRL2 port if your frame has a secondary control card.

The system controller’s COM ports must be compatible with the frame’s serial ports — the same 
Baud rate, parity settings and so on. The defaults for Master Control frames are 38400 Baud, 
RS-422, 8 data bits, no parity, 1 stop bit.

Similarly, a router automation system’s COM ports must also be compatible with the frame’s 
serial ports.

Diagnostic Ports 
The DIAG ports are DE9, either RS-232 or RS-422 (selectable in UniConfig). 

These ports are for configuration, firmware uploads, and testing. The ports are typically used 
with UniConfig to initialize the primary and secondary control cards for routing.

The ‘Diag’ ports must be set up properly before you can use them. If they are not, use the 
diagnostic port at the front of the control card. This port is always RS-232 at 9600 Baud, 8N1. 

The DIAG ports are not used during normal operation.

Use UniConfig to set the IP addresses of the control card(s). If the frame contains an MFR, you’ll 
use Uniconfig to define its partitions. See UniConfig and MRC on page 20.

Suggestions
If you are connected to an Ethernet port while using UniConfig, choose your master control 
frame in the router list at the left.

Whether UniConfig is in serial mode or Ethernet mode, set the frame’s IP address and mask in 
the ‘Configuration’ page. Define partitions in this page also. You should first click ‘Read All’ and 
follow your changes with a ‘Write All’. 

Set video reference options in the ‘Switch Point Setup’ page. Click ‘Write Changes’ afterward.

Set Ctrl1, Ctrl2, and Diag port parameters (e.g., RS-485/422 vs. RS-232) in the ‘Router Serial 
Configuration’ page.

Ethernet Ports 
The Ethernet connectors are used when you have an NV9000 router control system connected 
over Ethernet. 

The Ethernet connectors are needed only when a router is present in the frame and a 
Ethernet control protocol is in use. 

for Primary
Control Card

for Secondary 
Control Card
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Above the Ethernet ports are 10base2 connectors. Ignore these. They are not used. 

Before you can use the Ethernet ports, the control card(s) must be assigned IP addresses in 
UniConfig. See UniConfig and MRC on page 20 for details.

Cases:

1 If you are using an NV9000 control system with an Ethernet protocol, connect the primary 
Ethernet port to one of the “Panel/Router” network switches connected to the NV9000 sys-
tem controller. Similarly connect the secondary Ethernet port of your frame if it has a sec-
ondary control card.

2 If you have an automation system (in addition to the NV9000), connect a COM port of the 
automation system to either primary serial port, CTRL1 or CTRL2. Similarly connect a COM 
port to either secondary serial port if your frame has a secondary control card. 

Figure 4-1 shows stand-alone and redundant Ethernet connections: 

Fig. 4-1: NV9000 to Frame Connections 

Note that there is a crossover cable between the two Ethernet switches in the illustration of the 
redundant connections in Figure 4-1.

An NV920 system controller is an alternative to an NV9000 system controller. 

AES Reference
AES reference connectors allow you to sync AES audio in the master control frame to your house 
reference. If you do not supply an external AES reference, the control card itself will generate its 
own 48kHz reference. 
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There are two pairs of connectors for AES reference — one for the primary control card and one 
for the secondary control card. Each control card can use either: 

• BNC (75Ω) — unbalanced signals.

• A 3-pin Phoenix quick-release connector for STP connections (balanced signals). 

Both accept AES3-id signals at a 48kHz sample rate (3.072 MHz bit rate). The AES reference signal 
does not loop-through. Each input supports both balanced and unbalanced formats. Only one 
connector can be used at a time for a given input.

The use of redundant references from independent reference generators increases reliability 
and is the recommended method of operation. If one reference is lost, the frame automatically 
selects the backup reference. If you provide an external AES reference, it must be a 48kHz refer-
ence signal. 

The NV5100MC and NV5128-MC frames support “near-sync” operation. That is, an unlocked 
48kHz AES source can be routed by a synchronous AES input/output module pair. To accom-
plish this, the input card discards or repeats audio samples as required to bring the source into 
exact synchronization at the output. 

An AES reference is required only when there is a router in the frame and the router has AES or 
analog I/O cards. The reference makes inter-mixing analog and AES audio formats easier.

An acceptable reference includes any AES signal with a sample rate of 48kHz. Typically, digital 
silence is used as a house AES reference. Miranda manufactures AES sync generators suitable for 
this task.

At software release 6.1.0, MCEs derive AES reference from their video reference.

Aux Bus 
At the middle left portion of the rear of the frame are 2 ‘NVISION Aux Bus’ (BNC) connectors:.

If (and only if ) you are using an SMS7000 router control system with the master control system, 
connect the SMS7000 to the NVISION aux bus connector. 

The frame has two aux bus connections. The connection is loop-through: you can pass the 
SMS7000 “node bus” control signals on to another device. You can connect a redundant control 
system on the “node bus.” 

If you are using an SMS7000 control system, terminate the “node bus” with a 50Ω terminator.

Using an SMS7000 requires an SMS7000 mezzanine card installed on each router control 
card. Jumpers J4 and J6 must be set. See Control Card Jumpers on page 178 for detail.

There is no relation between this “aux” bus and the aux bus of an MCE, the aux buttons of 
certain control panels, or the aux audio inputs of an MCPM or MCE.

SMS7000 Connectors 
(BNC, 50Ω)
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Video Reference 
At the lower left portion of the rear of the frame are 4 video reference (BNC) connectors: 

These references affect only the router, if present, not the MCPMs in the frame. Each MCPM 
should have a video reference too. However, it is possible to “daisy chain” your house reference 
from the frame’s reference connectors to the MCPMs’ reference connectors.

If there is no video reference, the control card’s front red LED remains lit and takes within the 
MFR will not occur at defined switch points.

Four video reference connections (Video Ref 1 and Video Ref 2) are provided — two for each 
control card. Each connection is “loop-through.” One connector receives the reference signal; 
the other feeds it to another device.

Acceptable reference signals include NTSC analog, PAL analog, or HD tri-level analog signals. 
External 75-ohm termination is required on the frame if you do not feed the reference to 
another device. You can feed the MCPM references from these connectors.

Many MCPMs (include MCEs) support Dolby E audio, embedded or discrete. Dolby E requires 
a non-interlaced video reference format. Dolby E works with 720p video sources when the 
reference is 525i, 625i, or 1080i.

MCEs have only one video reference connection and that is internally terminated. If you 
have more than one MCE in a frame, you will need some means (perhaps a DA) to distribute 
video reference to each MCE. 

In the case of composite reference signals, only the sync portion is used. Reference signals may 
be single, redundant (same video standard and rate) or different (dual-standard mode, different 
rates). 

The choice between redundant and dual modes is made in UniConfig. If you have only a 
single reference signal, these modes do not apply.

Single Reference Signals 
There is one reference input, possibly “daisy chained” to reference inputs on other devices.

Redundant Reference Signals 
In this mode, both reference inputs are driven with identical but separate reference signals. At 
startup, the control card checks both inputs for valid signals. If both inputs are good, it uses 
reference input 1. If this input fails, the controller automatically selects reference input 2. If input 
1 is subsequently restored, the router will continue to use input 2 until the control card is reset. If 
both references fail, an internally generated reference signal will be used. In this case, switches 
will be asynchronous. 

Redundant mode improves system reliability.

Video Reference Connectors 
(BNC, 75Ω)
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Dual-Standard Reference Signals 
In this mode, the reference inputs are driven with different signals. An example might be NTSC 
analog black on reference input 1 and HD tri-level sync on reference input 2. 

If either reference fails, it will be replaced with the internally generated signal and any outputs 
using the failed reference will switch asynchronously. 

This mode allows the use of SD and HD video with video reference.

Remember that the clock-generator cards do not accept video reference signals.

Time Code Reference 
At the lower left portion of the rear of the frame are 2 connectors for time-code reference. 

The time-code reference is not used for master control.

Alarm Connections

System Alarms 
At the lower left portion of the rear of the frame is a DE9 connector for system alarms: 

This connector allows you to create alarm circuits of your own. (These are alarm outputs.)

The internal alarm signalling is provided by solid-state relays that turn on in the event of an 
alarm condition. This table describes the individual alarm connections: 
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Pin Signal Description Possible Alarm Condition(s)

1, 9 Alarm Com Common Common connection for all alarm signalling pins. This is a 
“return” for an external circuit.

2 Alarm 1 Major alarm Missing reference inputs, possible failure of fans or over-
temperature conditions on one or more modules.

3 Alarm 2 Minor alarm Any of alarms conditions 3, 4, 5 or 6.

4 Alarm 3 Power supply Main power supply module is missing. 
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Alarm Connections
Pins 2 through 8 signal alarm conditions that are signalled on either the primary or 
secondary control cards. The connector offers no way to distinguish which control card 
signaled the alarm.

Figure 4-2 shows sample system-level alarm circuits. Each pin of the connector monitors a 
specific function and activates a specific alarm. 

Fig. 4-2: Alarm Connections and On/Off Switches

Each of the 7 alarm connections corresponds to a solid-state, optically isolated relay. The relay 
allows current to pass in your external circuit when the alarm is on. The relay can accept up to 
30 VDC and tolerate up to 75 mW. Typical applications might use the following values for circuit 
1 above: 

Ext. Voltage Resistor Current Power 
5 V 470W 6.3 mA 19.15 mW
12 V 1600W 6.25 mA 62.5 mW

A current of about 6 mA is sufficient to illuminate LEDs brightly. 

Warning: do not reverse bias the alarm connections. They will not function and damage 
might occur.

Circuit 2, in Figure 4-2, controls relays to drive higher loads, such as lamps or speakers, possibly 
using AC. 

Caution: If your alarm load is inductive, protect the internal alarm relay contacts with a reversed-
biased diode. The external supply voltage should not exceed 30VDC and the load resistors 
should be sized to limit contact current to less than 150mA.

5 Alarm 4 Video reference Missing video reference signal 1 or 2 (if applicable). 

6 Alarm 5 AES or time code 
reference

Missing AES reference signals or loss of system clock. 

7 Alarm 6 Fans or internal 
Temperature

Failure of any one of three fans. Over-temperature condi-
tions on one or more modules.

8 Alarm 7 Controller health Control card(s) are not “healthy.”

Pin Signal Description Possible Alarm Condition(s)
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Power Supply Alarms 
At the lower right at the rear of the frame is a Phoenix 3-pin connector for power supply alarms: 

The frame has one alarm output for each power supply installed in the frame. (If a power supply 
module is removed, the alarm circuit is also.) An internal solid-state relay is provided for each 
supply. The relay turns on when there is an alarm condition.

Figure 4-3 shows sample power alarm circuits. Each pin of the connector monitors an individual 
power supply. 

Fig. 4-3: PS Alarm Connections

Each of the alarm connections corresponds to a solid-state, optically isolated relay. The relay 
allows current to pass in your external circuit when the alarm is on. The relay can accept up to 
30 VDC and tolerate up to 75 mW. Typical applications might use the following values for circuit 
1 above: 

Ext. Voltage Resistor Current Power 
5 V 470W 6.3 mA 19.15 mW
12 V 1600W 6.25 mA 62.5 mW

A current of about 6 mA is sufficient to illuminate LEDs brightly. 

Warning: do not reverse bias the alarm connections. They will not function and damage 
might occur.

Circuit 2, in Figure 4-3, controls electromechanical relays to drive higher loads, such as lamps or 
speakers, possibly using AC. 

Caution: The voltage of the external power supply for alarm signalling should not exceed 
30VDC. Resistors should be sized to limit the current through each internal alarm contact to less 
than 150mA. 

If the load is inductive, the alarm contacts should be protected with a parallel, reverse-biased 
diode.
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Power
Power 
The frame has two power supply bays (and two power connectors) to support redundancy. Only 
one power supply is actually required.

Connectors
At the middle right portion of the rear of the frame are 2 AC connectors: 

The frame has one (IEC) 3-conductor power connection for each of its 2 power supplies. These 
should be connected to a 90–130VAC or 180–250VAC 15A grounded circuit wired in accordance 
with local electrical codes. The power supplies operate at either 50 or 60 Hz.

Fuses for both AC power inputs are located on their respective power supplies. Ensure that the 
fuse ratings comply with specific requirements in your area. A 7.5A fuse is required for 110/
120VAC applications. For 220/240VAC operation, a 3.75A fuse is required. 

For increased protection against loss of power, we suggest that each power supply be 
connected to a separate branch circuit. A removable wire bail grips the power cable and hold it 
in place to reduce the possibility of accidental loss of power. 

The power cords represent the only means of disconnecting main power from the frame. Make 
sure to clearly mark the line side power connection with its function so that in the event of an 
emergency, power can be disconnected quickly. Disconnect both power cords before servicing 
any internal frame components. 

Power Supplies
The top power connector corresponds to the power supply on the left and the bottom 
connector corresponds to the power supply on the right (as you face the front of the frame). 

Only one power supply is required, but you can use two for redundancy. 
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Ground Lug 
At the lower left of the rear of the frame is a ground lug: 

Connect this “lug” to earth ground using 8–14 AWG wire.

Local Sources
We define “local sources” as those being connected directly at the backplane of the master 
control frame, and not through a set of routers controlled by an NV9000 router control system. 
(They might be switched at a small local router or patch bay. The essential point here is that the 
sources do not come from a NV9000 system.) 

These include: 

• Main sources — video only or video with a combination of embedded and discrete audio 
sources. Local main sources do not include router pre-select sources or external router 
sources. 

• Keyer sources — video only, “fill,” “key,” or both. Up to 8 pairs per MCE/MCPM. 

• Squeezeback backgrounds — video only. Up to 32 per MCE/MCPM. 

Enhanced squeezeback can use a second source (with or without embedded audio) but the 
second source is connected as either a main source or an external squeeze source (from a 
router).

• Audio overs — AES, up to 4. These audio sources compose the audio over, “off-air,” and “aux” 
inputs. All other discrete audio sources are treated as belonging to a main video source. 

It is possible for each audio over to consume 8 inputs per MCE/MCPM. 

An MCE or MCPM-SDHD has an over dedicated to audio from squeezeback image 2. 

An MCE configured for Intuition XG has an over dedicated to XG audio (called the XG 
over).

• Audio sources — analog or AES, these audio sources compose the “off-air” and “aux” inputs. 
All other discrete audio sources are treated as belonging to a main video source. 

It is possible for each of these two sources to consume 8 inputs per MCE/MCPM. 

For example: you have a VTR that delivers SD and AES channels 1–4. You’d use one BNC of one 
SD input card for the SD, and two BNCs on AES input cards for the audio. That would consume 3 
of the 128 inputs. This would be an example of video with discrete audio sources. 

The I/O connections you make are depend in part on the configurations that are possible in 
MasterConfig.

Although 128 inputs might seem plenty, the inputs can be consumed in large numbers. If 
you have multiple master control frames, it might not be a problem. In a single frame, you’ll 
want to share as many inputs as you can among the MCPMs and MCEs.

Ground
Lug
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Local Sources
Important Points to Remember
The various MCPMs allow different numbers of main sources. (Keep in mind that a main source 
can use more than one input.)

MCPM-SD 128 MCPM-HD, -HD2 64 MCPM-SDHD 641

MCPM-MK-SD 128 MCPM-MK-HD 16 MCE 20481

You can mix any MCPMs and MCEs in a frame as you like as long as they fit in the available 
output slots. The following points might affect where you place MCPMs and MCEs.

• An MCE, MCPM-HD, -HD2, MCPM-MK-HD, or MCPM-SDHD expect video inputs (main 
sources, keyers, squeeze background sources) in the range 1–64 (i.e, input slots 1–4). 

• In the same vein, an MCE, MCPM-HD, -HD2, MCPM-MK-HD, or MCPM-SDHD will not allow 
audio inputs (overs, aux, or off-air) in the range 1–64 (i.e, slots 1–4). 

• The MCPM-SD and MCPM-MK-SD allow video or audio inputs in any position in any slot. 

Note also that the 16 inputs for the MCPM-MK-HD are on its backplane module. They are not 
routed through the frame’s motherboard. These inputs exist in addition to the 128 potential 
inputs in the input slots.These inputs are HD only, and not SWB. These inputs are not accessible by 
other MCPMs or MCEs.

Local sources, router pre-select, external router sources, and MFR inputs share the input space. 
Further, inputs always come in sets of 16. If you need 17 inputs of some type, you’ll need 2 input 
cards. The implication is that you will have allocated 32 inputs. You must find some way to 
balance your requirements. Deploying multiple Master Control frames is one way to solve the 
problem. 

DB25 connectors (analog audio) require breakout cable. Miranda’s WC0053 is such a cable. (Its 
length is 15 feet.) Each DB25 supports 4 inputs (8 pairs). See WC0053 Breakout Cable on 
page 188. 

Phoenix 3-pin quick-release connectors (for AES) require cable construction but it is not difficult, 
require no special tools or precision, and the connectors are already present.

Potentially, all 128 inputs could be video with embedded audio for SD systems. That would be 
64 inputs for HD systems. 

If you run out of inputs, it is possible to use a small router (such as Miranda’s compact routers) or 
a patch panel to multiplex sources onto a single input. Implied is that the control (or patch) 
panel is quite near the MC panel.

DIN-to-BNC breakout panels are available. The part number for these 1RU panels is NV5100MC-
BOP. Each BNC connector on the panel is coupled to a 2 m cable with a DIN connector.

(Local) Main Sources
Local main sources are those connected directly at the master control backplane. Main sources 
can be also configured as router pre-select sources and external router sources. Main sources 
can be internal black/silence.

You have 3 choices: video alone, video with embedded audio, video with discrete audio. It is 
possible to combine embedded audio and discrete audio for a single main source.

1. Although the MCE allows 2048 main sources, only 64 may be connected at the NV5100MC backplane.
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There is no restriction on inputs (video or audio) for SD: the range for each is [1–128]. HD video 
inputs must be in [1–64] and audio must be in [65–128] except that MK-HD video must be in [1–
16] and come from the MK-HD backplane.

Although MCEs allow 2048 main sources, only 64 may be local sources. The remainder must 
be external router sources.

Video 
For MCPMs, video can be analog, SD, or HD. (Analog video is converted to SD at the input card.) 
MCEs do not accept analog video inputs. 

Note that if an MFR is present, an analog video output card would convert internal SD (and not 
HD) to analog output. 

Connect your analog video source to a BNC of one of your analog input backplane modules. 

Connect your SD video source to a BNC of one of your SD input backplane modules. 

Connect your HD video source to a BNC of one of your HD input backplane modules or to the 
backplane of an MCPM-MK-HD.

Discrete Audio
Discrete audio can be analog or (synchronous) AES or a combination of the two. Dolby E audio is 
possible. An MCPM can accept up to 8 individual channels (or 4 channel pairs). An MCE can 
accept up to 16 individual channels (or 8 channel pairs).

Connect an analog audio source to a set of DB25 terminals using a DB25 breakout cable such as 
the WC0053. An analog audio input card and backplane are required. Analog stereo pairs can be 
split — connected at different inputs. An MCPM or MCE can also be configured to take an 
analog stereo pair from different inputs. (Each input comprises 3 wires: “+”, “–” and shielding.)

Connect an AES source to a BNC or Phoenix connector. An AES input and backplane are 
required. Phoenix connectors support balanced signals. Although AES pairs cannot be split, the 
MCPM or MCE can be configured to take an AES pair from different inputs. (Each Phoenix input 
comprises 3 wires: “+”, “–” and shielding.)

See Misc. Connectors on page 193 for detail.

Embedded Audio
Video with embedded audio is either SD or HD. Straight AES or Dolby E. MCPMs accept up to 4 
AES pairs (8 channels). MCEs accept up to 16 channels (8 pairs) but currently process only the 
first 8 and pass the second 8 through to output unprocessed. 

You’ll configure the main source in MasterConfig according to the particular details of the 
embedded audio. You can mix embedded Dolby, embedded AES, and discrete audio (analog or 
AES).

If a main source has only embedded audio, then only the video connector is required.

(Local) Keyer Sources
Local keyer sources. are those connected directly at the master control backplane. Keyer sources 
can be also configured as external router sources. 
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Local Sources
A keyer is typically a pair of video sources: a fill source and a key source. However, “self-keyers” 
use only a fill source. (The key source is also sometimes called a “cut” source.)

Up to 8 keyer sources (potentially 16 video inputs) may be defined for each MCE or MCPM. Some 
or all of those sources may be external keyer sources. It is possible for multiple MC processors in 
a single master control frame to use entirely different keyer inputs. You probably want to avoid 
that situation.

Up to 20 inputs can be required if an MCE or MCPM uses both discrete and external keyers. 
External keyer sources consume either 3 (self-keying) video inputs or 6 (regular) video 
inputs.)

For MCPMs, keyers can be analog, SD, or HD. (Analog video is converted to SD at the input card.) 
MCEs do not accept analog keyer inputs. 

You cannot mix an SD keyer with HD program output or vice versa. 

Connect your analog keyer source to a BNC of one of your analog input backplane modules. 

Connect your SD keyer source to a BNC of one of your SD input backplane modules. 

Connect your HD keyer source to a BNC of one of your HD input backplane modules or to the 
backplane of an MCPM-MK-HD.

Although MCEs allow 2048 keyer sources, only 8 may be local sources. The remainder must 
be external router sources.

(Local) Squeeze Background Sources
A squeeze background is a video source. 

Local squeeze background sources. are those connected directly at the master control 
backplane. 

MCEs do not support squeeze local squeeze backgrounds — only those squeeze back-
grounds defined as main sources (or internal black).

You’d be tempted to think (using MasterConfig’s External Router Sources page) that you can 
define external squeeze source(s). Although you can provide an entry in this page, the 
squeeze pages allow only local inputs (but not for MCEs) and main source selections.

For MCPMs, squeeze backgrounds can be local discrete inputs, analog, SD, or HD (or taken from 
the main sources, or generated as internal black). (Analog video is converted to SD at the input 
card.) 

MCEs do not accept local squeeze background sources. Squeeze backgrounds in MCEs can be 
main sources or internal black. 

Up to 32 squeeze sources (32 video inputs) may be defined for each MCE or MCPM. These may 
be local sources (not for MCEs), main sources, or internal black. It is possible for multiple MC 
processors in a single master control frame to use entirely different inputs. You probably want to 
avoid that situation.

Connect your analog squeeze source to a BNC of one of your analog video input backplane 
modules. 

Connect your SD squeeze source to a BNC of one of your SD input backplane modules. 

Connect your HD squeeze source to a BNC of one of your HD input backplane modules or to the 
backplane of an MCPM-MK-HD.

You cannot mix an SD squeeze background with HD program output or vice versa. 
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Squeeze image 2 sources — really another matter — are not separate inputs. They are taken 
from the set of main sources.

(Local) Over Sources
Audio overs are audio signals overlayed on (or mixed with) the audio of program output. 

Local over sources are those connected directly at the master control backplane. Over sources 
can be also configured as router pre-select sources and external router sources. 

For MCPMs and MCEs alike, an audio over source is a set of discrete AES inputs AES. Dolby is not 
supported. 

Up to 4 overs may be defined for each MCE or MCPM. Each over can use up to 8 inputs (4 pairs). 
It is possible for multiple MC processors in a single master control frame to use entirely different 
inputs. You probably want to avoid that situation.

An AES card and backplane are required. Connect an AES source to a BNC or Phoenix connector. 
Phoenix connectors support balanced signals. Each Phoenix input comprises 3 wires: “+”, “–” 
and shielding. In either case, BNC or Phoenix, the MCPM or MCE can be configured to take an 
AES pair from different inputs. 

(Local) Audio Sources
Local audio sources are auxiliary signals that may be directed to the audio meters or monitors. 
They are not directly accessible by the processing buses of an MCPM or MCE. 

Each MCPM or MCE can direct two auxiliary audio inputs to audio monitors or audio meters. 
These sources are called, respectively, “off-air” and “aux.” Each source uses a set of up to 8 AES 
inputs. It is possible for multiple MC processors in a single master control frame to use entirely 
different inputs. You probably want to avoid that situation. 

An AES card and backplane are required. Connect an AES source to a BNC or Phoenix connector. 
Use Phoenix connectors for balanced signals. Each Phoenix input comprises 3 wires: “+”, “–” and 
shielding. The MCPM or MCE can be configured to take an AES pair from different inputs. 

NV9000 Sources
There are two ways for master control to access NV9000 sources: router pre-select and external 
router sources. Router pre-select applies to main sources and audio over sources. External router 
sources may be main sources, keyer sources, squeeze sources, and over sources. The behavioral 
difference between router pre-select and external router sources is described in the iMC Refer-
ence Manual. 

In brief:

• Router pre-select sources are explicitly selected by the operator by browsing NV9000 device 
categories. It is the router destination that is important during configuration. 

• There is no real limit to the number of router pre-select sources. 

• External router sources are preselected during MCE and MCPM configuration. The operator 
probably has no knowledge of which sources are external and which are not. It is the router 
source that is important (during configuration).

The number of external sources is limited to the number of sources configurable. 
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NV9000 Sources
In most if not all cases, a source from a router connects at the master control backplane as do 
local sources. However, the other ends of the cables connect to router outputs. 

NV9000 Connection
A pre-requisite for router sources is a connection between the NV9000 controller(s) and the 
master control system: 

The connection is fairly simple: it is just an Ethernet cable from each NV9000 controller’s master 
control port to the Master Control Ethernet switch. If you have a stand-alone NV9000 system, 
disregard the connection for the secondary controller.

The one complication might be determining which of the NV9000 ports is the master control 
port. Technically it’s the one you set up to match the master control network. But which RJ-45 on 
the back of the NV9000 box(es)? There are two defaults: very old NV9000 frames and new ones: 

Although it is not strictly a master control topic, a redundant NV9000 system also requires a 
crossover Ethernet cable between the control ports and a serial cable between the COM1 ports 
on each NV9000 controller. This shows the COM1 port and the default location of the control 
network port: 
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NV920 Connection
An NV920 is an alternate system controller. To access the NV920’s router sources, a connection is 
required between the NV920 controller(s) and the master control system: 

As for the NV9000, this connection are fairly simple: it is just an Ethernet cable from each NV920 
controller’s master control port to the Master Control Ethernet switch. If you have a stand-alone 
NV920 system, disregard the connection for the secondary controller.

Use one of the 3 available network ports for the master control net. 

Router Pre-Select
Router pre-selection applies to main sources and over sources. An MCPM or MCE configuration 
defines a main source “virtual button” (one of 16) as “operator modifiable” which means that the 
button can be used for router pre-selection. A control panel configuration then defines the 
NV9000 device categories that are selectable for router pre-selection (up to 10 categories). 

Similarly for over sources, an MCPM or MCE configuration defines an over source button (one of 
2) as “operator modifiable.” A control panel configuration specifies the NV9000 device catego-
ries that a connected MCPM or MCE can use. Over sources and main sources share the same 
NV9000 device categories. 

Router pre-select sources connect at the backplane the same way local sources do. The 
difference is that router pre-select inputs are connected to router outputs that compose a 
router destination in the NV9000 control system whereas inputs of local sources are 
connected directly to the outputs of devices. 

It is possible for a “local” source to be connected through a small independent router or 
through some other means, but such a router is not controlled by an NV9000 system.

Under router pre-select, the MCPM or MCE configuration specifies the router destination to 
which NV9000 sources are routed. A destination is a logical, not physical entity, belonging to a 
level set (NV9000 term). The level set determines what signals are routed. 

Generally, a level set includes one video level (SD, for example) and one or more audio levels 
(AES 1/2, AES 3/4, etc.). Video with embedded audio is considered just one level.
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NV9000 Sources
To connect the destination to the master control backplane implies connecting one video cable 
and one or more audio cables. This example shows the cabling for a destination that has 3 
levels: SD, AES 1/2, and AES 3/4: 

The router destination ID is specified, during MCPM or MCE configuration, for the source. 

The preceding illustration shows a main source. Over sources are similar, but all the connections 
are audio. 

For video sources, if you have an HD MCPM and SD MCPM in the same frame, it is not likely 
that they can share the same connectors. 

Squeeze background sources and squeeze image 2 sources can be selected from the set of 
main sources. These can include router pre-select sources.

It is possible to have more than one router pre-select source “button” defined for an MCE or 
MCPM. You might, for example, need a different router pre-select source for the preset, 
program, preview, and aux buses. 

If you have more than one MCPM or MCE in a frame, they may use the same router-preselect 
destinations or different router pre-select destinations. 

External Router Sources
The connection of external router sources is different: 

External main sources require 2 connections, A and B, where the A and B form a resource pool 
from which the available resource is selected. The A and B connections must be equivalent, 
albeit on different connectors. 

Similarly, external keyer sources require a pool of 3 connections. The connections in this pool 
must be identical, albeit on different connectors. And similarly, over sources require a pool of 2 
identical connections, A and B. 

For video sources, if you have an HD MCPM and SD MCPM in the same frame, it is not likely 
that they can share the same connectors. 

Squeeze background sources and squeeze image 2 sources can be selected from the set of 
main sources. These can include external main sources.
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These connections support all the external sources you might define. The limit to the number of 
external sources is in the configuration software: you may define up to 2048 (or 128, 64, or 16) 
main sources any or all of which may be external, up to 8 keyer sources any or all of which may 
be external, or up to 4 over sources, any or all of which may be external. 

The MCE allows 2048 main sources and 2048 keyer sources. Most of these will be external 
router sources.

The effect is that the operator selects the external router source without knowing whether the 
source is external. That is because, the external router source is defined as a main source (or 
keyer source or over source) during MCPM or MCE configuration. The router source ID specifies 
the source.

(The NV9000 control system and master control cooperate to make the switch in the router.)

External squeeze sources come through the external squeeze BNCs even when they are 
handled as main sources.

Master Control Network
The master control network connects Imagestore 750s, MCPMs, MCEs, master control panels, 
configuration PCs, and optionally, Intuition XG processors, tally processors, and device control-
lers. If you are using an NV9000 control system, it is also connected on the master control 
network. The NV5100MC frame is not on the network.

Before you connect MCPMs or MCEs to the Ethernet switch of the network, use MasterDiag to 
assign (through their diagnostic ports) their IP addresses. 

Before you connect hardware control panels to the Ethernet switch of the network, assign their 
IP addresses. Use their menu system to do so. 

Software control panels (GUIs) and configuration software execute on PCs which connect on the 
master control network. Ensure that the PCs have IP addresses on the master control network.

Subnet masks are always 255.255.255.0.

This is a sketch: 

All MCPMs and MCEs ship with the same default IP address. All control panels ship with the 
same default IP address. If you have purchased more than one MCPM, MCE, or control panel, 
do not connect and power them on all at the same time until you have configured unique IP 
addresses for all devices.
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This diagram shows some connector detail: 

MCPMs 
Before you can place an MCPM on the master control network, you must assign it an IP address. 
Doing so requires a straight-through serial cable and MasterDiag in serial mode. This is the cable 
connection: 

Follow these steps:

1 Connect a straight-through serial cable from a COM port (typically COM1) of your PC to the 
diagnostic port at the front of the MCPM. The diagnostic port is a female DE9. The protocol is 
RS-232 and the Baud rate is 115,200. There are no options for parity, data, or stop bits in Mas-
terDiag.

2 Launch MasterDiag. Choose serial mode from the ‘Communications’ menu. Choose the COM 
port at this time if necessary. 

3 Choose the ‘Ethernet Settings’ tab. We recommend that you click the “Read’ button first. 
Then enter the IP address and subnet mask (255.255.255.0) for the MCPM. Click the ‘Write’ 
button. 

4 You can disconnect the MCPM at this point, because you can use Ethernet communication 
through the master control network for all further modifications.

5 Repeat steps 1–3 for all MCPMs you want to be in your master control network. Each device 
on the network must have a unique IP address. 
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MCEs
Before you can place an MCE on the master control network, you must assign it an IP address. 
The process is the same as for MCPMs, but the cable is different. This is the cable connection: 

If you have not done so, obtain or fabricate a DE9-to-Phoenix cable. Then, follow these steps:

1 Connect the DE9-to-Phoenix from a COM port (typically COM1) of your PC to the diagnostic 
port of the MCE. The diagnostic port is the upper lower 3 pins of a 6-pin Phoenix connector. 
Like its counterpart in the MCPM, the MCE’s diagnostic protocol is RS-232 and the Baud rate 
is 115200. There are no options for parity, data, or stop bits in MasterDiag.

2 Launch MasterDiag. Choose serial mode from the ‘Communications’ menu. Choose the COM 
port at this time if necessary. 

3 Choose the ‘Ethernet Settings’ tab. We recommend you click the “Read’ button first. Then 
enter the IP address and subnet mask (255.255.255.0) for the MCE. Click the ‘Write’ button. 

You can disconnect the MCE at this point, because you can use Ethernet communication 
through the master control network for all further modifications.

4 Repeat steps 1–3 for all other MCEs you want in your master control network. Each must 
have a unique IP address. 

Hardware Panels

Ethernet
First, enter the IP address and subnet address in the appropriate submenu of the panel’s menu 
system. This step will vary from panel to panel. 

For most panels, choose the ‘Panel’ button from the menu, then choose ‘IP Setup’ from the 
resulting submenu and proceed. Some panels have a “LAN 2” option. Use LAN 1 and ignore LAN 
2.

It is not necessary to restart the panel.

Then, using an Ethernet cable, connect the panel to the Ethernet switch of the master control 
network. Some panels have one Ethernet port; others have two. Use “LAN1” if a panel has two.

GPI
All hardware panels have GPI/Alarms connectors that support 2 optically isolated GPI inputs and 
2 GPI relay outputs. The alarm signals on the connector represent the health of the panel. 

You can connect these to circuits of your own. Refer to Control Panel Connectors on page 198 
for the pinouts. 
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This is GPI input (for panels): 

There is a Schottky diode across the GPI input terminals to prevent damage to the internal 
circuitry (if you happen to reverse the input connection). And if you do, the input circuit won’t 
work, even if it survives. 

During panel configuration you can specify the polarity of the GPI inputs. That is (1) whether a 
GPI input button on the panel goes high-tally or low-tally when an input switch is closed.

This is GPI output (for panels): 

The outputs are mechanical SPDT relays with 3 terminals. You can switch fairly large loads with 
these relays. The panels’ alarm relays are the same. 

This is GPI/Alarm pinout (for panels): 

An alarm will clear when all of the triggering conditions are off for 5–10 seconds continuously. 

Power applied to the GPI inputs can be from 5 to 24 VDC, and less than 30 mA, typically, 5 V at 
1 mA. Loads for the GPI and alarm outputs can be larger: 

Max current: 1 A
Max voltage: 125 VAC, 110 VDC.
Max capacity: 62.5 VA, 33 W.
Rated loads: 1 A at 30 VDC; 0.3 A at 110 VDC; 0.5A at 125 VAC.
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In case you are using the WC0053 breakout cable for the GPIs and alarms, these are the WC0053 
wire numbers and colors: 

The colors of the wiring bundles tells you the functions of the bundles.

PCs
PCs can have one or more Ethernet ports. (Your NV9000 system controller, if you have one, has 6 
Ethernet ports by default). 

Configure one of your PC ports to be on the master control network. 

Follow these steps to configure IP addresses on each PC. 

1 Using the Windows Start menu on the Configuration PC, choose Settings > Network Con-
nections > Local Area Connection.

2 Set the IP address and subnet as shown. Each PC on the master control network must have a 
unique address on the network. 

The subnet address should be 255.255.255.0. 

WC0053 Pinout for GPI/Alarm Connectors

Bundle Jacket Color

DB25 Pin

GPI/Alarm FunctionRed (+) Black (–) Drain

1 Brown 24 12 25 Major

2 Red 10 23 11 Minor

3 Orange 21 9 22 (not used)

4 Yellow 7 20 8 GPI Input 1

5 Green 18 6 19 GPI Input 2

6 Blue 4 17 5 GPI Output 1

7 Violet 15 3 16 GPI Output 2

8 Gray 1 14 2 (not used)
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3 Click ‘Advanced’. Choose the DNS tab and ensure the settings appear as shown here: 

These values are the same for all PCs in the network. 

4 Choose the WINS tab and ensure the settings appear as shown here: 

These values are the same for all PCs in the network. 

Other than the IP address, the settings are typical Windows® XP default selections.

Important: DNS, WINS, or any other form of name resolution are not required and should 
not be enabled. 

DNS Tab

WINS Tab
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Tally Processors
The tally processor is slightly different because it is a third-party device.

First, connect the tally processor to the master control Ethernet switch. Use the front panel 
“menu” of the tally processor to define its IP address (which must be unique on the master 
control network).

Following that step, you can access the tally processor’s internal configuration software through 
a browser on your PC (such as Internet Explorer). To launch the software, type in the box’s IP 
address as the URL. Perform configuration as required and as directed in the Tally Processor User’s 
Guide.

You will have to fabricate cables to the tally processor’s GPIs (up to 32 inputs) and GPOs (up to 
32 outputs) connecting them to the appropriate switches and circuits at your facility. See Tally 
Processor Connectors on page 185.

You can connect the GPIs of control panels, MCPMs, and MCEs to the tally processor GPIOs. 

The tally processor receives event notification (e.g., preset keyer selected, transition occurred) 
from master control. The tally processor sends event commands (e.g., take, keyer on/off, transi-
tion) to master control based on its internal event-monitoring list (which you must configure). 

Device Controllers
The DC21 device controller, like the tally processor, is a third-party device. It is a 1RU processor 
that functions as an intermediary between your MCEs and devices that require machine control.

Your master control network can have more than one DC21. The configuration of every MCE 
that performs machine control identifies the DC21 with which it will communicate. A single 
DC21 could receive commands from more than one MCE. 

Ethernet Connection
First, connect the device controller to the master control Ethernet switch. Use the front panel 
“menu” of the device controller to define its IP address (which must be unique on the master 
control network).

In MasterConfig’s general settings, for each MCE that is to communicate with the DC21, specify 
that IP address for the device controller’s address.

You can access the device controller’s internal configuration software through a browser on 
your PC (such as Internet Explorer). To launch the software, type in the box’s IP address as the 
URL. Perform configuration as required and as directed in the Device Controller User’s Guide.

The device controller receives commands, through the master control network, from the MCE(s) 
that have been configured to communicate with it. 

Ports Connections
The DC21 can control up to 4 devices on its 4 serial ports using one of 3 protocols: Sony, Odetics, 
or VDCP. It can control up to 16 other devices with 100 ms start and stop pulses on its GPO lines. 

The devices you connect on the serial ports must, of course, recognize one of the available 
protocols. The device controller’s DE9 pinout is shown in Device Controller Connectors on 
page 186.
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Under master control, the DC21’s 32 GPO ports are paired (1,2), (3,4) and so on up to (31,32). This 
gives you control over 16 devices. The odd port in the pair carries a start pulse and the even port 
in the pair carries a stop pulse. MCEs can use these ports for device control as long as the device 
in question recognizes 100 ms start and stop pulses. Actual wiring of the GPO connections 
depends on your device(s). The port pinouts are also shown in Device Controller Connectors on 
page 186.

The DC21’s 32 GPI ports remain available but master control does not use them. It is possible to 
configure any GPOs not used by master control to be switched by the GPIs and by state changes 
in controlled devices. 

Intuition XG
The Intuition XG system is a single- or dual-channel graphics processor coupled with Xmedia 
software. When it is integrated with an NV5100MC master control system, the Intuition XG 
processor feeds HD or SD keys (fill and key video inputs with up to 16 audio channels) to MCEs. It 
provides multi-level character generation, and animation, still, and clip playout with multi-
channel audio. 

This guide does not address Xmedia creative software at all. Any discussion of installation 
and configuration is limited to the role of Intuition XG in the master control system. Please 
refer to the Intuition XG and Xmedia documentation available from Miranda.

Connections
This diagram shows the required Intuition XG connections: 

The Intuition XG processor is the subsystem’s graphics processor and provides the XG configura-
tion, video storage, and access to a network of graphics tools, information databases, and so on. 

Operators at master control panels use (and choose) the XG “layers” created or stored within the 
Intuition XG processor as they would choose any other video effect.

A dual-channel Intuition XG processor has 4 video outputs, fill and key for each channel. A 
single-channel Intuition XG processor has only two. 
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Ethernet 
The Intuition XG processor and the MCE communicate on the master control network. First 
connect the Intuition XG processor to the Ethernet switch. Then, in MasterConfig’s Intuition XG 
page for the MCE, specify the IP address of the Intuition XG processor. 

Video Cables 
The Intuition XG processor delivers one or two (fill, key) pairs to the master control system 
through an SWB card (a requirement). The MCE configuration identifies the ports through which 
the signals enter the master control system.

Video cables connect to the Intuition XG processor with an 8-BNC breakout connector. One of 
those cables is video reference (Analog Ref In). Note that the required reference is either NTSC or 
tri-level (1080i/59.94). The MCE can use tri-level, NTSC, or PAL reference. If the references 
supplied to the Intuition XG and MCE are different (e.g., one is using NTSC and the other is using 
tri-level) the two references must be properly timed. 

The 4 video cables on the breakout connector are labeled: 

(Program) (Preset)
SDI out A SDI out B “fill”
SDI out C/key SDI out D/key “key” 

If your Intuition XG processor is single-channel, do not connect cables to SDI outputs B and D. 

These cables feed to 4 (or 2 if single-channel) SWB input connectors on the master control 
frame’s backplane. Enter your connector choices in MasterConfig’s ‘Intuition XG’ page. 

Panels
No Intuition XG connections are required for panels. However, you will want to consider on 
which panels you place XG layer buttons. (The XG layer buttons operate somewhat like keyer 
buttons.)

For a single-channel Intuition XG processor, an XG layer can use any of the 3 keyers. A dual-
channel Intuition XG requires keyers 2 and 3. Remember that keyer 1 is pre-squeeze in the 
effects ordering and keyers 2 and 3 are post-squeeze.

When an XG layer button is active, the keyer it uses becomes inaccessible as a keyer. (An XG 
layer button is active when a panel controls an MCE with Intuition XG enabled.)

More Information
Intuition XG requires pre-roll enabled in the MCE and a pre-roll value of 6 frames for interlaced 
video or 12 frames for progressive video. The “pre-roll” value is just a delay value; there is no 
tape motion.

See Intuition XG configuration on page 106.

Configuration for Intuition XG involves both MasterConfig for your MCEs and MCS Panel Config-
uration Editor for your panels. 
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Kaleido-X
Master control can be integrated with a Kaleido-X multi-viewer (or monitor wall) in such a way 
that master control can trigger a Kaleido-X re-layout. The Kaleido system defines rooms (in which 
a multi-viewer exists) and layouts (the organization of views on the multi-viewer) for each room.

Panel operators can have available ‘Kaleido-X Layout’ buttons that trigger multi-viewer re-
layout. A channel change can also trigger a multi-viewer re-layout. 

Control panels, when they are controlling Imagestore 750s, can cause the source content of a 
monitor wall to change when the operator changes the current source group. In contrast, a 
multi-viewer re-layout changes the organization of the sources on the display. 

It is possible for the monitor wall router destinations (appropriate to Imagestore 750s) to be the 
same as the inputs to the Kaleido-X. 

Connections
This diagram shows the required Kaleido-X connections: 

The SDI (SD, HD, or 3Gig) inputs, from a router or other equipment, feed the inputs of the 
Kaleido-X. 

There are a number of Kaleido-X models, so the actual connectors and number of connectors 
might vary. For one, the Kaleido-X16 has 16 SDI inputs and two outputs, with DVI, HDMI, and 
BNC connectors for each output. 
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Configuration for MCEs and MCPMs
Chapter 5 is an introduction to the Master Control Installation Guide. 

Topics
Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81
MasterConfig . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82
MasterDiag  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93
MasterLogo  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93
MCS Panel Configuration Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  94
Tally Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103
Device Controller  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  105
Intuition XG  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  106
Misc. Topics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116

Please see Chapter 6 for information about Imagestore 750 configuration.

Introduction
Configuration for MCEs and MCPMs applies to control panels, MCPMs, MCEs, and tally 
processors. 

NV9000 system configuration is outside the scope of this guide. The use of UniConfig to set up 
routers (including MFRs) is also outside the scope of this guide, although it is addressed briefly, 
in the Introduction. See UniConfig and MRC on page 20.

The tally processor is third-party equipment and comes with its own built-in configuration 
utility that runs in a browser on a connected PC. Refer to the Tally Processor’s User’s Guide.

Other third-party equipment (e.g., automation systems, or router control systems) are also 
outside the scope of this guide.

All configuration pre-supposes a connected configuration PC. GUI configuration files require 
special handling. 

Configuration Tools
The NV5100MC series includes 4 configuration applications:

• MasterConfig

Configures master control processors (MCPMs and MCEs). 

• MasterDiag

Sets up MCPMs and MCEs. MasterDiag is also used for software uploads. 
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• MasterLogo

Converts logo artwork to the internal format required by MCPMs and MCEs. MasterLogo per-
forms the upload of logos to the MCPM’s or MCE’s logo store. 

• MCS Panel Configuration Editor

Configures master control panels. 

The tally processor’s configuration application is built-in. 

We recommend that you read the configuration user’s guides carefully. It is usually only neces-
sary to read the portions in which you have an interest. 

The following configuration tool summaries are meant to be helpful, but they are no substitute 
for reading the actual configuration manuals.

MasterConfig 
MasterConfig is the software that configures MCPMs and MCEs. 

When approaching MCPM and MCE configuration you should keep in mind that the various 
MCPM and MCE models are different, sometimes in subtle ways. Feature available in one might 
not be available in others. All MCPMs and MCEs operate independently. 

MCEs are advanced master control processors and differ from other MCPMs in these major 
areas: 

• MCEs support 16-channel audio. MCPMs support 8 audio channels.

• MCEs have preview and aux buses. MCPMs do not. These buses allow panel operators to 
view and compose effects with affecting on-air content.

• MCEs have extended features and features that MCPMs do not. For example, MCEs have two 
clean-feed outputs, not one. 

Your master control software comes with several default configurations. In fact, every MCPM or 
MCE that ships has some basic configuration. 

There are 6 default configuration files for MCEs: one for each video format supported by the 
MCE.

MCE_default_525.cfg MCE_default_625.cfg
MCE_default_720p_50.cfg MCE_default_720p_59_94.cfg
MCE_default_1080i_50.cfg MCE_default_1080i_59_94.cfg

Usage
MasterConfig is organized into several configuration pages roughly according what an MCPM or 
MCE can do. These are the pages:

1 General settings.

The ‘General Settings’ page defines fundamental properties of the MCPM or MCE and 
enables or disables several features. 

2 Main sources

The ‘Main Sources’ page defines program sources and associates video inputs with audio 
inputs. This page also defines certain squeeze background images and secondary squeeze 
images.
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3 Source groups

Source groups are available only for MCEs (and for Imagestore 750s).

The ‘Source Groups’ page allows the configurer to organize main sources into groups that 
conveniently fit on the buttons of master control panels. Operators then may select one or 
another source group when they wish to use the sources in the group.

Source groups must be enabled (in the general settings). When source groups are enabled, 
button mapping for main sources is disabled and vice versa. Operators will be able either to 
choose source groups or to perform button mapping. 

4 Over sources

The ‘Over Sources’ page defines audio over sources.

5 Audio monitors and meters (and analog outputs)

This page configures the way the MCPM or MCE handles audio metering outputs.

6 Keyer sources 

The ‘Keyer Sources’ page defines keyer sources.

7 Logo images 

The ‘Logo Images’ page identifies logo image files that are to be used by logo keyers.

8 Logo keyer sources 

The ‘Logo Keyer Sources’ page defines logo keyers.

9 Squeeze settings 

The ‘Squeeze Settings’ page defines squeezeback settings. The squeeze settings page 
applies to squeeze backgrounds whereas the squeeze 2 settings page applies to squeeze 
image 2.

The MCPM-MK-SD and -MK-HD do not provide squeezeback. The MCPM-SDHD and MCE 
offer squeeze “image 2” functions as part of enhanced squeezeback.

10 Squeeze 2 settings [-SDHD and MCE only]

The ‘Squeeze 2 Settings’ page further defines squeezeback settings. Whereas the squeeze 
settings page applies to squeeze backgrounds, the squeeze 2 settings page applies to 
squeeze image 2.

11 RS-422 communication settings 

The RS-422 page configures the master control automation settings.

In this page, you can specify a remapping that allows automation to control XG layers (at the 
expense of other video effects). This page is for MCEs only. Do not use this feature unless you 
are sure of what you are doing.

12 Button mapping — main source 

The main button mapping page defines where and how master control main sources are 
placed on control panel buttons.

Source groups must be disabled (in the general settings) if an operator is to perform button 
mapping. When source groups are enabled, button mapping for main sources is disabled 
and vice versa. 

13 Button mapping — over source 

The main button mapping page defines where and how master control over sources are 
placed on control panel buttons.
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14 Misc. settings 

The miscellaneous settings page defines miscellaneous MCPM or MCE parameters including 
which is the default main source and where the clean-feed tap occurs.

15 Video effect and over settings 

This page partially defines the behavior and certain defaults for video effects and audio 
overs.

16 Transition and fade-to-black settings 

This page defines the transition timing for transitions and fades.

17 GPI inputs 

This page defines the behavior of the two GPI inputs.

18 GPI outputs 

This page defines the behavior of the two GPI outputs. 

19 Wing outputs 

This page configures the outputs of (optional) wing output cards. 

It is available for the MCPM-HD2 and MCPM-SDHD only.

20 Aux outputs [MCE only]

This page configures the aux outputs of MCEs. It is available only for MCEs. 

21 ExtRtrSrc settings 

This page defines the ports used for external router sources.

22 Intuition XG settings 

This page defines the ports and other parameters for Intuition XG channels. The page is 
available only for MCEs.

Not every MCPM uses every configuration page. For example, the MCPM-MK-SD and -MK-HD do 
not have squeezeback and MasterConfig shows no squeezeback pages for those MCPMs.

With MasterConfig, you can, of course, save and re-open configuration files in your PC’s file 
system. You can manage configuration files any way you’d like. 

This is the general process to develop a configuration:

1 Choose an MCPM or MCE.

2 Read its configuration from the MCPM or MCE.

3 Modify its configuration.

4 Write the new configuration back to the MCPM or MCE.

You can develop configuration files “off-line.” It is not actually necessary to select an MCPM or 
MCE unless you want to read its configuration. 

You can start with a new “empty” configuration, use a default configuration, or use an existing 
configuration as the basis for a new one.

MCPM and MCE Characteristics
Besides the MCPM and MCE architecture and feature set — which you can read about in the 
reference manual — MCPMs and MCEs have some interesting characteristics.
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Assumption of Source Buttons
MCPMs and MCEs assume that a control panel has 16 main source buttons. Some have fewer 
physical main source buttons, but all have 16 “virtual buttons.” It is in MasterConfig that you 
specify how the virtual buttons are used. How the buttons are used is therefore an MCPM (or 
MCE) characteristic, and not a control panel characteristic. 

Router Sources
MCPMs and MCEs support two concepts: (1) external router sources and (2) router pre-selection. 

Router pre-selection relies on control panel configuration. Router pre-selection requires that at 
least one main source button (or at least one over button) being configured in MasterConfig as 
“operator-modifiable” or “system-modifiable.”

External router sources require nothing of the operator or of a control panel. However, external 
router sources can require a commitment of many input connectors at the rear of the master 
control frame. 

There can be potentially thousands of router pre-select sources. Those can vary daily without 
the MCPMs or MCEs requiring reconfiguration. The number of external router sources is limited 
to the number of main sources, over sources, keyer sources, and squeeze sources allowed by the 
MCPM or MCE. These do not vary. 

Automation
There are just a few automation options. The term “system modifiable” applies to source buttons 
that can be controlled by automation. 

MasterConfig also provides a remapping function that allows automation to control XG layers, 
by sacrificing other video effects. 

Preview and Aux
MCEs have 2 aux buses and might have a preview bus (if a preview board is present). MCPMs do 
not have these buses. 

The aux bus can be put to use in several very different ways. 

The control panels support the aux bus and the preview bus of the MCE. 

General Settings
There is a ‘General Settings’ page in which you define fundamental characteristics of the MCPM 
you are configuring.

Certain general settings enable (or disable) configuration pages. For example, its “Enable 
External Router Source” checkbox option enables the ‘ExtRtrSrc’ page. Unless you check that 
box, you will not see an ‘ExtRtrSrc’ page.

Certain general settings enable (or disable) options in the configuration pages. For example, the 
“Enable AutoRestore of Audio Mixer Settings” checkbox option causes an ‘Auto Restore’ 
checkbox option to appear on the main and over source configuration pages. 

Main Source Limits
SD MCPMs allow 128 video and/or audio inputs. 

HD MCPMs allow 64 video inputs in the range 1–64 and 64 audio inputs in the range 65–128. 
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The -MK-HD allow 16 video inputs, from its own backplane, and 64 audio inputs in the range 65–
128. These video inputs cannot be used by any other MCPMs or MCEs.

MCEs allow 64 physically connected video inputs in the range 1–64 and 64 audio inputs in the 
range 65–128. However, MCEs allow 2048 main sources most of which will be external router 
sources.

Each of an MCPM’s video sources can be configured with up to 8 audio sources. Each of an MCE’s 
video sources can be configured with up to 16 audio sources. Options include embedded audio, 
discrete audio, analog audio, and Dolby E encoding. 

An MCPM’s over sources can be configured with up to 8 audio inputs. An MCE’s over sources can 
be configured with up to 16 audio inputs. 

Misc.
The MCPM-MK-SD and MCPM-MK-HD have no squeezeback generator, only one logo, and no 
analog audio outputs. The MCEs have no analog audio outputs.

Choosing an MCE or MCPM
There is a list of MCPMs and MCEs at the left side of the MasterConfig window. You can click (or 
define or delete) any entry in this list. 

You can also enter the IP address of an MCPM or MCE directly at any time: 

You can create and edit a configuration off-line, without actually selecting an MCPM or MCE.

After you create a configuration, you can associate it with any of the MCPMs or MCEs in the list. 

Be careful, when writing data, not to load a configuration into an MCPM of the wrong type. 
There are some safeguards, but they are not fool-proof.

Editing
A new configuration starts with a dialog asking what MCPM type you want to configure and for 
what video standard: 
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General Settings
Use the General Settings page to specify the very basic parameters of your MCPM. The page 
varies with the MCPM. Figure 5-1 shows some of the variations: 

Fig. 5-1: MasterConfig General Settings Window

It is in this page that you can name the MCPM or MCE and specify the IP addresses of the 
NV9000 system (if present) from which you want to obtain source and destination IDs (if they 
apply).

If you have enabled external router sources and not router pre-select, this section of the 
general settings page changes: 

In this case, you must enter a virtual IP address. (This requires that the NV9000 system sup-
port virtual IP addresses.) The ‘ExtRtrSrc’ page also requires you to enter the virtual IP 
address because external router sources require the use of a virtual IP address. 

MCE

MCPM-SD
MCPM-MK-HD
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There are several complex and inter-related options in this page. Refer to the MasterConfig User’s 
Guide for information. 

You must click the ‘Apply’ button to confirm and capture the choices you make in this page.

Main Sources
Use the Main Sources page to list, and define, video sources. Specify the source mnemonic, the 
video and audio input connections, and audio channel usage. Use this page to specify the audio 
sources to be associated with this video. Audio may be embedded or discrete. 

A main source may be from a router in which case it is specified as an external source, or it may 
be local (in which case it is specified as a master control input). A main source may also be inter-
nally generated black/silence in which case there are no connectors. 

When you specify an external source, you give its NV9000 source ID. 

When you specify a router pre-select source, you give the ID of a NV9000 destination through 
which the source is sent. 

When you specify a master control source, you give its backplane connector number.

Main sources can also be selected as squeeze background and squeeze image 2 sources. 
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This shows the ‘Main Source’ page for an MCE: 

It shows 16 audio channels. The ‘Initial Values’ button will automatically enter the connector 
numbers, starting with the value you specify at the top of the list.

The MCE does not support analog video.

The MCE does support machine control and pre-roll.
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This shows the ‘Main Sources’ page for an MCPM-SD: 

It has 8 audio channels. The video source can be analog.

This shows the ‘Main Sources’ page for an MCPM-MK-HD: 

The -MK-HD has no analog option, no Dolby option, and its 16 allowable inputs come from its 
own backplane or from external router sources.
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Video Effects and Audio Overs
There are pages (similar in style, but not content) in which you may specify logo parameters, and 
the parameters of logo keyers, video keyers, squeezeback effects, and audio overs. 

The MCPM-SDHD and MCE support enhanced squeezeback effects. Other MCPMs do not.

Audio overs allow router pre-select sources as do main sources.

Meters and Monitors
The different MCPM types have different audio monitor/meter features. One common feature is 
the “User can modify” option. What this means is that a panel operator can direct program, 
preset, preview, aux, or off-air audio to monitors or meters if you enable it in the check box(es).

The monitor outputs of MCPMs are partitioned so they distribute some portion of both monitor 
A and monitor B to the outputs. There are 4 partitions allowed: 

A, A, A, A
A, A, A, B You can reverse A and B if you need, for example, B, B, B, B.
A, A, B, B That amounts to pretending A is B and vice versa. 
A, B, B, B

MCEs do not partition the monitor outputs. In fact, each monitor output produces up to 16 
channels, embedded in a blank video stream. 

This shows the ‘Audio Monitor’ page for an MCPM-SD: 

It shows 8 audio channels. There is an analog output section and the A/B monitor channels are 
partitioned on the outputs.
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This shows the ‘Audio Monitor’ page for an MCE: 

It has 16 audio channels. The monitor outputs are not partitioned and there is no analog 
section. 

The audio monitor outputs include the 24 AES outputs on the MCE-AXM card. 
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This shows the ‘Audio Monitor’ page for an MCPM-MK-HD: 

The -MK-HD has no analog option, but its monitor outputs are partitioned as for other MCPMs.

MasterDiag
MasterDiag is a relatively small program, but nonetheless important. It is not really a configura-
tion program. With MasterDiag, you can do the following: 

• Set the IP addresses of MCPMs and MCEs.

• Upload MCPM and MCE firmware. There are two cases:

MCPMs. At times, you will be directed by tech support to upload firmware to an MCPM. The 
firmware files are not directly available. You must obtain them from tech support.

MCEs. There is a.nvz file (MCESoftwarePackage.nvz) in the ‘setup’ subfolder of the master 
control installation folder. If it becomes necessary — as when you receive new firmware — 

you can upload this firmware to an MCE. The single .nvz file is appropriate for all MCEs.

• Use the ‘Timing’ page to view timing characteristics of video and audio inputs of MCEs. 

• Use the ‘System Status’ page to set the time and date. 

MasterLogo
MasterLogo is a utility program that supports the use of logos in the master control system. Like 
MasterDiag, it is not really a configuration program. Logos can be static or animated. Animated 
logos can play once or loop, with or without pauses between passes of the loop. 

MasterLogo converts graphic files (.TIF, .BMP, .JPG, .TGA, .PNG, .GIF) to the internal form 
(10-bit YCrCb) required by master control. 
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It is MasterLogo that executes the upload of logos to MCPM or MCE when MasterConfig writes 
configuration to an MCPM or MCE. (The upload is an option. Logo upload can take a long time 
and MCEs don’t generally need it beyond the first upload.)

Logo Limits

MCPMs
MCPMs have up to 128 MB or up to 512 MB of RAM in which to store logos, depending on the 
model. HD logos require the larger memory. The maximum number of logos of any type is 64.

The first logo (identified in the MasterConfig logo images list by ‘selno 1’) is stored in non-vola-
tile memory (flash) and is always available immediately after an MCPM restarts. It must be static, 
not animated, and must be less than 1.7MB in size. The MCPM stores all other logos in logo RAM 
(which is volatile) and you must upload these logos to the MCPM after a restart. The upload 
process is semi-automatic. You will be prompted to upload them after a reset initiated by 
MasterConfig. The maximum file size for these logo images is 2.3MB per image.

The maximum number of frames for an animated logo image is 256. At 30 fps, that amounts to 
8.5 seconds of animation. At 25 fps, that is 10.2 seconds of animation. 

MCEs
MCEs have up to 2 GB of memory in which to store logos. The maximum number of logos of any 
type is presently 400. The maximum number of frames for an animated logo image is 900. 

All logos in an MCE reside in non-volatile storage. It is not necessary to reload logos at every 
restart. 

MCS Panel Configuration Editor 
The MCS Panel Configuration Editor (the “panel editor,” for short) has an assortment of configu-
ration pages whose presence and content vary depending on the control panel you are 
configuring.

As with other configuration tools, you should refer to the user’s guide for detailed information. 

The panel editor configures all NV5100MC control panels ever made, including the legacy 
panels and panels designed for specific customers: These include the FFCP, CFCP, PC GUI, SCP, 
CECP, CECP M1, CECP GUI, Aux/Preview GUI, FECP, iMC-Panel-200, iMC-Panel-300, and iMC-
Panel-GUI. 

For the iMC-Panel-200, iMC-Panel-300, and iMC-Panel-GUI, the panel editor provides two sepa-
rate sets of configuration pages, one set for the Imagestore 750, and the other set for MCEs and 
MCPMs. These panels can, therefore, control either Imagestore 750s or MCEs and MCPMs.

A panel configuration does the following:

• Defines which channels (MCPMs or MCEs) a master control operator can select. (You can 
configure a default channel which is especially useful if you have only one channel and do 
not want to waste a panel button on channel selection.)

The default channel can be configured as one of up to 4 automatically “ganged” channels. 
Such a configuration is called “automatic gang mode.” Whenever the default channel is 
selected (by any method) the defined channel gang automatically becomes active. (Auto-
matic gang control is not available for Imagestore 750s.)
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• Selects the NV9000 source categories the operator can use (if an NV9000 system is present).

• Defines configurable button functions. 

A panel might support features not available in the MCPM. For example: a panel might have a 
squeeze button when it is controlling an MCPM-MK-SD or -MK-HD. The squeeze button is 
disabled because these MCPMs have no squeeze function.

A panel might lack features that support MCPM or MCE features. For example: the aux bus or 
preview bus in an MCE cannot be accessed from an FFCP, CFCP, PC GUI, or SCP. Automation can 
do so, however, because it is not limited by any panel features. 

All but the iMC panels are considered legacy panels with respect to the iMC master control 
system.

Usage
The panel editor is organized into several tabbed configuration pages roughly according what 
an panel can do. These are its pages:

1 General settings

The ‘General Settings’ page is minimal: it allows you to name a control panel.

2 Channel selection list

The ‘Channel Selection List’ page allows you to define the channels a control panel can 
access, which channel is the default, and what salvo, if any, will execute when a channel is 
selected. 

The ‘Channel Selection List’ page also determines which channels, if any, are to be ganged 
with the default channel under “automatic gang mode.” 

3 User button layout 

This page defines configurable buttons in the upper section of a panel.

4 Bottom row layout 

This page defines configurable buttons at the front of the lower section of a panel.

5 Logging settings 

This page specifies several logging levels. There are 7 levels that can be applied to each of 8 
functions.

6 NV9000 settings 

This page specifies the IP address(es) of an associated NV9000 control system and specifies 
the NV9000’s source categories to be used by the panel.

7 Advanced settings 

This page specifies miscellaneous parameters which are not necessarily “advanced.”

8 Button assignments 

The panels allow a configurable number of main source buttons (from 0 to 16), and a config-
urable number of “layer” buttons (video effects, XG layers, audio overs, DVEs, DSKs). The but-
ton assignments page specifies the number of main source buttons, and places the video 
effects, etc., on the panel buttons in the order and position required. 

The iMC-Panel-GUI and iMC-Panel-200 have a “bank select” function. The iMC-Panel-300 
does not. 
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9 User menu lists 

This page exists for the SCP only. It allows you to create (and name) menu pages in the SCP’s 
hierarchical menu system.

10 Menu layouts 

This page exists for the SCP only. It allows you to define the button functions of menu pages 
you created in the ‘User Menu Lists’ page.

11 Aux delegates 

This page exists for panels that have aux buttons: the CECP, CECP M1, CECP GUI, Aux/Preview 
GUI, FECP, iMC-Panel-200, iMC-Panel-300, and iMC-Panel-GUI.

It allows you to assign “aux delegate” functions to configurable (non-main-source) buttons 
in the aux button row. (Pressing an aux delegate button changes the function of the aux but-
ton row.)

12 Audio monitoring layout 

This page exists for the FECP and iMC-Panel-300. It lets you redefine the audio metering/
monitoring button functions. (These are not generally configurable buttons. They have only 
audio functions.)

13 Audio macros 

This page exists for the CECP, CECP M1, CECP GUI, Aux/Preview GUI, FECP, iMC-Panel-200, 
iMC-Panel-300, and iMC-Panel-GUI. It lets you define up to 16 “audio macros.” Audio macros 
(1) perform “channel swaps”— audio crosspoint mappings — and (2) set channel gain. The 
audio macros can be assigned to panel buttons. Pressing an audio macro button causes an 
instant audio crosspoint change. 

With the panel editor, you can, of course, save and re-open configuration files in your PC’s file 
system. You can manage configuration files any way you’d like. 

This is the general process to develop a configuration:

1 Choose a panel.

2 Read its configuration.

3 Modify its configuration.

4 Write the new configuration back to the panel.

You can develop configuration files “off-line.” It is not actually necessary to select a panel unless 
you want to read its configuration. 

You can start with a new “empty” configuration, use a default configuration, or use an existing 
configuration as the basis for a new one.

Panel Characteristics
Master control panels have some interesting characteristics. The SCP (obsolete) is quite different 
from other panels. GUI configuration files are treated differently from hardware panel configura-
tion files. The iMC-Panel-100 is also different from other panels because its monitor is third-party 
equipment and separate from the button panel. 
96



Master Control
Installation Guide
GPI
All hardware panels have 2 GPI inputs and 2 GPI outputs. MCPMs and MCEs also have 2 GPI 
inputs and 2 GPI outputs. The GUIs (software control panels) do not have GPI inputs or outputs. 

A control panel can control and sense MCPM GPIs as well as its own GPIs. 

Assumption of Source Buttons
Some control panel have 16 physical main source buttons. Some panels have fewer, but have 16 
“virtual source buttons” that can be selected with a “bank select” button. The button switches 
the “bank” that appears on the physical buttons. 

(Some panels have a fixed set of video effect and audio over buttons. Some panels have a 
configurable set.)

Router Sources
Master control has two concepts: (1) external router sources and (2) router pre-selection. 

Panel configurations have little or nothing to do with external router sources. 

Panel configurations, however, do support router pre-selection. It is in the panel configuration 
that you specify (1) the NV9000 control system with which the panel communicates to obtain 
router sources, and (2) the source categories to which the panel has access. (Router pre-selec-
tion covers main sources and over sources.)

For router pre-selection to work, main source buttons and over source buttons must be config-
ured — in MasterConfig — as “operator-modifiable” or “system-modifiable.”

Automation
Control panels are not automated. However, all panels have a configurable button function that 
enables or disables MCPM or MCE automation. 

Source buttons (main and over) can be configured in MasterConfig as “system-modifiable.” This 
is in fact an MCPM or MCE characteristic, not a panel characteristic. 

A panel’s buttons reflect an MCPM’s or MCE’s status and as automation changes an MCPM or 
MCE, the panel buttons might (or might not) reflect the change. Nevertheless, automation is 
an MCPM or MCE function, not a panel function.

Preview and Aux
MCEs have 2 aux buses and might have a preview bus (if a preview board is present). MCPMs do 
not have these buses. 

The CECP, CECP GUI, FECP, iMC-Panel-200, iMC-Panel-300, and iMC-Panel-GUI have an aux 
button row and a preview button row. The CECP M1 has aux buttons but does not have preview 
buttons.

The aux buttons can be assigned very different functions. See Aux Delegates on page 100.

The preview buttons simply allow experimentation with video effects and does not affect (or 
interfere with) program content. 
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Configuration Files
Configuration files for GUIs are handled differently from configuration files for hardware control 
panels. 

To take effect, a GUI’s configuration file must be placed in the same folder as the GUI’s execut-
able file and must be named cecp_gui.uicfg (for the CECP GUI, iMC-Panel-GUI, or Aux/
Preview GUI) and MasterGUI.uicfg (for the older PC GUI). 

For a hardware panel, you must write the configuration file to the panel from the panel editor. 
Use the ‘Write Config to Panel’ command from the ‘File’ menu.

You can also read GUI configuration files and hardware panel configuration files. Use the ‘File > 

Open’ command to read a GUI file. Use the ‘File > Read Config from File’ command to read a 
hardware panel’s configuration.

Choosing a Panel
There is a panel list at the left side of the panel editor window. You can select (or define or 
delete) any entry in this list. If you want to choose a panel, it must be in this list. If the list is 
empty, create a panel definition (name and IP address) by clicking the word ‘Panels’ at the top of 
the list.

You do not need to choose a panel.

After you create a configuration, you can associate it with any of the panels in the list. 

Be careful, when writing data, not to load a configuration into a panel of the wrong type. 
There are some safeguards, but they are not fool-proof.

The handling of configuration files is different for GUIs and hardware control panels.

Editing
A new configuration starts with a dialog asking what panel type you want to configure: 

General Settings
There is very little in the ‘General’ page — just the name you give the panel.
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Channel Specification
Use the ‘Channel Selection List’ page to specify what channels (MCPMs or MCEs) the control 
panel may access: 

Place a check mark in the ‘Default MCPM’ column to indicate which channel is the default 
channel (the one to which the panel attaches at startup). 

A panel must have at least one channel defined to be functional.

If you are configuring a CECP M1, the table has an extra field “Live Levels A/B” that allows 
you to select which audio metering input, A or B, for the Live Levels display. This can vary 
with the channel selected. 

A channel change can also execute an NV9000 system salvo. If you have an NV9000 connected, 
you may choose a salvo from the drop-down list that appears in the salvo field. 

You must have clicked ‘Attach to NV9000’ in the ‘NV9000 Settings’ page to be able to see 
salvo IDs. 

The ‘Ganged’ column at the right allows you to designate certain channels as followers under 
“automatic gang mode.” If you do that, the default channel then functions as the “main” channel 
of a channel gang. When panel operators carry out actions for the default (main) channel, the 
same actions apply to the follower channels. 

Automatic gang mode means that when the default channel is selected (by any method, espe-
cially panel startup), all the other channels in the gang become selected, and the default 
channel is the main channel of the gang. 

Automatic gang mode is not available for Imagestore 750s.

If the channel is to trigger a multi-viewer re-layout when it the channel is selected, specify the 
room and layout for the room in the ‘KaleidoX Room’ and ‘KaleidoX Layout’ fields for the 
channel. These options are available in drop-down lists and are determined by the Kaleido-X 
configuration. (If you are working off-line or if the Kaleido-X is not connected to your PC’s 
network, you will not see the drop-down lists.)
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Configurable Buttons
Most panels have an array of 16 configurable buttons. (The SCP has a configurable menu struc-
ture implemented on 8 buttons. Any menu item can be assigned one of many functions.) 

Most panels also have additional configurable buttons which are normally defined as transition 
control buttons and system control buttons. You can override these default functions if it suits 
the needs of your system.

The panel editor has configuration pages in which you can assign button functions. (When you 
are editing an SCP configuration, you modify the menu system.)

Aux Delegates
The CECP, CECP M1, CECP GUI, Aux/Preview GUI, FECP, iMC-Panel-200, iMC-Panel-300, and iMC-
Panel-GUI have a set of aux buttons. When the panel is controlling an MCPM or MCE, up to six of 
the aux buttons may be configured as “aux delegates.” The delegates determine the function of 
the aux bus. 

These are the 6 aux delegate types:

• Aux Bus A

The main source selected on the aux bus appears at the MCE’s aux A output.

• Aux Bus B

The main source selected on the aux bus appears at the MCE’s aux B output.

• Preset Squeeze Background

The main source selected on the aux bus becomes the preset squeeze background image.

• Preset Squeeze Image2

The main source selected on the aux bus becomes the preset squeeze image 2.

• Preview Squeeze Background

The main source selected on the aux bus becomes the preview squeeze background image.

• Preview Squeeze Image2

The main source selected on the aux bus becomes the preview squeeze image 2.

It should be noted that unless an ‘Aux Bus A’ or ‘Aux Bus B’ button is pressed, the aux 
buttons have nothing to do with the MCE’s aux bus(es). Further, the MCE configuration 
can associate or disassociate the aux bus(es) with a panel’s aux buttons. 

The aux buttons are disabled unless the panel is controlling an MCE.

The preset aux delegates are not available in the Aux/Preview GUI.
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This is a sample Aux Delegates’ configuration page: 

The iMC-Panel-200, iMC-Panel-300, and iMC-Panel-GUI have a set of aux/user buttons. When the 
panels are controlling MCEs or MCPMs, the buttons include aux delegates as described above. 
When the panels are controlling Imagestore 750s, those buttons are customer-configurable 
buttons. 

Virtual Source Buttons
The CFCP, CECP, CECP M1, CECP GUI, Aux/Preview GUI, SCP, iMC-Panel-200, and iMC-Panel-GUI 
have button rows of 16 buttons that must accommodate main source buttons and video effects 
and audio overs. Up to 16 of those buttons are main source buttons. The FECP and iMC-Panel-
300 have button rows of 24 buttons and up to 16 of those are main source buttons. 

All of those panels but the FECP and the iMC-Panel-300 have a bank select button function. 
Operators can use the bank select button to place different sets of main sources on the physical 
main source buttons. The panel editor has a configuration page that allows you to define how 
the main sources, video effects, and audio overs are organized.
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This is the configuration page (as for the iMC-Panel-200). 

In this illustration, the panel has 6 physical main source buttons configured for MCEs and 
MCPMs. The mapping of virtual main sources buttons to physical allows the operator 12 virtual 
main sources. 

Keeping the same virtual buttons in both button banks might be useful if those buttons are 
router pre-select buttons. 

In this example, two of the buttons are XG keyer layer buttons. The remaining 8 buttons are 
keyers, logos, and audio overs (in their standard ordering). 

For all panels, up to 16 buttons may be main source buttons. In that case, in panels that have 16 
buttons, all “layer” buttons (XG keyer layers, video effects, and audio overs) are sacrificed. This 
does not prevent automation (or another panel) from using video effects and audio overs in the 
same MCPM or MCE.

It is possible for the panels to have no main source buttons.

If a 16-button panel has more than 10 main source buttons, aux delegate button positions 
are sacrificed. 

Menus for the SCP
The SCP is unique because it offers a hierarchical customer-defined menu system in lieu of a 
finite set of configurable buttons. The menu buttons also provide status. Some of the config-
urable button functions are status functions. 

There are two pages in the panel editor that support an SCP’s menus: ‘Menu Layouts’ and ‘User 
Menu List’. You must create a menu in the ‘User Menu List’ page before you can assign functions 
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to it in the ‘Menu Layouts’ page. Note that the leftmost button is always the ‘Home/Panel Menu’ 
button and the other 7 buttons of the menu are configurable.

This is the ‘User Menu List’ page (empty): 

This is the ‘Menu Layouts’ page: 

It is empty — none of its buttons have functions assigned. The left-most button is always the 
‘Panel Menu’ button. Its function is fixed. The other 7 buttons are assignable.

This illustration shows the ‘Top Level’ menu. This menu always exists and you do not have to 
define it in the ‘User Menu List’ page. 

Tally Processor
The master control tally processor is third-party1 equipment. Its configuration application is 
built-in and requires no separate installation. It communicates with a designated MCPM or MCE 
using NVEP.2 It senses and controls a certain set of master control events.

1. DNF Controls of Sylmar, California (www.dnfcontrols.com)
2. Miranda’s NVISION Ethernet Protocol.
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The master control system treats the tally processor as if it were a control panel.

Prior to configuration, you must have assigned the tally processor an IP address on the master 
control network. That assignment is made through the tally processor’s front panel.

Once you have made that assignment, you can use any browser application (such as Internet 
Explorer) on your configuration PC to configure the tally processor. To access the configuration 
application, type the IP address of the tally processor in the URL field of the browser.

When you launch the internal DNF configuration tool in your browser, its initial screen is this: 

(The IP address in the illustration is 192.168.102.112.)

The main page presents 9 options (sub-pages) listed across the top in the yellow region: 

Each sub-page manages a configuration table. Configuration tables can be saved and retrieved 
for fast setups and quick changes during a broadcast or production.

Summary
The tally processor can be configured to respond to master control events such as source or 
keyer presses and can be configured to trigger events such as source or keyer presses.

Protocol assignment Define connections to MCEs and MCPMs and master control events.

GPI Configure any or all of the 32 GPIs.

GPO Configure any or all of the 32 GPOs.

GTP to USP Cfg Ignore this unless you have a USP.a 

a. Miranda does not provide any support for the USP (Universal Switch Panel) — a separate DNF prod-
uct.

USP events Ignore this unless you have a USP.

Remote events Events coming from another master control on the network.

Combinational events Logic expression based on inputs and master control events. 

Event monitoring Defines what the events to monitor are and what to do when the 
events occur and when they expire.

System Presents a login dialog and provides configuration options for the tally 
processor (to which you are connected) and its software.
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The tally processor also has 32 GPI inputs and 32 GPI outputs. These can be connected to master 
control GPIs and to other GPI devices in your facility. 

See Tally Processor Connectors on page 185 for connector details.

Read the Tally Processor User’s Guide for further information.

Device Controller
The DC21, the master control device controller, is third-party3 equipment. Its configuration 
application is built-in and requires no separate installation. It communicates with a designated 
MCE using NVEP.4 It functions as an intermediary between an MCE and devices that are subject 
to machine control and pre-roll. It receives commands from the MCE and dispatches control 
signals to connected devices in the appropriate protocol (Sony, Odetics, or VDCP). 

Prior to configuration, you must have assigned the device controller an IP address on the master 
control network. That assignment is made through the tally processor’s front panel.

Once you have made that assignment, you can use any browser application (such as Internet 
Explorer) on your configuration PC to configure the tally processor. To access the configuration 
application, type the IP address of the tally processor in the URL field of the browser.

When you launch the internal DNF configuration tool in your browser, its initial screen is this: 

(The IP address in the illustration is 192.168.102.112.)

It presents 7 options (sub-pages) listed across the top in the yellow region: 

3. DNF Controls of Sylmar, California (www.dnfcontrols.com)
4. Miranda’s NVISION Ethernet Protocol.

Protocol assignment Define connections to MCEs and MCPMs and master control events.

GPI The GPIs are not used for master control.

GPO Configure any or all of the 32 GPOs.

Event notification Ignore this unless you have a USP.a 

USP events Ignore this unless you have a USP.
105



Configuration for MCEs and MCPMs
Intuition XG
Only 4 of these used by master control. 

Each sub-page manages a configuration table. Configuration tables can be saved and retrieved 
for fast setups and quick changes during broadcast or production.

Summary
The DC21 device controller relays machine control commands to VTRs and similar devices when 
requested to do so by an MCE. Protocols supported are Sony, Odetics, and VDCP.

The device controller has 32 GPI outputs, used in pairs, and 4 serial ports that can perform 
machine control. See Device Controller Connectors on page 186 for connector details.

Read the Device Controller User’s Guide for further information.

Intuition XG
The Intuition XG system is an “advanced HD/SD graphics processor” coupled with Xmedia soft-
ware. Refer to Miranda’s Intuition XG documentation for full detail.

Intuition XG Configuration
Some of points noted in this section are “givens”— features that are created during commis-
sioning. This document assumes that any and all “commissioning” has taken place.

1 The Intuition XG graphics processor runs Windows XP. Use the built-in Windows tools to give 
the Intuition XG processor an IP address on the master control network.

2 Verify the software versions. At revision 6.3.1 and later, MCEs are compatible with: 

3 XMedia Suite version 4.3 build 249 (or later)

In earlier software revisions, MCEs are compatible with XMedia Suite version 4.2, but not ver-
sion 4.3.

4 There are 3 .ini files in C:\Program Files\VertigoXmedia\Apps\ 

XPlay.ini 
Channel_A\VCG2.ini (These channel names are arbitrary)
Channel_B\VCG2.ini

5 Use the Dashboard and MasterDiag together to adjust the timing of the Intuition XG output 
channels with respect to the MCE inputs. 

6 Verify the configuration of XG channels A and B.

Event monitoring Ignore this unless the device controller has spare GPOs that you want 
to respond either to GPI events or device control events. This table is 
not used by master control.

System Presents a login dialog and provides configuration options for the tally 
processor (to which you are connected) and its software.

a. Miranda does not provide any support for the USP (Universal Switch Panel) — a separate DNF prod-
uct.
106



Master Control
Installation Guide
Start the Dashboard. Be sure that each entry in the table has a green dot, not red. This is the 
Dashboard table with channel A selected: 

Output resolution must be 1080i30M (29.97 Hz), not 1080i30 (30 Hz) for both channels.

Genlock status to be “locked,” not “locking” or “free running” for both channels.
107



Configuration for MCEs and MCPMs
Intuition XG
7 Verify that Xplay is properly configured.

You should see 4 panes, i.e., 2 keyer layers for channels A and B. The names are arbitrary. 
Here they are CGA-0, CGA-1, CGB-0, and CGB-1: 

Choose Xplay > Tools > Settings > General. 

Ensure that the layout is ‘Multidevice’. Ensure that the number of devices is 4.

Choose Xplay > Tools > Device Manager 

Verify that your channels (here named CGA and CGB) are present.

Choose Xplay > Tools > Configure Automation. 
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For channel A (“program” in MasterConfig) the TCP port must be 5006. 

If it exists, channel B (“preset” in MasterConfig) must be 5007.

8 Ensure that all keys have proper recall IDs. 

Although Xmedia software allows recall IDs to be alphanumeric, master control requires that 
the recall IDs of XG keys be numeric and in the range 1–65535. Master control panel opera-
tors will not be able to select XG keys that have any other recall IDs. 

Legacy M2100 automation protocols are restricted to the range 1–255 (a single byte).

Recall IDs must not be blank or zero.

Recall IDs must not have leading zeroes.

Recall IDs must not contain characters other than 0–9. Hexadecimal digits, alphabetic char-
acters, punctuation, and underbars are not allowed. 

Any XG clip that has a recall ID that violates these conditions is inaccessible to master con-
trol. A control panel produces a notification beep if an operator attempts to access such a 
clip.

XPlay Settings
Choose ‘Settings’ under XPlay’s Tools menu.

1 Under the ‘General’ category, ensure that the ‘Sync with device on connect’ is checked: 

Check
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2 Under the ‘Playout’ category, ensure that the ‘Cue on Load Playlist’ is unchecked: 

Xstudio Add-On Functions
There are 18 add-on functions that allow Xstudio clips to manipulate an MCE’s squeezeback, 
audio overs, and main sources. 

The add-on functions are built into special XML files. The XML files that come as a standard part 
of Xstudio do not contain the add-on functions. You can obtain these from the Master Control 
CD (SB0221). You can also obtain these files from Miranda technical support.

The location on the CD is the folder named ‘XStudio Support’. The files are named:

Commands.xml
Commands_User.xml

and they should be placed in

C:\Program Files\VertigoXmedia\Apps

or in the folder you have chosen for Xmedia software. When you obtain the special XML files, use 
them to replace the standard files. (Rename the standard files so you don’t lose them.) 

The special XML files are for customers who want to make use of the MCE embedded 
commands. The default XML files are intended for use with Imagestore.

You must install these files on every PC for which you want to modify Xstudio.

Uncheck
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Adjusting the Timing of the Intuition XG Output
Figure 5-2 shows the Intuition XG connections: 

Fig. 5-2: Intuition XG Connections for MCEs

An Intuition XG processor has either one or two output channels. If it has two, the two can be 
used by one MCE, or each channel can be used by different MCEs. (One of the channels could be 
used by an Imagestore 750, but that is a separate issue.)

You might need to adjust the timing of the output channels with respect to the SWB card in the 
frame in which the MCE resides.

To adjust the Intuition output timing, launch the Dashboard and launch MasterDiag. Follow 
these steps: 

1 In MasterDiag, go to the ‘System Status’ page and toggle debug mode ON: 
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2 Then go to the ‘Timing Diagnostics’ page: 

3 In the indicated scroll box (which was enabled in debug mode), select the BNC number for 
the Intuition XG channel (A or B) you want to examine. 

If you forget the BNC number, the BNC number was specified (or should have been specified 
if it was not) in the ‘Intuition XG’ page of MasterConfig: 

(Use the connector number for the ‘Fill’ input. The BNC in question belongs to one of the 
cables connecting the Intuition XG to the SWB input backplane of the MCE’s frame.)
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4 Now examine the timing graphic: 

If the center portion of the graphic is green and the white line is reasonably centered, no 
adjustments are needed. If the white line is not centered 

or if the center portion of the graphic is yellow, then adjustment is needed. 

5 If adjustment is needed, switch to the Dashboard. Choose ‘Advanced’ in the ‘Settings Mode’ 
drop-down menu. The choose channel A or B whichever matches the BNC you have chosen 
in MasterDiag: 
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6 Adjust the sliders (‘Horizontal Delay’ or ‘Vertical Delay’. What setting to choose is different for 
every system. You might have to experiment with different settings to get the best setting. 

After you adjust the sliders, click ‘Apply Changes’. The software will ask if you really want to 
make the change: 

Click ‘Yes’. 

7 In a few moments, the timing display in MasterDiag will change. View the changes. Repeat 
step 6 until the timing display turns green and the white line is reasonably centered. 

8 Repeat the entire procedure for the other Intuition XG output channel (if it has another out-
put channel). 

9 Do not forget to return to the ‘System Status’ page of MasterDiag and toggle debug mode 
OFF. The MCE will not operate until you do.

NV5100MC Configuration for Intuition XG
Configuration of the master control system for Intuition XG occurs in two parts: one is in Master-
Config and the other is in the MCS Panel Configuration Editor. 

Please refer to those manuals for more detail.

MasterConfig
1 Enable pre-roll in the general settings. Intuition XG requires it to function properly. 

2 In the ‘Intuition XG’ page, check the ‘Program’ box and, if your XG box has 2 channels, also 
check either the ‘Preset’ box or the ‘Preview box’. 

3 Assign IP addresses to ‘program’ and ‘preset’ or ‘preview’. If they use a single XG processor, 
use the same IP address. If you have not checked the ‘Program’ box, the check boxes for pre-
set or preview are dim (disabled). You must check the preview or preset check boxes for their 
options to appear.

4 Assign “Oxtel” ports. Use 5006 for program and 5007 for preset. These are predetermined by 
the Intuition XG processor. 

5 Choose a keyer for the ‘program’ channel and choose a (different) keyer for the preset (or 
preview) channel. 

If you have a two-channel XG processor, the program keyer must be keyer 3 and the preset 
keyer must be keyer 2. (Note that these are both post-squeeze in the effects ordering.)

If you have a single-channel XG processor, you may use any of the 3 keyers. (Keyer 1 is pre-
squeeze.)

Master control supports up to 4 XG layers. Each layer can be assigned an XG media clip 
identifiable by a “recall ID.” The clips mix with the MCE’s program video through the 
keyers assigned to the XG channels. In an MCE configured for Intuition XG, those keyers 
are not available as independent keyers. 
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6 Specify the SWB input ports for each channel. (These belong to an SWB input backplane. The 
SWB input card and backplane are required for Intuition XG.)

7 Specify the XMS port as 14050 (predetermined by the Intuition XG processor) for the proces-
sor(s) you have identified by their IP addresses. Specify the keyer behavior (disabled, normal 
or clear after preset). It is not likely that you would want ‘disabled’ but it is one of the choices.

8 Specify the pre-roll value as 6 (frames). This is actually not a pre-roll, but a latency. The 
latency might vary and might have to be determined through experimentation.

The value 6 is suitably for interlaced formats. Use 12 for progressive video formats.

9 Specify the audio parameters.

The Intuition XG video signals can include embedded audio (up to 16 channels). The MCE 
processes this audio as an audio over. These are the audio options:

The number of audio channels (from 8 to 16).

The default over-to-main ratio of the XG layers. This is simply labeled ‘Ratio’. Panel operators 
can adjust the over level and the over-to-main ratio.

Whether to turn on the audio over when a panel operator presses an ‘XG layer’ button. This 
is a checkbox option. With this option enabled, the XG over follows the state of the keyer 
assigned to the XG channel: when the keyer is on, the over is on; when the keyer is off, the 
over is off.

10 Specify the maximum number of layers.

The lower this value, the better your system performance will be. 

11 Specify the keyer behavior.

The choices are ‘Normal’ and ‘Clear Preset after Program Transitions to On’. See the 
NV5100MC MasterConfig User’s Guide for details.

MCS Panel Configuration Editor
(Intuition XG configuration is available only for the SCP, CECP, CECP M1, CECP GUI, Aux/Preview 
GUI, FECP, iMC-Panel-200, iMC-Panel-300, and iMC-Panel-GUI.)

In the ‘Button Assignments’ page, place from one to four XG layer buttons on the program bus. 
The same buttons can appear on either the preset bus or the preview bus depending on config-
uration of MCEs under control.) 

The program bus corresponds to one channel of the Intuition XG processor. The preset (or 
preview) bus corresponds to the other channel of the Intuition XG processor (if it has the 
second channel).

You might have to sacrifice a main source button or two to do so. 

When XG layer buttons are active, the keyers assigned to the XG layers become inaccessible 
for normal use. 

Optionally configure one of the customer-definable buttons as an “XG Keyer Control” button. 
(The button causes the keyers that support XG layers to turn on or off at any time. The button 
should be considered an emergency button, to be used rarely, if ever. Note that the button does 
not affect the Intuition XG processor, only its assigned keyers.)
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Notes 
The Intuition XG’s video reference must be tri-level 1080i/59.94, connected to ‘Analog Ref In’. The 
reference for the MCE and Intuition XG references must be closely timed (within ± 1/2 line). 
Otherwise, you’ll get non-sync errors. 

The Intuition XG processor receives information regarding what to play and when to play it from 
the MCE over its Ethernet connection.

Misc. Topics 

Restarting an MCPM or MCE
MCPM and MCEs restart, or reset, after you (1) press the reset switch at the front of the module, 
(2) reinsert the module in the frame, or (3) cycle power to the module.

At reset, the MCPM enters bypass mode (the emergency bypass relay routes bypass signals to 
the program output and inhibits MCPM output), the red bypass LED comes on, the red alarm 
LED comes on, and the MCPM initializes. After a few seconds, the heart beat LED comes on. Soon 
the red alarm light goes out, and the green LED (health) comes on and the amber light comes 
on (active). If the MCPM is functioning properly, the bypass light will have gone out. 

Put simply: if the green LED turns on, the MCPM has restarted successfully. (Otherwise, it will 
remain in bypass mode).

If it has reset properly, the MCPM configuration will have been copied from flash to RAM, 
possibly overwriting operator changes. 

For MCPMs, any logos previously in RAM will have been lost, and must be reloaded from the 
configuration PC. (You can use MasterLogo for that purpose.)

For MCEs, logos are not lost because they remain in flash memory.

MCPM Health 
At the front of the MCPM, there is a green LED labeled “HEALTH” and a red LED labeled “ALARM.” 
When an MCPM is operating normally (it is “healthy”), the green LED is on and the red LED is off. 
When an MCPM cannot operate normally (it is “unhealthy”), the green LED will be off and the 
red LED will be on. Any of the following conditions can cause the MCPM to be “unhealthy”:

1 A problem with video reference (e.g., reference not present or video not locked).

2 The FPGAs are not loaded properly.

3 The application is missing or not loaded properly (e.g., an application for the MCPM-SD is 
loaded in the MCPM-MK-SD).

4 A problem with MCPM configuration (e.g., it is missing, corrupt, or of the wrong type for this 
type of MCPM).

5 A problem with AES clocks (received on the backplane from the control card or clock card).
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Restarting a Control Panel
A control panel restarts when you reconnect power or after you press the Panel Status > Update 
Config menu button (6 seconds) or Panel Status > Restart Panel menu button (70+ seconds). 

As the control panel restarts, the user-definable buttons display a cycling pattern and the LCD is 
kept off until the panel’s main processor has booted. When the pattern stops cycling and the 
LCD lights up, the panel has reset. The LCD touchscreen will display a warning or error message 
(e.g., Panel Not Connected) if something is wrong.

The cyclic pattern displays the message “Master Control Panel Starting” on the upper row of 
user-definable buttons and turns the lower row of buttons red, one by one. 

Put simply: when the red buttons go out and the LCD lights up, the control panel has restarted 
successfully. You should check the messages on the LCD.

There are .nvz files (software/firmware files for FECP, CECP, SCP, iMC-Panel-200, and iMC-
Panel-300 control panels) in the ‘setup’ subfolder of the master control installation folder. 
You can use the MCS Panel Configuration Editor to upload these files to the appropriate 
panel if it becomes necessary, such as when you receive new software.

Control Panel Health
The control panel can have two kinds of problems:

• Major alarm:

A failure of any circuit board.
Failure of both power supplies.
A detected failure of an attached transition lever arm.

• Minor alarm:

Failure of one power supply.
Fan failure or over temperature.

The control panel has alarm outputs (relays) which can be used to signal problems. 

See Control Panel Connectors on page 198 for connector information.
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Chapter 6 describes the installation and preliminary configuration of Imagestore 750s. 
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The procedures given in this chapter will connect the Imagestore 750 and establish communica-
tion with the NV9000, with iMC panels, and with a Kaleido-X multi-viewer. Subsequent 
Imagestore 750 configuration is not addressed here. Nor is Kaleido-X configuration. For more 
information, refer to the Imagestore 750 Configurator Reference Manual and any of the Kaleido-X 
documents. 

Introduction

Before You Begin
Most of the installation and configuration of the Imagestore 750 in the iMC master control 
system is relatively simple if you complete a few specific (and simple) tasks.

The exception is configuring audio. You have a choice:

• Construct an “audio graph.” The audio graph (in the Imagestore 750 Configurator) is a graph-
ical representation of interconnections of various audio components of the Imagestore 750. 

• Choose a pre-configured audio template — one that most fits the needs of your system. If 
you choose a template, it will become available in the audio graph tool, and you can then 
modify it as you wish. 

You should decide whether to use an audio template or to start from scratch using the audio 
graph tool. In either case, you must familiarize yourself with the audio graph tool if you are to 
complete the audio configuration successfully. See Audio Configuration on page 150 for a brief 
description of the audio graph tool and a suggested configuration. Please refer to the Imag-
estore 750 Reference Manual for a full discussion of the audio graph tool.

After you have installed the Imagestore 750, there are additional configuration tasks, which can 
be demanding and subtle. This guide does not address anything beyond the few installation 
steps.
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Essentials
First, make sure that you have the version 4.5 of the Imagestore 750. 

Second, make sure that you have the correct version of the Imagestore 750 Configurator. Pres-
ently, it is v1.8: 

In the context of the iMC master control system, an NV9000 router control system is required 
and a video router1 that supports embedded audio is required. To configure the NV9000 system, 
you need a recent version of NV9000-SE Utilities. At this writing, the released version is 6.2.2.

To configure control panels to control Imagestore 750s, you will need the MCS Panel Configura-
tion Editor, version 7.2.9.0 or later.

An Ethernet switch is required for a master control network.

LGK-3901, DSK-3901, and ISM-3901
The iMC master control system can control the LGK-3901, DSK-3901, and ISM-3901. These are 
transition processors that fit in a 3RU Densité frame. These units provide a subset of the func-
tions of an Imagestore 750. The master control system treats these units as if they were 
Imagestore 750s. They are configurable using the Imagestore 750 Configurator and each has a 
browser application (for remote management) that is similar to the browser application for the 
Imagestore 750.

The ISM-3901 is “bundled” version of the LGK-3901.

For detailed information, refer to the LGK-3901/DSK-3901 Installation and Operator’s Guide. 

Overview
Installing the Imagestore 750 involves making cable connections and describing those connec-
tions in NV9000-SE Utilities, in the Imagestore 750 Configurator, and in various control panel 
configurations. (You can also use the Imagestore 750’s browser application for some tasks.)

(Note: all of the Imagestore 750’s video connectors are 75W BNCs.) 

The installation process for a single Imagestore 750 is different from the process for multiple 
Imagestore 750s. The difference lies in how you allow multiple Imagestore 750s to share 
resources such as a monitor wall. With only a single Imagestore 750, sharing is not at issue.

1. The NV8256 and the NV8500 family routers are suitable.
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Single Imagestore 750
The connections for a system that includes a single Imagestore 750 are simple: 

The NV9000 system controls a video router and the router provides the signals that are 
controlled by the Imagestore 750. The Imagestore 750 receives commands from master control 
panels and relays those commands to the NV9000 whereupon the NV9000 switches sources to 
the destinations of interest.

Two of the router destinations connect directly to the A and B inputs of the Imagestore 750. The 
Imagestore 750 instructs the NV9000 to switch router sources to these destinations. 

A third router destination feeds an aux (auxiliary) device such as a waveform monitor.

Other router destinations related to the Imagestore 750 feed router sources to a Kaleido-X 
multi-viewer supporting a monitor wall. Master control can control up to 24 sources of a 
monitor wall. When a panel operator changes sources, the Imagestore 750 sends messages to 
the NV9000 that switch these sources to the monitor destinations. 

The various devices communicate over the master control network. The NV9000 communicates 
with the router or routers over one of its own panel and router networks. 

Connections to the AES, GPIO, metadata and LTC inputs and outputs of the Imagestore 750 are 
optional and subject to the requirements of your facility. Connections to the fill and key inputs 
of the Imagestore 750 are also optional. 

If the Imagestore 750 has an Intuition XG coprocessor, the feed from the Intuition XG uses one of 
the fill/key pairs. (The Imagestore 750 can control input from one Intuition XG processor.)
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Multiple Imagestore 750s
The connections (and configuration steps) are slightly more complex when you have more than 
one Imagestore 750 in your system. Shown here is a single-Imagestore 750 system for compar-
ison with Figure 6-1: 

The system for multiple Imagestore 750s feeds the outputs of the various Imagestore 750s back 
into the router and switches the output of the currently selected Imagestore 750s to a single set 
of destinations that feed a Kaleido-X monitor wall: 

Fig. 6-1: Multiple Imagestore 750s

The basic connections for each Imagestore 750 are the same as for a single Imagestore 750. 
However, now it is possible to direct the sources and outputs of the multiple Imagestore 750s to 
the same monitor wall. When a panel operator changes channels, the newly acquired Imag-
estore 750 sends commands to the NV9000 to take the appropriate sources to the router 
destinations supporting the monitor wall. 

(The aux output associated with an Imagestore 750 is actually a router destination and is not 
part of the Imagestore 750. If an aux destination is defined for the monitor wall — in the panel 

&

%

���&�
���%�

���	
�

���
��*
�<
��

����

1:������

������������

���
���

3	.�!���
��
"���

 �
���&�

�3�������!

������

4�

���& ,

&

%

���&�
���%�

���	
�

�����
��*��
�<��
����

����

�
&
%

&
%

1:

�#�
���
��

��

&�:

�����
��*��
�<��
����

������

������������

���
���

3	.�!���
��
"���

���������

�

���&@
���%@

���&��
���%�

 �
���&�

�3�������!

����������������	���
��
����&����������
���	���
������%����

 	�
����&�����!

���
���
���	���
�������&�

��������
�����
���	���
���


 	�
����&������!

5&�����
��������������������
��
���������	���
�����
067���8�%�9�������

����@
��*�@
�<�@
���@

�����
��*��
�<��
����

������

4�

����@
��*�@
�<�@
���@

�����
��*��
�<��
����

����

�
����

�

���������

�

���������

�

122



Master Control
Installation Guide
configuration — that destination is used instead of the aux destination defined for an individual 
Imagestore 750. That is, the aux destination defined in the panel configuration overrides any 
aux destination defined for an Imagestore 750. If there is no aux destination defined in the panel 
configuration, no override takes place.

The monitor wall layout can also change with a channel change. The panel operator can also 
trigger a layout change with a function button.

All related router sources and destinations must first be defined in NV9000-SE Utilities. Then you 
must select router sources (and some destinations) in the Imagestore 750 Configurator. You 
must select certain router destinations (e.g., for the monitor wall) in the MCS Panel Configura-
tion Editor. 

Installation Summary
The following is a summary of the installation process. The details of installation process follow, 
starting at Network Connections on page page 125.

Preliminary (NV9000-SE Utilities, PCs, Imagestore 750 Front Panel)
1 Define, and make, connections to the master control Ethernet switch for the NV9000, for 

each Imagestore 750, for each Intuition XG, for iMC panels, and for each configuration PC 
and GUI PC. 

In NV9000-SE Utilities
2 If you have only a single Imagestore 750 . . . 

Define two router destinations for the Imagestore 750’s A and B inputs. Optionally, define a 
third router destination that feeds an auxiliary device. Make the physical connections. 

3 Otherwise, you have multiple Imagestore 750s . . . 

For each Imagestore 750, define two router destinations for the Imagestore 750’s A and B 
inputs. Optionally, define a third router destination that feeds an auxiliary device. Make the 
physical connections. 

The aux outputs assigned to the Imagestore 750s can be overridden by the aux destina-
tion specified in a control panel configuration. This is recommended for multiple 
Imagestore 750s. 

For each Imagestore 750, define router sources for the Imagestore 750’s outputs (PGM, PST, 
CLN, and MON) that are to feed the monitor wall. Physically connect those outputs to their 
respective router inputs. (Do not make such a connection for the aux output associated with 
the Imagestore 750.) 

4 Define monitor wall connections.

Define a router destination for each router source to be monitored and define up to 5 desti-
nations for Imagestore 750 output. Later on, connect those destinations physically to the 
Kaleido-X inputs. 
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In the Imagestore 750 Configurator
5 For each Imagestore 750, define its NV9000 connections.

Specify the IP address of the NV9000 system controller. Use the NV9000’s virtual IP address if 
it has one. 

It is important to complete this step before proceeding. The configurator cannot 
perform certain functions without knowing the NV9000’s IP address. 

Also specify the ‘router type’ as NV9000. Leave the ‘router port’ field at its default.

6 For each Imagestore 750, identify its router destinations (A, B, and aux).

The aux outputs can be overridden by the aux destination specified in a control panel 
configuration. This is recommended for multiple Imagestore 750s. 

7 For each Imagestore 750, define its router sources.

Under ‘Master Control’, choose ‘File > New’ and specify the IP address of the Imagestore 750. 
A list of NV9000 sources appears. Select some or all that apply to this Imagestore 750. 

8 For each Imagestore 750, create salvo configuration files. (Although this is optional, you will 
probably want salvos and therefore will have to identify them in the Imagestore 750 Config-
urator.)

Under ‘Salvo Mode’, choose ‘File > New’ and specify the IP address of the Imagestore 750. A 
list of NV9000 salvos appears. Select some or all that apply to this Imagestore 750. 

9 For each Imagestore 750, designate the names of the ‘Master Control Config File’ and 
(optionally) of the ‘Salvo Config File’ you created. 

10 For each Imagestore 750, identify the router sources that feed the Imagestore 750’s PGM, 
PST, CLN, and MON outputs into the router. These fields are required only you have more 
than one Imagestore 750. 

11 For each Imagestore 750, define channel ownership. These are the ‘Allow Kick’ and ‘Allow 
Share’ options. See step 19 also. 

12 For each Imagestore 750, describe the NV9000 configuration.

We recommend that you leave these fields at their default values. 

Optionally, specify which NV9000 name set to use. Optionally, specify a post tally delay. The 
default value of 4 is acceptable for installation.

13 For each Imagestore 750, define Imagestore 750 preferences. You can also do this later. 

14 For each Imagestore 750, define “preview” options — those that govern the use of the preset 
buttons on panels. See also step 22. 

15 For each Imagestore 750, define Intuition XG options (if it has a connected Intuition XG). 

Run a serial cable from a COM port of the Imagestore 750 (RS-232, 19200 Baud, 8N1) to the 
RS-232 port of the Intuition XG processor. This allows the Imagestore 750 to control the Intu-
ition XG processor.

16 For each Imagestore 750, define source groups.

Do this before you define ‘Group Select’ buttons in panel configurations.

(Choose ‘Master Control’ in the top right drop-down menu. Then choose ‘File > Open’. Spec-
ify the IP address of the Imagestore 750 and choose a master control configuration file. 
Select the ‘Source Groups’ tab.)

Source groups are implicitly numbered, starting at 0. 
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17 For each Imagestore 750, define an audio configuration.

Audio configuration is complex. You have a choice of selecting an audio template or starting 
from scratch using the ‘Audio Graph’ tool of the Imagestore 750 Configurator. Please refer to 
the Imagestore 750 Reference Manual for audio graph details.

In the MCE Panel Configuration Editor
18 For each panel, in the ‘Monitor Wall’ page, identify the router destinations (defined in step 4) 

that feed the monitor wall.

Panels configurations that use the same monitor wall use the same router destinations. 

19 For each control panel, in the ‘Advanced’ page, enable or disable sharing and choose a kick 
option.

20 For each control panel, define group selection buttons. 

(This is discretionary. You might not actually want group selection buttons.)

21 For each control panel, define salvo buttons and specify salvos that execute when a channel 
change occurs. 

22 For each control panel, specify the ‘preset tally’ option. Go to the ‘Advanced’ page.

Some operators like the “PresStation” method of arming DVEs, DSKs, and voice-overs on the 
preset bus. Other operators like the traditional method. The ‘preset tally’ option lets you 
choose.

Miscellaneous connections
The use of all other Imagestore 750 signals is optional. Their ports are documented in the Master 
Control Reference Manual and Imagestore 750 Reference Manual. Other than pin-out and elec-
trical characteristics, their use is outside the scope of this document. 

The GPIO connector is an HD44. A breakout device is available. 

The AES connector is a SCSI VHDCI-68 female. Breakout boxes are available, one for 75 Ω BNCs 
and one for 110Ω 3-pin STP connectors. The cable must have male connectors with 0.8 mm pin 
spacing. 

Please refer to the Imagestore 750 Reference Manual for details.

Network Connections

[Step 1] Follow these steps to make network connections: 

1 Using the NV9000’s master control network port, connect the NV9000 to the master control 
Ethernet switch. Assign an IP address to the NV9000’s master control network port. (See 
NV9000 System Controller on page 19 for the port’s physical location.)

The default IP address is 192.168.7.201 for the primary NV9000’s master control network and 
192.168.7.202 for the secondary’s. 

If you prefer not to change the NV9000’s master control address, make all other IP addresses 
on the master control network part of the 192.168.7.xxx subnet. 

2 Connect the Imagestore 750 to master control’s Ethernet switch. You can use either of the 
two LAN ports on the Imagestore 750.
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3 Assign an IP address to the Imagestore 750. 

Use the front panel of the Imagestore 750. See the Imagestore 750 Reference Manual for 
instructions. Its IP address must belong to the master control subnet. 

4 Repeat steps 2 and 3 for any additional Imagestore 750s. 

5 If your system has Intuition XG processors, connect those and assign them IP addresses on 
the master control network. (Imagestore 750s typically receive clips from Intuition XGs.)

6 Connect a configuration PC to the master control Ethernet switch and give it an appropriate 
IP address on the master control subnet. Also connect a configuration PC to the NV9000 at 
its house network port (again with an appropriate IP address). You can use the same PC for 
both networks.

At this point, if you have the configuration software installed, it is possible to configure the 
Imagestore 750(s), the NV9000, and any control panels you have installed. 

Similarly, connect any GUI PCs to the master control Ethernet switch.

In NV9000-SE Utilities

[Step 2] Router Connections for a Single Imagestore 750
The Imagestore 750 accepts HD or SD video, with or without embedded audio, at its A and B 
input ports. It is a router controlled by the NV9000 system that provides these inputs. 

Follow these steps: 

1 In NV9000-SE Utilities, define two router destinations2 for the Imagestore 750. 

Use the ‘Devices’ page in the ‘Configuration’ navigation pane to configure destinations. 

Each of these destinations can involve multiple virtual levels, but the Imagestore 750 con-
nects on exactly one level, which is the level corresponding to a video output of an HD or SD 
router. 

2 Optionally, define a third router destination that supports an auxiliary device. 

Master control panels that control Imagestore 750s have an “aux” button row with which the 
panel operator selects router sources. The Imagestore 750 will issue commands to the 
NV9000 that direct the selected source to a designated auxiliary device (e.g., a waveform 
monitor).

2. You will need some understanding of NV9000-SE Utilities concepts, such as destinations, sources, devic-
es, virtual levels, level sets, or categories, to proceed. 
There are many other considerations in NV9000-SE Utilities beyond the scope of master control setup. 
These cannot be avoided. It is likely that someone else in your organization is responsible for overall 
NV9000 and router configuration. You should collaborate with that person.
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This is a sample from NV9000-SE Utilities after A, B, and aux destinations have been defined for a 
single Imagestore 750: 

To make the physical connections: 

1 Connect the video router port belonging to the “A” destination to the A input port of the 
Imagestore 750. 

2 Connect the video router port belonging to the “B” destination to the B input port of the 
Imagestore 750. 

3 Optionally, connect the router port supporting the aux device to the input port of the auxil-
iary device. 

[Step 3] Router Connections for Multiple Imagestore 750s
The Imagestore 750 accepts HD or SD video, with or without embedded audio, at its A and B 
input ports. In typical systems, the outputs of the Imagestore 750s are fed back into the router to 
be directed to a monitor wall. That way the multiple Imagestore 750s can share the monitor 
wall. 

It might help to refer to Figure 6-1.

Repeat these steps, in NV9000-SE Utilities, for each Imagestore 750:

1 Define two router destinations for the Imagestore 750’s A and B inputs. 

Use the ‘Devices’ page in the ‘Configuration’ navigation pane to configure destinations. 

Each of these destinations can involve multiple virtual levels, but the Imagestore 750 con-
nects on exactly one level, which is the level corresponding to an output of a video router. 

In figures 6-2 and 6-3, following, these are outputs ‘IS1 A’, ‘IS1 B’, IS2 A’ and ‘IS2 B’.

2 Optionally, define a third router destination that supports the “aux bus.” 

Master control panels that control Imagestore 750s have an “aux” button row with which the 
panel operator selects router sources. The Imagestore 750 will issue commands to the 
NV9000 that direct the selected source to a designated “aux” destination.

These aux outputs are overridden by the aux destination defined (in a panel configuration) 
for the monitor wall. If you define an aux destination in the panel configuration, it becomes 
the designated aux destination instead of the Imagestore 750’s aux destination.

This view is the ‘PhysConns’
table, available under the 
‘Views’ navigation pane. 

The names of the destinatio
devices are helpful, but not
important.

It is the ports (in this illustra
tion, 6, 7, and 8) of the 
applicable router that are 
important. You need to kno
the port numbers when 
making physical connection
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In the sample shown in figures 6-2 and 6-3, this option was not taken because there is a 
common aux output for the Kaleido-X multi-viewer.

3 Define a router source for each of the Imagestore 750’s outputs that is to be taken to the 
monitor wall. The Imagestore 750’s outputs are its PGM, PST, CLN, and MON outputs. 

In the sample shown in figures 6-2 and 6-3, these outputs are 4 of the 5 outputs (i.e., destina-
tions) whose names begin with “KX.”

To make the connections, for each Imagestore 750: 

1 Connect its PGM output to the designated router input. 

2 Connect its PST output to the designated router input.

3 Connect its CLN output to the designated router input.

4 Connect its MON output to the designated router input.

Do not make a feedback connection for the aux output associated with the Imagestore 
750. 

Figure 6-2 is a the ‘PhysConns’ table in NV9000-SE Utilities that describes connections for two 
Imagestore 750: 

Fig. 6-2: Two Imagestore 750s Set Up for Use with a Monitor Wall
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Figure 6-3 shows the result of making connections for the two Imagestore 750s. 

Fig. 6-3: Two Imagestore 750s Ready for a Monitor Wall Connection

[Step 4] Monitor Wall Connections
There are 3 monitor wall functions to consider: 

• A monitor wall can display the currently selected Imagestore 750’s sources and outputs. 

• A monitor wall can display the currently selected Imagestore 750’s aux output. 

• If the monitor wall is driven by a Kaleido-X multi-viewer, a panel operator can cause a moni-
tor wall re-layout to occur. 

To make monitor wall settings, first define monitor wall destinations for sources, then define 
monitor wall destinations for Imagestore 750 outputs and the aux output associated with the 
Imagestore 750. 

Later, in step 19, identify those destinations in the MCS Panel Configuration Editor. 

(You will later identify the router sources (defined in step 3, for each Imagestore 750) that feed 
the monitor wall destinations for PGM, PST, CLN, and MON in the Imagestore 750 Configurator. 
See step 10.)

Important: this step associates source buttons (of one or more panels) with the monitor wall 
destinations. Because an Imagestore 750 can have a number of source groups, a source button 
may correspond to more than one source. 

There is potentially a monitor wall display for each source button. The sources controlled by that 
button always appear on that particular display. (If one panel has 8 source buttons, and another 
has 10, and a third has 12, then you would probably want to define 12 monitor wall destinations 
for the sources that are controlled by the panel buttons.) 

At the upper limit, the Imagestore 750 can control up to 29 monitor wall displays out of the total 
number used in your system. The number 29 stems from the fact that the largest number of 
sources that can be controlled on a master control panel is 24. With 4 Imagestore 750 outputs 
and the aux output, the number comes to 29. (The monitor wall can have additional displays 
beyond the ones controlled by master control panels.)
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Follow these steps, in NV9000-SE Utilities: 

1 Define router destinations for each of the monitored source (buttons).

2 Define router destinations for up to 5 destinations for Imagestore 750 output. 

Later on, connect those destinations physically to the Kaleido-X inputs. 

This a sample from NV9000-SE Utilities after the monitor destinations have been defined: 

Here again, this view is the 
‘PhysConns’ table, available
under the ‘Views’ naviga-
tion pane. 

The names of the destina-
tion devices are not 
important.

It is the ports of the appli-
cable router that are 
important. (In this illustra-
tion, 9–19 and 28–32 are 
visible.) You need to know 
the port numbers when 
making physical 
connections.
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Figure 6-4 shows the addition of the monitor wall connections: 

Fig. 6-4: Connections for Two Imagestore 750s and Monitor Wall
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In this diagram, KX AUX is used to 
feed both the auxiliary device and 
the monitor wall. This signal is 
used instead of an aux output for 
each Imagestore 750.

The most recently selected Imag-
estore 750 causes the router to 
take the appropriate inputs to the 
monitor wall.
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Imagestore 750 Configuration
Perform basic configuration steps for each Imagestore 750. (More advanced configuration and 
configuration adjustments can be performed after installation.)

Notes

Creating a Configuration
To create a configuration for an Imagestore 750: 

1 Launch the Imagestore 750 Configurator. 

2 Choose ‘File > New > From Device . . .’:

3 Then specify the IP address of the Imagestore 750. (You defined its IP address in either step 2 
or step 3): 

4 You will be asked for the video format of the Imagestore 750: 
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5 Save the configuration. At this point, all the settings in the configuration are either at their 
default values or undefined: 

Note that the configuration is saved in the Imagestore 750 itself.

Each of the steps described in this section assume that you have opened the configuration file 
for the Imagestore 750 on which you are currently working. 

Activating a Configuration
When you are configuring an Imagestore 750, you typically want to choose the active configura-
tion when you select the Imagestore 750 for configuration. The active configuration is the one 
that is running in the Imagestore 750. 

To make a particular configuration the active configuration, you can choose ‘Save and Apply’ 
from the File menu 

or you can use the Imagestore 750’s front panel. 
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It is easier to use the Imagestore 750’s browser application than the front panel: 

1 Launch your browser. Enter the IP address of the Imagestore 750 as the URL. 

2 Login. (The default password is “miranda.”)

3 Choose ‘Front Panel Mirror’ from the list of options. A graphical front panel view appears: 

4 Scroll right (click the right arrow) to find ‘User Presets’: 

Click ‘ENT’.

5 The ‘Import’ command appears. Click ‘ENT’: 

6 Scroll to find the configuration that you want to become active: 

Click ‘ENT’.

7 To confirm that you want that configuration, scroll once to choose ‘Yes’ and click ‘ENT’: 

8 After a few seconds, the “Software Reset’ command appears. To confirm that you want to 
restart the Imagestore 750, scroll once to choose ‘Yes’ and click ‘ENT’: 

9 After approximately 20 seconds, the Imagestore 750 will have restarted with the selected 
configuration as the active configuration and the browser application will report ‘Done’. 

10 Close the browser application unless you have more to do. 
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[Step 5] NV9000 Connection
Choose ‘Configuration Mode’ in the top right drop-down menu. Then, choose the ‘System 
Settings’ tab and open the ‘Master Control’ branch of the navigation tree at the left: 

Specify the ‘router type’ as NV9000.

Enter the IP address of your NV9000 system controller in the ‘router address’ field. 

Leave the ‘router port’ field at its default.

It is important to complete this step, for each Imagestore 750, before proceeding. The 
configurator cannot perform certain functions without knowing the NV9000’s IP address. 

If your NV9000 is a redundant system (one that has both an active and a stand-by system 
controller), each system controller has its own IP address. NV9000-SE Utilities allows you to 
define a single “virtual” IP address for the redundant pair. You should define the virtual IP 
address in NV9000-SE Utilities and use the virtual IP address here. 

[Step 6] Router Destinations
Select the router destinations for Imagestore 750’s A and B inputs and optionally for the auxil-
iary device. 
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To do this, again choose the ‘System Settings’ tab under ‘Configuration Mode’ and open ‘Master 
Control > Router Destinations’ in the navigation tree at the left. 

Choose a router destination for each of the three entries. Note that ‘PGM bus destination’ corre-
sponds to the A input and ‘PST bus destination’ corresponds to the B input. When you click the 
field to make an entry, a list of NV9000 destinations appears: 

Choose one of them and click ‘OK’. (The entries appear in this list because you defined them, in 
step 2 or step 3, in the NV9000 system’s configuration.)
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[Step 7] Router Sources
This step identifies router sources. These are the sources that can be included in source groups 
and that can be selected by panel operators. 

1 Create a master control configuration file for the Imagestore 750 you are configuring. 

To do that, choose ‘Master Control’ in the top right drop-down menu: 

Then choose ‘File > New’. Specify the IP address of the Imagestore 750: 

After doing so, a list of NV9000 sources appears: 

2 Select some or all that apply to this Imagestore 750. You can revise the list at any later time. 
(You will eventually need all the sources that you intend to assign to source groups.)

3 Save the configuration using the ‘File > Save’ or ‘File > Save As’ command.
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[Step 8] Router Salvos
This optional step identifies router salvos. Salvos are NV9000 “programs”— files containing 
NV9000 commands in sequence. 

(Salvos execute upon a channel change or when an operator presses a salvo button or through 
automation. The salvos that can execute are the ones defined in this step.) 

1 Create a salvo configuration file for the Imagestore 750 you are configuring. 

To do that, choose ‘Salvo Mode’ in the top right drop-down menu: 

Then choose ‘File > New’. Specify the IP address of the Imagestore 750: 

After doing so, a list of NV9000 salvos appears: 

2 Select some or all that apply to this Imagestore 750. You can revise the list at any later time.

3 Save the configuration using the ‘File > Save’ or ‘File > Save As’ command.

The salvos you identify are implicitly numbered, starting at 0. These salvo numbers are the 
salvo IDs to be used in the MCS Panel Configuration Editor. See step 21.

[Step 9] File Names
Designate the name of the ‘Master Control Config File’ and (optionally) the name of the ‘Salvo 
Config File’ you are using for this Imagestore 750. 

You will need to know which salvos 
are needed for your Imagestore 750.

Although writing salvos (in NV9000-SE 
Utilities) is straightforward, this docu-
ment does not address it. 

Either you or some other persons in 
your organization will have written 
the salvos that appear in this list.
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To do this, again choose the ‘System Settings’ tab under ‘Configuration Mode’ and open the 
‘Master Control’ branch of the navigation tree at the left: 

Because you defined the master control configuration file (step 7), its name will appear in the 
drop-down menu when you click next to ‘master control config file’. Choose that file. (Do not 
choose the default or system values.)

Similarly, the name of the salvo configuration file (step 8), will appear in the drop-down menu 
when you click next to ‘salvo config file’. Choose that file. (Because the salvo configuration file is 
optional, the drop-down menu might not have any entries unless you created a salvo configura-
tion file in step 8.)

[Step 10] Router Sources for the Monitor Wall
Select the router sources that feed this Imagestore 750’s PGM, PST, CLN, and MON outputs into 
the router. 

These fields are required only you have more than one Imagestore 750 sharing a connection 
to a Kaleido-X multi-viewer (or some other device).
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To do this, again choose the ‘System Settings’ tab under ‘Configuration Mode’ and open ‘Master 
Control > Router Sources’ in the navigation tree at the left. 

Click the field next to ‘Src being fed by PGM output’. When you click the field to make an entry, a 
list of NV9000 sources appears: 

Select one of them and then click ‘OK’. Do the same for the PST, CLN, and MON outputs. The 
other fields in this page are optional. You can configure them now or later, at your discretion.
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[Step 11] Channel Ownership
Choose the ‘System Settings’ tab under ‘Configuration Mode’ and open ‘Master Control > 
Channel Ownership’ in the navigation tree at the left. Select ‘Channel Ownership’. 

Here you can define the Imagestore 750’s channel name and specify how the Imagestore 750 is 
to be used by multiple users. 

‘Allow Kick’
A “kick” is when a panel operator who wants to control an Imagestore 750 preempts an operator 
who already has control of the Imagestore 750. The conditions that govern kicking are listed in 
the drop-down menu for the ‘Allow Kick’ option: 

• Never

The Imagestore 750 cannot be acquired by another operator if it is already attached to a con-
trol panel. 

• By higher priority panels only

The Imagestore 750 can be acquired by another panel if that panel has been configured with 
a higher “priority” than the panel that currently “owns” the Imagestore 750.

• By same or higher priority panels

The Imagestore 750 can be acquired by another panel if that panel has been configured with 
a priority the same or higher than the priority of the panel that currently “owns” the Imag-
estore 750. 

• Always

The Imagestore 750 can always be acquired by another operator. 

• Use panel setting

Whether an Imagestore 750 can be acquired by another panel is determined by the panel 
settings of the two panels involved. 

The panel settings are made in the ‘Advanced’ page of the MCS Panel Configuration Editor. 
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‘Allow Share’
“Sharing” means that more than one panel operator can control an Imagestore 750. The condi-
tions are listed in the drop-down menu for the ‘Allow Share’ option:

• True — the Imagestore 750 is sharable. 

• False — the Imagestore 750 is not sharable. 

• Use panel setting — whether an Imagestore 750 can be shared is determined by the panel 
settings of the two (or more) panels involved. 

The panel settings are made in the ‘Advanced’ page of the MCS Panel Configuration Editor. 

[Step 12] Router Configuration
Here, you provide details about the NV9000 configuration (not a router configuration).

Choose the ‘System Settings’ tab under ‘Configuration Mode’ and open ‘Master Control > Router 
Configuration’ in the navigation tree at the left: 

We recommend that you leave these fields at their default values. 

(Note: the ‘NP00173 mnemonic’ option controls which NV9000 name set is used by the Imag-
estore 750 Configurator. The names in that name set appear on control panel buttons. When the 
mnemonic option is the default, the Imagestore 750 uses the NV9000’s system names.)

The default value of 4 is acceptable for installation. You might wish to set this value higher, later 
on, if you see flashes at the end of transitions. Higher values are for slower routers. Use a value 
for the longest switch time where there is some variance in your routers’ switch delays.

3. The term “NP0017” is the part number of the document describing an NVISION protocol. The term has 
no actual significance here. 
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[Step 13] Preferences
This step is optional during installation. You can perform this step at any time after installation. 

Choose the ‘System Settings’ tab under ‘Configuration Mode’ and open ‘Master Control > Prefer-
ences’ in the navigation tree: 

These are the options: 

• Cut all from air on hot PGM switch

This option can be enabled or disabled. 

When it is enabled, performing a hot cut on the program bus causes all effects (DVEs, XG 
keyer layers, DSKs, and voice-overs) to be removed (cut down) from the program bus. 

When this option is disabled, a hot cut does not change the effects present on the program 
bus.

• ‘Re-arm mix on PST bus source change.’

This option can be enabled or disabled. 

When it is enabled, selecting a source on the preset bus that is different from the source 
selected on the program bus causes the most recently selected transition type to become 
selected. (It does not matter why that transition type was selected — the option uses the 
most recently selected transition type.) Further, if the operator selects a source on the preset 
bus that is the same as the source on the program bus, all transition types becomes de-
selected. 

When this option is disabled, selecting a source on the preset bus has no effect on whatever 
transition type is selected or not selected.

• ‘Aux Bus Follow’

This option — although not strictly a transition option — has 3 choices: ‘none’, ‘PGM’, or ‘PST: 

When the option is ‘PGM’, the aux bus “follows” the program bus. That means that whatever 
source an operator selects on the program bus is also selected on the aux bus. 

When the option is ‘PST’, the aux bus “follows” the preset bus. 
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When the option is ‘none’, the aux bus does not “follow” either bus and operates normally. 

Note that when the option is ‘PGM’ or ‘PST’, the operator can still use the aux buttons, nor-
mally, to switch sources to your aux output. 

[Step 14] “Preview” Options
This step is optional during installation. You can perform this step at any time after installation. 

The Imagestore 750 has several options that govern the use of the preset button row on master 
control panels before, during, and after transitions. (The preset bus is called “preview” in the 
parlance of the Imagestore 750 Configurator.)

To configure these options, go to the ‘System Settings’ pane under ‘Configuration Mode’ and 
open ‘Video > Preview’: 

These are the options: 

• ‘Preview Select’

Normally, this option presents the preset bus at the preset output. (Within the configuration 
software, this output is called either preview or preset.)

It is possible, although not likely, for the Imagestore 750 to be configured to present pro-
gram output, the program A/B mixer output, the program DVE output, or the outputs of 
DSKs 1, 2, or 3 as the preset output. 

• ‘Active Preview AB Mixer’ 

This option can be enabled or disabled. 

When it is enabled, the preset (a.k.a. preview) background video depends on both the 
progress of the program A/B mixer and its arm state. 

If the operator has not armed the A/B mixer (i.e., has not selected a transition type), the pre-
set background video is the same as the program video background. 
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When the operator selects a transition type, the preset background video is what was cho-
sen as the preset source, which will be the background video on program after the next tran-
sition (or “Take”).

When the option is disabled, the preset background video is independent of the A/B mixer 
and its arm state. The preset background video is always the chosen preset source.

• ‘Preview AB Mixer Angle’ 

This option can be either ‘A channel’ or ‘B channel’. 

Leave this at the default which is ‘B channel’.

• ‘Active Preview DVE’

When this option is activated, if you hot-cut a DVE on the program bus, it will also become 
active on the preset bus. And, if you hot-cut a DVE off the program bus, it will also be 
removed from the preset bus. 

• ‘Active Preview Keyers’

Some operators like the “PresStation” method of arming DVEs, DSKs, and voice-overs on the 
preset bus. Other operators like the traditional method (which is used for MCEs and MCPMs). 

When this option — coupled with ‘Enable Traditional PST Tally’ of the MCS Panel Configura-
tion Editor — is chosen, the panel will operate using the traditional method. Otherwise, the 
panel will use the PresStation method.

This setting must match the setting in the MCS Panel Configuration Editor. See step 22.

• ‘DSK n Preview Keyer Position’

This basically turns the Imagestore 750’s individual DSKs on or off.

If your panel has DSK buttons, and they are disabled in the Imagestore 750’s configuration, 
the buttons will be disabled on your panel. They might be enabled for another Imagestore 
750. 
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[Step 15] Intuition XG Options
If your Imagestore 750 receives input from an Intuition XG, it is essential that you configure its 
connection. To do so, go to the ‘System Settings’ pane under ‘Configuration Mode’ and open 
‘Devices > Slave’: 

At a minimum, specify 

1 Specify ‘Intuition XG’ in the ‘slave type’ field.

2 Enter the IP address (on the master control network) of the Intuition XG processor in the 
‘slave ip address’ field.

This IP address is used for command forwarding (if you prefer Ethernet control to serial con-
trol).

3 In the ‘slave fill/key input’ field, choose one of the 3 fill-and-key pairs for the input from the 
Intuition XG processor. (You will cable these ports to the outputs of the Intuition XG proces-
sor later. The Intuition XG processor might have two sets of outputs. The Imagestore 750 
Configurator supports only one, but you can use either one.)’

4 In the ‘slave keyer mnemonic’ field, enter a mnemonic for the Intuition XG.

Other options
XG layers are peculiar. First, XG layers are processed by one of the Imagestore 750’s DSKs. 
Second, operators cannot view an XG layer merely by selecting it on PST. Doing so only arms the 
XG layer for transition. 

However, operators can view XG layers by selecting an XG layer on PGM and then selecting the 
DSK that carries it, either on PGM or on PST. If you select the DSK on PGM, the XG layer appears 
on air. If you select the DSK on PST, it does not.

1

2

3

4
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There are several Intuition XG (i.e., “slave”) options that relate to this phenomenon: 

• Slave keyer assign.

This option designates one of the DSKs as the default carrier for XG layer content. When the 
operator selects an XG layer (on PST or PGM) the default DSK is also selected. The operator 
can always override this default.

To make this configuration, choose one of the DSKs (or none) in the drop-down list. ‘None’ 
means there is no default. 

• Slave keyer follow up.

This option can be enabled or disabled.

When it is enabled, the default DSK turns on automatically when the operator has selected 
one or more XG layers. 

When this option is disabled, the default DSK is not affected by XG layer selections.

Note: If the operator is be able to preview an XG layer on PST without it appearing on air, 
set this parameter to disabled. Because the XG layer can be viewed only when it is on 
PGM, when this option is enabled, the DSK becomes selected on PGM (and viewable on 
air).

• Slave keyer follow down.

This option can be enabled or disabled.

When it is enabled, the default DSK turns off automatically when no XG layers are selected. 

When this option is disabled, the default DSK is not affected by XG layer selections.

• Slave number of keyers.

The number of XG layers that are supported and return thumbnails. By default, Intuition XG 
provides 8 layers.

Keyer Settings
Go to the ‘System Settings’ pane under ‘Configuration Mode’ and open ‘Video > External Fill/
Key’. Choose Fill-1/Key-1, Fill-2/Key-2, and Fill-3/Key-3 in succession and specify the ‘input name’ 
and the ‘input thumbnail name’ for each. 

For the external keyers that are not from the Intuition XG, leave these fields at their default. In 
this illustration, Fill-1/Key-1 is set to its default: 
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The default name for input pair 1 is “> F1+K1 <” and the default for the thumbnail (file) name is 
F1+K1.jpg. (Note that these defaults are built into the Imagestore 750.)

For the external keyer that belongs to the Intuition XG, select instead the name “> INT-XG <” and 
the thumbnail INT-XG.jpg: 

These names are also built into the Imagestore 750.

Serial Cable
An Imagestore 750 controls an Intuition XG processor over a serial connection.

Connect one of the Imagestore 750’s COM ports to the RS-232 port of the Intuition XG processor. 
You need either a special cable or an RS-45 cable with a special adapter that comes with the 
Imagestore 750. The part number of the adapter is 1897-1800-100.

The pinout of the Imagestore 750’s COM port (RJ-45) and the pinout of the Intuition XG’s RS-232 
port are both non-standard. The Intuition XG’s RS-232 port is male. This is the wiring of the cable 
you need: 

The following serial port settings are normally recommended between the Imagestore 750 and 
Intuition XG:

Baud rate 19200

Serial protocol Oxtel slave

Serial standard RS232

In the Imagestore 750 Configurator, configure the rate and settings for the port you chose under 
‘Configuration Mode’. Choose Devices > Serial Communications > COM n. 

For the Intuition XG, configure the rate and settings for this port using Xplay. (Choose Tools > 
Configure Automation > CQB > Oxtel over Serial.) The rate should match that of the Imagestore 
750’s COM port. 

[Step 16] Source Groups 
You must define at least one source group. Typically, panel operators may select from several 
source groups. Sources may be assigned to more than one source group. 

A defined source group identifies the sources that are to appear on a control panel’s source 
buttons at any one time, and on which buttons they are to appear. 

You should define source groups in the Imagestore 750 Configurator before you define 
‘Group Select’ buttons in panel configurations.
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1 Choose ‘Master Control’ in the top right drop-down menu: 

2 Then choose ‘File > Open’. Specify the IP address of the Imagestore 750 and choose a master 
control configuration file: 

This file is one that you created in step 9. 

Select the ‘Source Groups’ tab: 

To create a new source group, right-click the ‘Source Groups’ region and select ‘New’ from 
the context menu that appears. A dialog appears: 
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Specify the name of the group and the number of sources in the group. The configurator 
now shows the sources of the group in the lower part of the display where you can add, 
remove, or change sources: 

Gaps in the source list are allowed.

Keep in mind that the source groups are implicitly numbered, starting at 0. The group num-
bers are used in the assignment of ‘Group Select’ buttons in the MCS panel configuration 
editor.

The sources in the group are mapped to source buttons on panels in the order in which they 
appear in the group. That is, source 1 appears on the left-most source button, source 2 
appears on button 2, and so on. If there is a gap in the source group, the gap maps to a 
source button (and the button is dark or disabled).

[Step 17] Audio Configuration
Audio configuration is more complex than other configuration tasks, but, even so, it is straight-
forward and logical. You can cope with its complexity if you keep the iMC Master Control model 
in mind, This drawing represents the iMC model: 

Without correct audio configuration, the Imagestore 750, one or more features of your master 
control system might not work properly. 

There are two methods by which you can configure the audio in an Imagestore 750: 

• Construct an audio graph (using the tool in the Imagestore 750 Configurator). 

• Use an audio template. 
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Here is a comparison of the methods: 

If you decide to start with an audio template, we recommend you choose

abmix16_ep8_vo_pvw_aes16_vo_pvw.xml

which seems to be the closest to the iMC master control model. Variations on this audio config-
uration are permissible to a degree. The criterion is whether the variation will work in your 
system. See Selecting an Audio Template on page 154.

Browsing Audio Templates
Although template selections are made in the Imagestore 750 Configurator, you may examine 
the specifications for each of the templates in the Imagestore 750’s browser application.

1 Launch your browser (e.g., Internet Explorer).

2 Enter the IP address of the Imagestore 750 in the address field. The initial page of the 
browser application appears: 

Audio Graph Audio Templates

Starting from an empty configuration is daunting 
unless you already have some experience with 
audio in Imagestore 750s.

It is very easy to choose an audio template. (Choose 
the one that is most appropriate for your system.)

The audio graph is very flexible. You can do what 
you want.

The template might not be exactly what you want. 
(You can modify your choice using the audio graph 
tool.)

Unless you do it right, the Imagestore 750 will not 
work properly, especially in the context of the iMC 
master control system.

Each template works as defined (as long as your 
Imagestore 750 has the needed components).
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3 Click ‘Login’ and then enter your password. The default password is ‘miranda’: 

4 The ‘Welcome’ page appears: 

Click ‘Audio Templates’ at the left. 
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5 The audio templates page appears: 

The templates are just listed at the top and described in detail further on. At present, there 
are 19 templates. Click on a template entry to jump to its details. When you are viewing the 
details, you can download the template if you want. It is not a necessary part of audio con-
figuration to download the template. (The templates are .XML files.)
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Selecting an Audio Template
1 Launch the Imagestore 750 Configurator. Either create a new configuration or open an exist-

ing configuration using the IP address of the Imagestore 750 you are configuring. 

2 From the ‘File’ menu, click ‘Import Audio Graph’: 

Choose ‘From Device Template...’ in the sub-menu.

3 The template list appears: 

Choose one of the templates and click ‘OK’. We recommend the one shown selected above, 
because it is nearest to the requirements of the iMC master control system.

4 At this point, the Imagestore 750 should pass audio (after you save the configuration and 
restart the Imagestore 750 with the new configuration). It probably will not do everything 
expected of an Imagestore 750 in an iMC master control system. You can modify the audio 
graph at a later time.
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Details of the Recommended Audio Template 
5 If you have imported the recommended template, click the ‘Audio Graph’ tab. The audio 

graph corresponding to that template appears: 

The audio graph page has 3 sections. On the left is a list of components available (in a cate-
gory) and a drop-down list of categories. On the right is a region in which you can change 
the parameters for a selected block or signal group.

In the middle is a portion of the audio graph. You can view other portions of the audio graph 
by scrolling left and right or up and down. (It is not possible to see the entire audio graph.)

In the illustration above, one of the blocks is selected and highlighted with a red outline. Its 
parameters are listed in the right-hand section of the page. 
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Here we reproduce the full audio graph of the template 
abmix16_ep8_vo_pvw_aes16_vo_pvw: 

If you are viewing this page, in PDF, on your computer, you can zoom in to see better detail. 
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Figure 6-5 shows a more orderly view of that audio graph: 

Fig. 6-5: A Schematic View of the Template’s Audio Graph

Note certain details: 

• The iMC system refers to the processing paths of the Imagestore 750 as program and preset. 
The Imagestore 750 terminology calls these the program and preview. Thus, within the Imag-
estore 750, the terms preset and preview mean the same thing.

• The EasyPlay devices in the template emit 8 channels of audio. If you use this template, you 
might want to add an additional 8 channels for a total of 16. 

• The multiplexers in front of the preview, meter, clean-feed, and monitor outputs are not 
essential. If you always want to monitor the same signal, you can delete the multiplexer for 
the monitor output and connect the signal(s) to the monitor output block directly. Similarly, 
if you always want the output of the preset path to be present in the preview output, you 
can delete the multiplexer and connect the PST VO2 output(s) directly to the preview output 
block.

• This graph does not include audio delays at output. Audio delays are probably required in 
your system to compensate for timing differences. You can add them if you need them. 

• The master control system’s mute and invert functions are handled in the gain blocks. It is 
probably immaterial whether gain should precede shuffle or vice versa.
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• The graph has no output shuffle block. Although you could add one, the master control sys-
tem does not support output shuffle and the block would be useless. 

• The VO1 blocks accept input from (internal) EasyPlay blocks. The VO2 blocks accept input 
from (external) AES inputs. You could reverse this. You could also have additional EasyPlay 
blocks that feed VO2 instead of an AES block. 

Or you could have AES inputs feed both VO1 and VO2. However, there are only 16 AES 
inputs. You would have to assign some of the AES inputs to VO1 and others to VO2. 

Here is a example of the preceding template having been modified: 

Fig. 6-6: Diagram of Audio Template Modified after Selection

In this modification, the various multiplexers are removed and the corresponding outputs have 
been connected directly to a point within the processing path. A second set of EasyPlay units 
drive VO2 instead of the AES inputs. The EasyPlay units now use all 16 audio channels.

EasyPlay clips are managed and loaded into the Imagestore 750 using the Audio Builder 
application, part of the MCS software that ships with the Imagestore 750.

Effective Use of the Audio Graph Tool
Knowing a few techniques will help you to build or modify audio graphs efficiently. 

What you do in the audio graph is to select audio blocks (i.e., components) from the left side of 
the audio graph page and place them, by dragging-and-dropping, onto the middle portion (the 
graphic portion) of the audio graph window. Then, when you have placed enough blocks to 
proceed, you draw lines connecting signals from one block to another. When you are done, you 
will have an audio processing path from input to output, for both program and preset, and 
possibly for other paths. The topology of the graph will probably resemble that shown in 
Figure 6-6 (or Figure 6-5), but of course there are very many options not represented in those 
figures. 

You can rename the blocks and rename signals within the blocks.
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The following list identifies the audio blocks from which you may choose. The blocks corre-
spond to actual components in the Imagestore 750. The blocks available to you depend on what 
Imagestore 750 options you have purchased. 

The number of blocks available are given in parentheses:

• Audio delay banks (6)

• Audio inputs

AES input (1), EasyPlay (4)

SDI audio feeds 1–4 (1 each)

Silence (1), test tone (1)

• Audio outputs

AES output (1)

Meters (1)

SDI PGM output (1), SDI PVW output (1), SDI CLF output (1), SDI MON output (1)

• Audio mix blocks

A/B mixer (1)

Audio description module (1)

Fade to silence cut (1), fade to silence data (1), Fade to silence mix (1)

Gain (1)

Program input gain (1), program input shuffle (1), program input multiplexer (1)

Preset input gain (1), preset input shuffle (1), preset input multiplexer (1)

Automatic duck (1), Automatic mute (1)

Audio mix (1)

Program output gain (1), program output shuffle (1), program output multiplexer (1)

Meter output multiplexer (1), monitor output multiplexer (1)

Preview output multiplexer (1), clean-feed output multiplexer (1)

PGM voice-over (8), PST voice-over (8), voice-over preview (8)

• Audio modules

Dolby decoder, AC-3 and E (1)

Dolby AC-3 encoder (1)

Dolby E encoder (1)

Upmix (1)

• Metadata modules

Metadata A/B mixer (1)

Metadata blank source (1)

Metadata processor (4)

Metadata UARTs (1) — 4 UARTs, RS-485, in this block

There are also some legacy block types which will not be discussed. Please call Miranda tech-
nical support if you need assistance with these.
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Placing a Block
Click to select a block type in the left pane and drag the block onto the graphic area. The block 
will appear in its fully expanded form. You can collapse the block later if you prefer. However, to 
connect the signals from that block, it needs to be expanded so that you can see the individual 
signals. Here is an example: 

Interconnect
Drag your cursor from an output of one block to an input of another block. A straight line then 
appears between the output and the input. You can make multiple connections as easily as you 
can make single connections. Follow these steps to make multiple connections: 

1 Drag your cursor around the outputs you want to connect to some inputs. They become 
highlighted in red: 

Fully expanded

Semi-collapsed

Fully collapsed
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2 Point to one of the outputs and drag your cursor so that the lines (that now appear) connect 
to the appropriate inputs: 

3 Release the cursor to make the connection. The interconnected ports become bright yellow: 

Repeat these basic steps to interconnect all the blocks in your audio graph. 
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Imagestore 750 Configuration
Block Options
Right-click a block to get a context menu for the block: 

You can

• Delete the block entirely. (Connections to it are deleted as well.)

• Remove some or all of the block’s connections.

• Modify the block’s size, which is to change the number of channels in the block.

You can also right-click an individual port. A context menu appears: 

From this menu, you can

• Remove an individual connection to this signal. 

• Remove all of the block’s connections.

• Modify the block’s size, which is to change the number of channels in the block.

If you have right-clicked an output port, you might have a choice of which connection to 
remove, depending on the fanout of the signal. 
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Fanout
It is possible (and useful, even necessary) to connect the outputs of one block to the inputs of 
more than one block. For example, you might want the SDI inputs to go the next stage in the 
processing path (e.g., gain) and also to the clean-feed multiplexer. 

Just select the outputs and drag your cursor from the outputs to the additional inputs. 
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Imagestore 750 Configuration
Managing the Graph
As your graph becomes more fully populated with blocks and interconnect, you might want to 
collapse many of the blocks and adjust the position of the blocks more optimally: 

You can select any block by clicking it. To select multiple blocks, drag your cursor across a region 
that completely contains all the blocks you want to select. (The graphic view does not pan auto-
matically.) To select all blocks, choose ‘Select all’ from the ‘Edit’ menu (or press Ctrl-A). 

You can drag select blocks to any position in the visible portion of the audio graph. The inter-
connect moves with the blocks as you move them. 

Tips
Press the space bar to center the audio graph in the audio graph pane. 

There is no zoom or pan. But you can adjust the view with the scroll bars. 

You cannot make multiple selections by clicking. You must marquee drag around the signals or 
blocks you want to select. You cannot add entries to, or remove entries from, a selection.

You cannot connect a signal already connected. Delete the existing connection(s) first. 

You cannot select signals that have been collapsed. 

You cannot use copy and paste to create blocks in the graph.

‘Select all’ from the edit menu selects all blocks. Ctrl-A is its shortcut. 
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In the MCS Panel Configuration Editor
Perform these steps for each panel you are installing. 

Tip: do not forget to choose the ‘Imagestore 750’ button in the ‘General’ configuration page. 

[Step 18] Router Destinations
Here you identify the monitor wall destinations for a panel configuration:

1 Open a panel configuration. Go to the ‘Monitor Wall’ configuration page.

2 Select router destinations for each monitor source. These are the destinations you defined in 
step 4. If the panel you are configuring uses N sources, complete the first N entries. 

3 Select router destinations for any of the 5 types of Imagestore 750 output you want to send 
to the monitor wall. These are also destinations you defined in step 4. 

Panels configurations that use the same monitor wall use the same router destinations. 

This is an example of applying the destinations defined in NV9000-SE Utilities to the ‘Moni-
tor Wall’ table in the MCS Panel Configuration Editor: 

Monitor destinations as defined in NV9000-SE Utilities

Destination IDs applied in the 
MCS Panel Configuration Edi-
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In the MCS Panel Configuration Editor
[Step 19] Channel Acquisition
Imagestore 750s have sharing and “kick” options (step 11) and panels have sharing and kick 
options. A panel’s sharing and kick options are somewhat inter-related with those of the Imag-
estore 750s it can control. 

These options define how panels can share Imagestore 750s, how panels that do not share may 
preempt other panels, and how panels may be permitted or denied access to Imagestore 750s. 

To configure sharing and kick options, go to the ‘Advanced’ page and use the ‘Channel Acquisi-
tion Settings’ section: 

Check ‘Allow Sharing’ if the panel is to share control of any of its Imagestore 750s with other 
panels. 

Designate the priority level of this panel for when other panels attempt to gain access to the 
Imagestore 750 controlled by this panel. Then choose a value for ‘Allow Kicking’. This value spec-
ifies how this panel reacts when another panel (that does not share) attempts to acquire its 
Imagestore 750. The choices are: 

• ‘Never’ — this panel never allows another panel to preempt it. 

• ‘By higher priority panels only’.

• ‘By same or higher priority panels’.

• ‘Always’ — this panel always allows another panel to preempt it. 

[Step 20] Group Select Buttons
‘Group Select’ buttons are discretionary. How many such buttons you place on a panel depends 
on many factors. Typically, you will have one button for each source group.

To configure a group selection button, choose one of the various configurable button sections 
of the panel you are configuring. Then choose a button and make it ‘Group Select’ button: 

(‘Group Select’ buttons are available from the ‘Utility’ branch of the button function tree.) 

Assign a group number to the button. The source groups in the Imagestore 750 configurator are 
numbered implicitly, starting at 0. If you have many source groups, you’ll have to determine their 
numbers by inspection.

[Step 21] Salvos
Salvos execute upon an a channel change or when an operator presses a salvo button or 
through automation. The salvos that can execute are the ones you defined in step 8.) 
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Channels
A channel selection can cause an NV9000 salvo to execute. 

To configure a salvo for a channel, go to the ‘Channel Selection List’ page. Enter a salvo ID (from 
among the salvos listed in the Imagestore 750 configuration) in the ‘Salvo ID’ field for the 
channel: 

Leave the field blank for channels that do not trigger salvos. 

Salvo Buttons
‘Salvo’ buttons are discretionary. 

To configure a salvo button, choose one of the various configurable button sections of the panel 
you are configuring. Then choose a button and make it ‘Salvo’ button: 

Enter a salvo ID (from among the salvos listed in the Imagestore 750 configuration).

[Step 22] Preset Tally Option
Panel configurations have an option that applies to panels when they are controlling Imag-
estore 750s. This option governs the way a panel’s preset button row tallies before, during, and 
after transitions. Some operators like the “PresStation” method of arming DVEs, DSKs, and voice-
overs on the preset bus. Other operators like the traditional method (which is used for MCEs and 
MCPMs). 

The option —‘Enable Traditional PST Tally’— is specified in the ‘Advanced’ configuration page of 
the MCS Panel Configuration Editor. If you enable the option, the panel will operate using the 
traditional method. Otherwise, the panel will use the “PresStation” method.

If you do enable the option, it is imperative that the ‘Active Preview Keyers’ parameter of the 
Imagestore 750 configuration be set to true. See step 14. 
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Intuition XG Settings
Intuition XG Settings
It is important to observe some particular settings in Xplay for the Intuition XGs connected to 
your Imagestore 750. 

Choose ‘Settings’ under XPlay’s Tools menu.

1 Under the ‘General’ category, ensure that the ‘Sync with device on connect’ is checked: 

2 Under the ‘Playout’ category, ensure that the ‘Cue on Load Playlist’ is unchecked: 

This is very important. XG clips will not function properly under master control unless this 
option is unchecked.

Check

Uncheck
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Other Matters

Virtual IP Address
If you have a redundant NV9000 system, it is advisable to create a virtual IP address (one the 
represents either the primary or secondary, whichever is active). Do this in the ‘System Manage-
ment’ page of NV9000-SE Utilities: 

Miscellaneous Connections
The use of all other Imagestore 750 signals is optional. Their ports are documented in the Imag-
estore 750 and Imagestore 750 Configurator manuals.

The GPIO connector is an HD44. A breakout device is available. 

The AES connector is a SCSI VHDCI-68 female. Breakout boxes are available. The cable must have 
male connectors with 0.8 mm pin spacing. 

There are four RJ-45 COM ports that support RS-232 or RS-422 for automation or serial control.

See Imagestore 750 Connectors on page 199 for details. 

Key Signal Connections
In the context of the NV5100MC master control system, the Imagestore 750 supports up to 3 
external key pairs (fill and key video inputs). You can connect these external key ports to any 
devices that are useful to your master control system. 

Typically one of the pairs connects to the output of an Intuition XG processor.
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Maintenance
Chapter 7 provides information about maintenance and trouble-shooting. 

Topics
NV5100MC Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171
NV5100MC Trouble-Shooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  173
NV5100MC Module Replacement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174

NV5100MC Maintenance 
The master control system requires very little in the way of routine or preventative maintenance. 
Other than cleaning the fan air intake filter, all that is required is periodic inspection of the 
system to make sure no failures have occurred.

Periodic Inspection
Periodically inspecting the master control system for signs of trouble is the best way to prevent 
unplanned outages. The following items will be helpful when performing this inspection. Begin 
the inspection at the front of the frame. Open the door to the master control frame and make 
these observations.

1 Check the +48VDC LEDs on the front of the PS6100 (or older PS6000) power supplies. An 
LED that is off or very dim indicates a failed or failing supply.

2 Place your hand lightly across the air intakes on the front of the power supplies. You should 
feel slight air movement, indicating that the internal cooling fans are running. These fans run 
at very low speed, so you will notice only slight air movement. You can use a flashlight to ver-
ify that the fan blades are rotating at the proper speed.

3 Look at each input/output module and verify that none of the red alarm LEDs are illumi-
nated. Normally, the green and/or amber LEDs are illuminated. Refer to Table  on page 173 
to interpret the LED status indicators.

4 Look at the control card(s) and verify that the green and amber LEDs are illuminated on the 
active control card, and that the green LED is on for the standby controller (if present). Verify 
that the low battery LED is off on one or both control cards. Table  describes the various LEDs 
and their meaning.

5 Inspect the air intake filter located inside the door. If the filter is dirty or clogged, refer to 
Intake Filter Screen Cleaning for information on how to clean it. 

6 Verify that there are no missing backplane cover plates. Cover plates are required to ensure 
proper cooling in the frame.

7 Place your hand near the air exhausts. You should feel strong air pressure evenly across the 
entire opening.
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8 Check all cable connectors for any sign of unseating.

9 Verify that one or both AC cords are firmly seated at both ends. Make sure that the spring 
bail power cord retainers on the rear of the frame are in place. 

Intake Filter Screen Cleaning
The intake filter is located on the front door assembly of the master control frame. To access the 
filter, simply open the door by releasing the two thumbscrew locks. Slide the filter up and to the 
right to remove it. This process might be easier if you remove the entire door. To remove it, 
simply open the door and lift it straight up. The system can be operated safely with the door 
removed for short periods of time.

Be sure to replace the door when you are done. This ensures that air entering the frame is 
properly filtered.

If the filter is only lightly contaminated with debris, clean it with a vacuum cleaner or dry 
compressed air. Remove loose debris and dirt with a vacuum cleaner or by blowing air from the 
clean side to the dirty side. For filters that are badly clogged, a rinse with cold water may prove 
effective. You can also wash the filter with warm water and mild detergent. In any case, make 
sure the filter is completely dry before reinstalling it.

Battery Replacement
A CR2330 lithium coin cell is located on the front edge of an EM0374 router control card and at 
the front edge of an MCPM-SD or -HD. These batteries provides power to maintain the RAM 
contents when power is lost. 

Other MCPMs have no battery. EM0414 clock cards do not have a battery.

Under continual power, the battery should last several years or more. If the module is frequently 
powered down, you should replace the battery every 6 months. A red LED, located directly 
above the battery holder in the control card illuminates if the battery is low. The MCPM-SD and -
HD have no obvious battery LED.

The batteries can be replaced while the NV5100MC is powered up and operating. Simply pull 
the battery from its holder to remove the spent cell. Insert the replacement in the holder while 
carefully observing the polarity of the battery. 

Reinstall the battery with positive (+) terminal facing left as you insert the battery (or facing up if 
you have taken the module out of the frame). 

Fig. 7-1: Battery Replacement (Two Control Cards)

Warning: Inserting the battery backwards may result in an explosion.

Red Battery LEDs

Coin Cells

Control Cards MCPM-SD, -HD

Coin Cell
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Fuse Replacement
All input and output modules, except for the SD output module, all HD modules and the  control 
cards, include 1A non-serviceable, self-resetting thermal fuses. These fuses open in the event of 
a serious overload, preventing major damage. They will self-reset if allowed to cool. 

A replaceable AC fuse cartridge is used on the PS6100 power supply modules. The correct fuse is 
15A (1.25″ × 0.25″ fast-blow). 

The correct fuse for the older PS6000 power supply is given in this table: 

If a fuse fails, locate the cause of the trouble rather than simply replacing the fuse blindly. While 
fuses that have been in service for years may fail due to cumulative stress, a fuse normally fails 
for a reason. Contact  technical support for assistance if a fault problem cannot be isolated. 
Replacing the fuse without determining what caused it to open could cause equipment 
damage or fire by restoring power to a damaged unit. 

NV5100MC Trouble-Shooting 

LED Status Indicators 
Every module has LEDs at its front that indicate the status of the module. The LEDs provide valu-
able visual clues about the cause of a failure. Table  outlines the function of the most important 
LEDs: 

90–130VAC 8.0A, 5×20 mm, slow-blow fuse

180–250VAC 6.3A, 5×20 mm, slow-blow fuse

NV5100MC Module Status LEDs

Module Type LED Function Description

Control Card Red (above bat-
tery holder)

Battery 
status

If red LED is ON, replace battery.

Green Healthy Normal operation, successful boot, module power sup-
plies OK. Ready to go active.

Amber Active Module is active or in use.

Red Alarm Fault State:
• Bad or missing video or AES reference.
• Bad on-module power supply.
• Microprocessor failure. Try rebooting.

MCPM Red (bypass) Bypass Indicates that the MCPM is in bypass mode

Green Healthy Normal operation, successful boot, module power sup-
plies OK

Amber Active Module is active or in use

Red Alarm Fault State:
• Bad or missing video or AES reference.
• Bad on-module power supply.
• Microprocessor failure. Try rebooting.
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Other LED indicators may be present on some modules. For example, the control card and the 
MCPMs also have a “heartbeat” LED that blinks at an approximate 1 Hz. Some cards have LEDs 
that indicate the presence of data on the many communication ports. These indicators are 
located on the module PCB and are intended for more advanced troubleshooting. 

Miranda customer support representatives might ask for the status of these indicators and will 
provide instruction on locating them on the specific module if necessary. 

NV5100MC Module Replacement

I/O Modules
The power supplies and all front-loaded I//O modules may be removed or installed with the 
power applied or “hot swapped.” MCPMs and MCEs may be hot-swapped.

Prior to installing a replacement module, verify that any possible switch settings are configured 
correctly. Modules that receive and process serial data from the controller will automatically 
configure themselves at power up. 

Ensure that a replacement MCPM or MCE has a correct IP address. Control panels will be unable 
to control the MCPM or MCE if it is not correctly identified. Also ensure that replacement MCPMs 
and MCEs have been given the correct configuration (including logos).

If any module appears to malfunction, first try re-seating it in the frame.

Backplane Modules
All but the HD input and output backplanes and the SD input backplanes are completely 
passive and may be removed at any time. Use the same cautions as with front-loaded modules. 
Be sure to match rear modules to the corresponding front modules. Those using BNC connec-
tors are especially easy to install in the wrong location because, under casual observation, they 
look very similar. No damage will normally result from an unintentional mismatch.

HD Input, HD Output, and SD Input Modules
Unlike other backplanes, HD input and output backplanes and SD input backplanes contain 
active circuitry. Power to these modules is supplied by their associated front-mounted module. 
To remove one of these rear interface modules, first remove the front module. It is sufficient just 
to disconnect the module from the motherboard. Pull that module out a short distance if you 
wish to leave it in the frame slot.

I/O Red (upper) Alarm Indicates a fault condition. For example, an on-module 
power supply could be faulty.

Green (upper) Power All power supplies are OK.

Amber FPGA 
loaded

Indicates that FPGA code is properly loaded. This LED 
must be ON for normal operation.

Green (lower) Comm. 
good

Communication with the controller is healthy,

Red (lower) Comm. fail-
ure

Communication with the controller has failed.

NV5100MC Module Status LEDs

Module Type LED Function Description
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Control Card Jumpers

EM0374 Jumpers
The EM0374 router control card has several jumper sets: 

Figure A-1. EM0374 Router Control Card Jumpers

Table  describes the jumpers. Jumpers not listed should be left in the factory position: 
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EM0374 Jumpers

Jumper Settings

J1, J2 Leave these jumpers in the 10B2 position. The control card (and therefore the frame) does 
not support SBus yet.

J4, J6 SMS7000 option. Place the jumpers in the SMS7 position to use a SMS7000 control system 
and the Node Bus connectors. Otherwise, leave the jumpers in the SBus position. (SBus is 
not supported.) 
Note: Using an SMS7000 requires an SMS7000 mezzanine card to be installed.

J13, J16 AES reference termination options. See Figure A-1 above for the jumper settings.
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EM0414 Jumpers
The EM0414 clock generator card also has several jumper sets: 

Fig. A-2: EM0414 Clock Generator Card Jumpers

Table  describes the jumpers. Jumpers not listed should be left in the factory position: 

Analog Audio Switches and Jumpers
The analog audio input card (EM0585) has several jumper options. So does analog audio output 
card (EM0586. Options include:

• Setting the gain of individual channels. 

If you are using single-ended inputs, you can double the input level by choosing a +6dB 
switch setting for those input channels.

• Activating mute detection.

• Setting operating levels to match facility production levels.
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EM0414 Jumpers

Jumper Settings

J13, J16 AES reference termination options. See Figure A-2 above for the jumper settings. (The set-
tings are the same for the EM0374 and EM0414.)

J22 Leave this jumper in the RUN_PLL position.
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Analog Audio Switches and Jumpers
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Individual Channel Gain 
The analog audio input card has four 8-position DIP switches near the center of the board that 
allow the gain of each channel to be increased by 6 dB (doubled). These switches are labeled 
SW1, SW2, SW3, and SW5. (SW4 is elsewhere on the board.) Place the switch in the 0 dB position 
for normal gain. Otherwise, place the switch in the 6 dB position. There are 32 switches, one for 
each channel, 1L, 1R, 2L, 2R, and so on, up to 16L and 16R.

These switches affect only input gain. With the additional gain, source inputs are limited to 
+18 dB.

Mute Detection
The analog audio input card also has a mute detect enable jumper (J21), labeled ‘Mute Control’. 
When the analog audio input level drops to –78 dB or lower for more than 0.25 per second, the 
output sample values are replaced with digital silence. This jumper affects all inputs on the card 
globally. The ‘ON’ position activates mute control; the ‘OFF’ position deactivates mute control. 

Figure A-3 shows the location of the DIP switches for the analog audio input card. 

Figure A-3. Analog Audio Input Card Switch and Jumper Locations
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Operating Levels
Both the analog input card and the analog output card have an additional DIP switch that can 
be used to match the operating level of your facility. For example, if the incoming signal oper-
ating level is +24 dBu, the card can be set to +24 dBu. By matching the incoming signal level, 
there is less degradation of the signal when it is converted to digital for internal routing in the 
router. Operating levels can be set for +15 dBu, +18 dBu or +24 dBu. 

The DIP switch is SW4 on the input card and S1 on the output card. Only the first two switches 
on the DIP are used for the operating level. The following shows the switch positions for each 
operating level:

By default, all switches are set to ‘OFF’ and the operating level set to +24 dBu. 

Figure A-4 shows the location of the DIP switches for analog audio output card: 

Fig. A-4: Analog Audio Output Card Switch Locations

Switch 1 Switch 2 Operating Level (Max)

Off — +24 dBu

On Off +18 dBu

On On +15 dBu
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Analog Video Conversion (AVC) Card Switches
Analog Video Conversion (AVC) Card Switches

AVC Input Card
The AVC input card (EM0432) receives composite analog video (NTSC or PAL) and converts the 
signal to SD format for delivery to the motherboard. The AVC output card (EM0433) receives SD 
formatted signals from the motherboard and converts them to composite analog video outputs 
in NTSC or PAL format. Because the color space for SD signals differs from that of composite 
signals, the absence or presence of pedestal in NTSC signals must be accommodated if color and 
luminance information is to be maintained. DIP switches are provided to preserve, as well as 
possible, the color and luminance integrity of signals processed by AVC cards.

Although composite PAL and NTSC inputs can be applied to and simultaneously routed by the 
AVC input card (EM0432), all NTSC signals must be in the same format (NTSC-M or NTSC-J). The 
8-position DIP switch (S1) on the AVC input card configures the card to process NTSC signals 
correctly. If the incoming signals are NTSC-M formatted signals, set DIP Switch S1-1 to ON. If the 
incoming format is NTSC-J (no pedestal), set S1-1 to OFF. The ON position for S1-1 is determined 
by the markings on the body of the DIP switch. 

Figure A-5 shows the location of the DIP switches for the analog video input card. 

Fig. A-5: Analog Video Input Card Switch Locations
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The remaining seven switch positions (S1-2 through S1-8) are not used. Switch S1-1 settings 
have no effect on PAL signal processing.

AVC Output Card
The AVC output card (EM0433) has three 8-position DIP switches, labeled S1, S2, and S3. Switch 
S2 is not used. The S1 and S3 switches (labeled ‘User Settings’) configure each of the 16 outputs 
for the correct NTSC output format (pedestal or no pedestal).
All 16 outputs on each output card must have pedestal settings that match the pedestal 
settings on the AVC input card. For example, if the input card’s S1-1 is set to ON, then the output 
card’s S1 and S2 must have all 16 switches set to ON. Refer to the silk screen markings on the 
AVC output card to identify and set switches to their proper positions. Do not use markings on 
the actual switch bodies. 

If signals fed to the AVC output card originate from SD input cards, then each output can be 
configured for pedestal or no pedestal (NTSC-M or NTSC-J) composite outputs. DIP switches S1 
and S3 have no effect when handling PAL signals.

Note

Attempting to convert NTSC-M signals to NTSC-J signals or vice versa results in large 
chroma/luma gain errors.
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Analog Video Conversion (AVC) Card Switches
Figure A-6 shows the location of the DIP switches for the analog video output card. 

Fig. A-6: Analog Video Output Card Switch Locations
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Tally Processor Connectors 

GPIO
There are two GPI connectors (inputs 1–16 and inputs 17–32) and there are two GPO connectors 
(outputs 1–16 and outputs 17–32). These illustrations show the pin-out: 

The input and output ranges 17–32 follow the same pattern.

GPI limits:
5 VDC–12 VDC (or 24 VDC with a resistor of 680 to 820 ohms).
20 mA maximum current.

GPO limits:
0.5 A at 125 VAC.
1.0 A at 24 VDC.
1.0 A maximum current.

Power
The tally processor’s power connector is a DE9 to which you normally connect the product’s 
external power supply. In case you need it, this is the pinout of the power connector: 
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Device Controller Connectors
Device Controller Connectors 

GPIO
There are two GPI connectors (inputs 1–16 and inputs 17–32) and there are two GPO connectors 
(outputs 1–16 and outputs 17–32). These illustrations show the pin-out: 

Inputs 17–32 and outputs 17–32 have the same ordering. These are the ratings:

Inputs Outputs
5–12 VDC 0.5 A at 125 VAC
24 VDC with ext. resistor 680–820W 1.0 A at 24 VDC
20 mA max 1.0 A max

The inputs are not used by master control, but may be used for other purposes. 

Serial Connectors
The DC21 device controller has 4 serial ports. Each of the 4 serial ports has this pinout: 

The DC21 supports RS-422 or RS-232 communication.

I/O Connectors

BNC Connectors
The master control frames (and MCPMs) uses BNC connectors for analog video, digital video, 
and unbalanced AES audio signals. To connect your equipment to the NV5100MC, you should 
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use high quality connectors and cable, and install the connectors using the manufacturer’s 
recommended methods and tools.

Note: BNC connectors used to connect signals to the frame should have a characteristic 
impedance of 75Ω. This is especially critical for SD-SDI and HD-SDI video signals. 

Fig. A-7: Connections (Unbalanced)

MCE backplanes use 1.0/2.3 coax connectors for many signals. The coax connectors can be 
considered a miniature version of the BNC.

DB25 Connectors
Analog audio connections use DB25 connectors. The backplane receptacle has female sockets; 
the connector on the mating cable has male pins. Each DB25 connector accommodates 4 stereo 
pairs or 8 mono channels:

Fig. A-8: DB25 Connections

Each analog audio input card has four DB25 connectors. Thus there are 16 stereo channels or 32 
monaural channels on each input card. (DB25s on output cards have the same pinouts.)

Customers can use Miranda breakout cables (WC0053) or create their own cables. 
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WC0053 Breakout Cable
Phoenix Connectors 
Some backplanes use 3-pin Phoenix connectors. The backplane receptacle has female sockets; 
the connector on the mating cable has male pins: 

Fig. A-9: Phoenix Connectors (Balanced)

These are also called twisted pair connectors because the + and – inputs are usually a 
twisted pair.

NOTE: Although, for reliability reasons, it is not good practice, you can connect coaxial cable 
to balanced (Phoenix) input connectors. Connect the shield of the cable to the GND terminal 
of the plug connector, and the center conductor to the “+” terminal of the plug.

WC0053 Breakout Cable 
You can use Miranda’s WC0053 DB25 breakout cable for any purpose that suits you. This table 
maps the color of the cable bundles to the pins of the connector: 

If you use the breakout cable for the GPI/Alarm connectors of control panels, Table  on page 75 
shows the mapping of the bundles to GPI and alarm functions.

+

–

GND

�

�

�=
	

5%!���

Bundle Jacket Color

DB25 Pin

Red (+) Black (–) Drain

1 Brown 24 12 25

2 Red 10 23 11

3 Orange 21 9 22 Pin 13 is not used

4 Yellow 7 20 8

5 Green 18 6 19

6 Blue 4 17 5

7 Violet 15 3 16

8 Gray 1 14 2
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Panel Cutouts
These patterns are for legacy equipment.

If you want to cut a hole in your console top in which to recess the control panel, use these 
simple patterns for the cuts: 

Your table surface must be about 1″ thick and rigid. The control panel rests on the console 
surface. You do not have to fasten it to the console surface. A sheet metal console surface will 
not work well.
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NV9000 Integration
Figure A-10 shows the profile of the FFCP or CFCP as mounted in a recess: 

Fig. A-10: Side View of the FFCP, inset in the Console Surface.

NV9000 Integration 
If master control is used with an NV9000 router control system, connected routers may be used 
as pre-selectors “ahead of” NV5100MC inputs. 

The benefits of integrating the NV5100MC and an NV9000 system include:

• Thousands of inputs (depending on the external router sizes). 

• Router source names appear on buttons (because of integration). 

• The control panel can control the upstream pre-router. Router information is displayed on 
the control surface.

• The ability to fire router salvos (with or without channel change) from the control surface.

• SNMP monitoring for MCPMs and MCEs (a licensed option).

Generally, the following steps are required to link master control and NV9000:

• Establish a network connection between the NV9000 and the master control frame. 

• Make the required configuration changes to the NV9000 database to support master con-
trol. 

• Configure IP addresses for the NV9000 controller(s) in the master control panels. 

• Add NV9000 source, destination, and salvo IDs to MCPM and MCE configurations. 

The following MasterConfig pages include NV9000 settings:

• General Settings. • Main Sources.

• Over Sources • External Router Sources
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In the MCS Panel Configuration Editor, use the ‘NV9000 Settings’ page to specify the NV9000’s IP 
addresses. Its ‘Channel Selection List’ page uses NV9000 salvo IDs.

Application Tips 

Multi-Channel Monitoring
With many stations running multiple channels of master control, video and audio monitoring 
can become an integration nightmare. One master control feature can help alleviate this issue. 
Because master control frames support internal multi-format routers, space can be allocated for 
a small monitor router in addition to the master control channels. The monitor outputs of the 
MCPM and MCEs can be “re-entered” into the system via router input modules. Router output 
cards then drive video and audio monitoring equipment. If you are using an NV9000 router 
control system, monitor switching can be integrated in the control panel, alleviating control 
system interfacing issues.

An NV9000 router control system, with an appropriately configured NV96xx control panels, 
allows operators to select individual channels for monitoring with the push of a button. Two or 
three channels of master control and the required routing hardware will easily fit into a single 
NV5100MC or NV5128-MC frame. Note that EM0374 router control card(s) are required, instead 
of EM0414 clock cards. 

The router control cards support a wide range of interface protocols allowing operation with 
either the NV9000 router control system or those of several other manufacturers. 

Fig. A-11: Multi-Channel Monitoring

Using Router Buses as Pre-Select for Master Control
Unused output slots within the master control frame can be used to expand the range of 
sources available for master control. Applications where the squeezeback background input 
changes often, or where there are large numbers of key sources to handle can be much easier to 
manage using router buses as pre-select for master control.

When used with an NV9000 router control system and larger external routers, such as the 
NV8256 for digital/analog video and NV7256 for digital/analog audio, access to all equipment 
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within your facility is possible. Control panel buttons will display source mnemonics pulled from 
the NV9000 database.

Each squeezeback configured can have its own unique background source. In most cases this 
will be single input. For applications where the background source changes frequently, setting 
all squeeze configurations to use the same source which is then driven by a router destination 
can simplify operation. NV9000 salvos can be set up to switch background sources as part of the 
squeeze function.

Driving the external key and fill inputs of one or more of the 3 master control keyers with router 
buses allows the operator simple access to a large number of sources. A hybrid mix — one or 
two of the keyers with fixed sources for quick access, and the remaining keyers fed from router 
outputs for versatility — can provide enhanced functionality without complexity.

Router outputs may be switched using the X-Y style router control panels. A NV96xx control 
panel can provide single-button access to external sources.

Linking Two MCPMs as Primary and Backup
You can use the external video and audio bypass inputs to provide a form of redundancy for the 
master control system, by cross-connect two MCPMs or MCEs, as shown in Figure A-12. 

The bypass relay within the MCPM or MCE will switch to the bypass input when a fault occurs. 
(Or you can switch over manually using the toggle switch on the front of the MCPM or MCE.) 
Control functions for the two MCPMs can be configured so that the two track each other as the 
operator performs transitions to air. If automation is used, a separate connection from the auto-
mation system to each MCPM or MCE is needed.

This approach does not prevent using the backup processor as a second channel occasionally. 
Its program outputs can be used to provide a second program feed when backup operation is 
not needed. Although this is not shown here, routing functions could be used to allow a single 
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MCPM or MCE to act as a backup for several others. A salvo within the control system could then 
route the appropriate video and audio signals as shown in Figure A-12. 

Fig. A-12: Connecting Two MCPM-SDs (or -HDs) as Primary and Backup

Misc. Connectors

Frame

Control Port Connectors 
The master control frame has two sets of these connectors — one for the primary control card 
and one for the redundant control card. 

CTRL1, CTRL2 DIAG
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Router Control Card
At the front of the EM0374 router control card is a DE9 diagnostic port:

An alternative to the 9-pin diagnostic port is the Phoenix 3-pin “console” port immediately 
above it. Note that GND is at the top and Tx is at the bottom of the Phoenix connector. (The pins 
are labelled on the PCB.)

On the DE9, pins 1, 4, and 6 are tied together and pin 9 is not connected. 

MCPM Connectors

Aux Connectors 
There are two forms of the aux connector: DB15 for the MCPM-MK-SD and -HD, and a DB25 for 
the MCPM-SD, -HD, -HD2, and -SDHD. 

DB15 DB25 

GPI and GPO here stand for general purpose input and output, respectively. The bypass termi-
nals are connected to the MCPM’s emergency bypass relay. The LTC (linear time code) inputs are 
unused.

Metadata 1 carries decoded Dolby E metadata from the program bus. Metadata 2 carries 
decoded Dolby E metadata from the preset bus.

The MCPM-MK-SD and -HD have no Dolby E audio and therefore no metadata outputs.
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Meter and Monitor Connectors 
All MCPMs have an digital output port for metering and monitoring: 

The MCPM-SD, -HD, -HD2, and -SDHD also have an analog output connector for metering and 
monitoring: 

The MCPM-MK-SD and -HD do not.

Automation Connectors 
All MCPMs have an automation connector: 

(The protocol is RS-422.)

Diagnostic/Configuration Connector
At the front of each MCPM is a DE9 diagnostic and configuration port:
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Misc. Connectors
The protocol is RS-232.

An alternative to the 9-pin diagnostic port is the Phoenix 3-pin “console” port, either above or 
below the DE9 connector. Note that GND is at the top and Tx is at the bottom of the Phoenix 
connector. (The pins are not labelled on the PCB.)

On the DE9, pins 1, 4, and 6 are tied together and pin 9 is not connected. 

MCE Core Connectors

Aux Connectors 
The MCE has a DB25 auxiliary connector: 

GPI and GPO here stand for general purpose input and output, respectively. The bypass termi-
nals are connected to the MCPM’s emergency bypass relay. The LTC (linear time code) inputs are 
unused.

Automation Connectors 
All MCPMs have an automation connector: 

(The protocol is RS-422.)

Diagnostic/Configuration Connector
At the front of each MCE (-CORE card) is a 6-pin Phoenix connector that supports both the diag-
nostic and configuration ports: 

The diagnostic protocol is RS-232. So is the console protocol, but the console is not used with 
MasterDiag. It is the diagnostic part of this port to which you connect when using MasterDiag. 
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MCE AXM Connectors 
The MCE-AXM has unusual connectors. The signals on these 4 DB25 connectors will change at a 
later revision. The connectors are called J1–J4, J1 being at the top of the AXM backplane 
module:

The metadata connector J1 provides 8 metadata signals. The metadata pairs are compatible 
with RS-422 or RS-485 electrical characteristics. Each of the 8 metadata ports is configurable.

The other 3 connectors provide 8 AES pairs each. The 24 outputs are configurable.
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Control Panel Connectors

CP AUX
The CP AUX connector (DB15) is present, but unused, on the iMC-Panel-200 and iMC-Panel-300. 
Its pinout is not of any concern to customers.

GPI/Alarms
The GPI /Alarm connector (DB25) is the same for all hardware control panels: 

A panel produces two levels of alarm output:

• Major alarm:

A failure of any circuit board.
Failure of both power supplies.
The internal panel temperature is greater than 60°C.
(FFCP, CFCP) A detected failure of an attached transition lever arm.
(SCP) The panel has been in one of the following states for greater than 5 minutes:

a Panel restarting or panel startup.

b Panel shutdown.

c Panel restarting.

d Internal panel communication problem.

• Minor alarm:

Failure of one power supply.
Fan failure or over temperature (> 50°C).

The alarm outputs are SPDT relay terminals (NC, NO, COM) as are the GPI output terminals. 
External GPI and alarm circuits are determined by the customer. 

An alarm will clear when all of the triggering conditions are off for 5–10 seconds 
continuously. 

Power applied to the GPI inputs can be from 5 to 24 VDC, and less than 30 mA. Typically, 5 V at 
1 mA. Loads for the GPI and alarm outputs can be larger: 

Max current: 1 A
Max voltage: 125 VAC, 110 VDC.
Max capacity: 62.5 VA, 33 W.
Rated loads: 1 A at 30 VDC; 0.3 A at 110 VDC; 0.5A at 125 VAC.
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Imagestore 750 Connectors 

GPIO
This is a drawing of the GPIO connector: 

There is a GPIO adapter for this connector. The part number is GPIO-44TBA. It is a small circuit 
board with Phoenix screw terminals. 

Pinout

There are 16 GPIO pins. Any of these can be an input or an output. There are two GPIO grounds 
and a +5V and +12V input for GPIO.

Each GPIO terminal can be configured in one of 4 ways:

• GPI Input On — a positive voltage level triggers the GPI input, relative to the GPI ground 
pin(s). 

• GPI Input Off — a (nominally) zero voltage level triggers the GPI input, relative to the GPI 
ground pin(s). 

• GPI Output On — a zero voltage level, relative to the GPI ground pin(s), drives an output cir-
cuit. 

• GPI Output Off — a positive voltage level, relative to the GPI ground pin(s), drives an output 
circuit. 

�

6�

��

88

Pin Signal Pin Signal Pin Signal 

1 LTC– 16 RS485/1+ 31 LTC+

2 LTC_GND 17 RS485/1– 32 GP_GND

3 TOTAL_DC_FAIL 18 RS485/2+ 33 GPIO_16

4 GPIO_15 19 RS485/2– 34 GPIO_14

5 GPIO_13 20 RS485/3+ 35 GPIO_12

6 GPIO_11 21 RS485/3– 36 GPIO_10

7 GP_+5V 22 RS485/4+ 37 TOTAL_DC_FAIL

8 GP_+12V 23 RS485/4– 38 GPIO_9

9 GPIO_8 24 GND 39 GPIO_7

10 GPIO_6 25 GND 40 GPIO_5

11 GPIO_4 26 GND 41 GPIO_3

12 GPIO_2 27 RS232A_TXa 

a. The RS-232 pins are reserved for future use.

42 GPIO_1

13 GP_GND 28 RS232A_CTS 43 RS232A_RX 

14 RS232B_TX 29 RS232A_RTS 44 RS232B_RX 

15 RS232B_RTS 30 RS232B_CTS 
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GPI inputs can be configured to execute “macros.” (A macro is a sequence of commands, up to 
2048 bytes, about 200 commands, such as ‘DSK 1 Fade Up’. A macro can also include GPI output 
commands.)

A GPI output can be associated with one (of several) internal conditions, such as ‘EAS Running’. 
The outputs can be configured to turn on or off when its associated condition arises.

AES I/O
This is a drawing of the AES connector: 

Pinout: 

These are balanced differential pairs. Cabling is up to customer.

However, breakout boxes are available for 110Ω and 75Ω BNCs. The part numbers are ABT-32-
32-D110 and ABT-32-32-D75 respectively. Connect the breakout box to the AES port using a 
SCSI VHDCI-68 male-to-male cable. The cable must have connectors with 0.8 mm pin spacing.

;A

68

6�

�

Pin Signal Pin Signal Pin Signal Pin Signal

1 AES_IN_1 (+) 35 AES_IN_1 (–) 18 AES_OUT_1 (+) 52 AES_OUT_1 (–)

2 AES_IN_2 (+) 36 AES_IN_2 (–) 19 AES_OUT_2 (+) 53 AES_OUT_2 (–)

3 AES_IN_3 (+) 37 AES_IN_3 (–) 20 AES_OUT_3 (+) 54 AES_OUT_3 (–)

4 AES_IN_4 (+) 38 AES_IN_4 (–) 21 AES_OUT_4 (+) 55 AES_OUT_4 (–)

5 AES_IN_5 (+) 39 AES_IN_5 (–) 22 AES_OUT_5 (+) 56 AES_OUT_5 (–)

6 GND 40 GND 23 AES_OUT_6 (+) 57 AES_OUT_6 (–)

7 AES_IN_6 (+) 41 AES_IN_6 (–) 24 AES_OUT_7 (+) 58 AES_OUT_7 (–)

8 AES_IN_7 (+) 42 AES_IN_7 (–) 25 AES_OUT_8 (+) 59 AES_OUT_8 (–)

9 AES_IN_8 (+) 43 AES_IN_8 (–) 26 AES_OUT_9 (+) 60 AES_OUT_9 (–)

10 AES_IN_9 (+) 44 AES_IN_9 (–) 27 AES_OUT_10 (+) 61 AES_OUT_10 (–)

11 AES_IN_10 (+) 45 AES_IN_10 (–) 28 AES_OUT_11 (+) 62 AES_OUT_11 (–)

12 AES_IN_11 (+) 46 AES_IN_11 (–) 29 AES_OUT_12 (+) 63 AES_OUT_12 (–)

13 AES_IN_12 (+) 47 AES_IN_12 (–) 30 GND 64 GND

14 AES_IN_13 (+) 48 AES_IN_13 (–) 31 AES_OUT_13 (+) 65 AES_OUT_13 (–)

15 AES_IN_14 (+) 49 AES_IN_14 (–) 32 AES_OUT_14 (+) 66 AES_OUT_14 (–)

16 AES_IN_15 (+) 50 AES_IN_15 (–) 33 AES_OUT_15 (+) 67 AES_OUT_15 (–)

17 AES_IN_16 (+) 51 AES_IN_16 (–) 34 AES_OUT_16 (+) 68 AES_OUT_16 (–)
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COM Ports
There are 4 COM ports, all like this: 

The ports support RS-232 or RS-422. The pinout is non-standard. Rates 9600, 19,200, 38,400, 
57,600, and 115,200. The factory default is 57,600.

There are 4 protocols: Oxtel automation, Intuition, and 2 EAS.1 

BNCs
The BNCs are all 75Ω connectors. The reference BNC is also 75Ω and is terminated internally.

For the LAN ports you don’t need detail.

Other Signals (on the GPIO Connector)
‘Total DC Fail’ is a pair of terminals. You can connect a lamp (or similar circuit) to this pair. There is 
a contact closure when DC fails within the Imagestore 750. Otherwise, the contacts are open. 
The limits are 400 mA and 25 VDC.

The connector supports 4 RS-485 ports (differential pairs). The ports operate at 115.2 kbps with 
1 start bit, 8 data bits, 1 stop bit, and no parity. The ports can be configured as inputs or outputs. 

The RS-485 ports are for Dolby metadata.

There are pins for two RS-232 ports, but the ports are disabled at present. They are for future use.

There are 3 LTC connectors (+, –, and GND).

LGK-3901, DSK-3901, and ISM-3901
The LGK-3901, DSK-3901, and ISM-3901 are small transition processors that fit in 2 slots of a 3RU 
Densité frame. The master control system treats these units as if they were Imagestore 750s. 

These units have a small backplane connector module with fewer connectors than an Imag-
estore 750. 

GPIO, LTC, AES
This a drawing of the GPIO connector: 

It supports LTC input and 4 AES inputs, 8 GPI inputs and 8 GPI outputs. 
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There are 75W and 110W terminal block adapters for this connector. The part numbers are 

• LGK-44-TBA-75, DSK-44-TBA-75

This part (the same part, but different names) has 5 BNC connectors, 4 for unbalanced AES, 
and 1 for LTC, and 2 terminal blocks for GPIO.

• LGK-44-TBA-110, DSK-44-TBA-110 

This part (the same part, but different names) has 1 BNC connector for LTC, 1 terminal block 
for balanced AES, and 2 terminal blocks for GPIO.

There are 16 GPIO pins— 8 inputs and 8 outputs. There are 8 ground pins. 

There are 4 AES input pairs (“+” and “–”).

Each GPIO terminal can be configured in one of 4 ways:

• GPI Input On — a positive voltage level triggers the GPI input, relative to the GPI ground 
pin(s). 

• GPI Input Off — a (nominally) zero voltage level triggers the GPI input, relative to the GPI 
ground pin(s). 

• GPI Output On — a zero voltage level, relative to the GPI ground pin(s), drives an output cir-
cuit. 

• GPI Output Off — a positive voltage level, relative to the GPI ground pin(s), drives an output 
circuit. 

GPI inputs can be configured to execute “macros.” (A macro is a sequence of commands, up to 
2048 bytes, about 200 commands, such as ‘DSK 1 Fade Up’. A macro can also include GPI output 
commands.)

A GPI output can be associated with one (of several) internal conditions, such as ‘EAS Running’. 
The outputs can be configured to turn on or off when its associated condition arises.
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GPIO Pinout for LGK-3901, DSK-3901, and ISM-3901

COM Ports
COM ports: There are 2 like this: 

The ports support RS-232 or RS-422. The pinout is unusual.

Rates 9600, 19,200, 38,400, 57,600, 76,800 and 115,200. The factory default is 57,600.

There are 5 protocols: (Oxtel) automation, Presmaster, Intuition, and 2 EAS. 

BNCs
The BNCs are all 75W connectors. The reference BNC is also 75W and is terminated internally.

For the LAN ports you don’t need detail.

Pin Signal Pin Signal Pin Signal 

1 GPI_IN_2 16 GPI_IN_1 31 GPI_IN_0

2 GPI_IN_4 17 GPI_IN_3 32 GND

3 GPI_IN_6 18 GPI_IN_5 33 GPI_IN_7

4 AES_IN_P4 19 AES_IN_N4 34 GND

5 AES_IN_P3 20 AES_IN_N3 35 LTC_IN

6 AES_IN_P2 21 AES_IN_N2 36 GND

7 AES_IN_P1 22 AES_IN_N1 37 GND

8 n.c. 23 n.c. 38 GND

9 n.c. 24 n.c. 39 GND

10 n.c. 25 n.c. 40 n.c.

11 n.c. 26 n.c. 41 GND

12 n.c. 27 n.c. 42 GPI_OUT_7

13 GPI_OUT_5 28 GPI_OUT_6 43 GND

14 GPI_OUT_3 29 GPI_OUT_4 44 GPI_OUT_0

15 GPI_OUT_1 30 GPI_OUT_2
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Things to Consider
Intuition XG RS-232 Port
The Intuition XG processor’s RS-232 port is a male DE9: 

The port supports RS-232. The pinout is non-standard.

Configure the rate and settings for this port using Xplay. (Choose Tools > Configure Automation 
> CQB > Oxtel over Serial.) The rate should match that of the Imagestore 750’s COM port if you 
connect the Imagestore 750 and the Intuition XG processor serially. You need a special cable or 
an RJ-45 cable with a special adapter (supplied with the Imagestore 750).

Things to Consider
Is your master control system operating under a router control system? Is it an NV9000 system? 
You will need to assign the controller(s) IP addresses on the master control network during 
master control software installation.

If you want your SNMP system to monitor MCEs and MCPMs, it is possible to do so through the 
NV9000 software. The NV5100MC MIB is available by license (part number EC9610). The NV9000 
software does not (yet) support the Imagestore 750’s SNMP option.

Up to 4 control panels may control a single MCPM or MCE. (The internal software ignores 
commands from any panel beyond four.)

A single control panel can control up to 4 channels (MCPMs or MCEs). The channels are said to 
be “ganged” in that case. A designated set of channels can be ganged automatically when the 
main channel of the gang is selected. A panel can be configured to start up with this gang 
selected.

Can your panel operators or system tolerate source bank selection? The smaller panels might 
have fewer than 16 main source buttons and therefore require a bank select button to map the 
16 “virtual source buttons” onto their physical buttons.

Router pre-select buttons are defined in MasterConfig. Router pre-select categories are defined 
the NV9000 configuration software and are selected in the MCS Panel Configuration Editor. 

How many main sources do you need? SD MCPMs allow 128 main source connections. HD 
MCPMs allow 64. MCEs allow 64. The MCPM-MK-HD allows only 16 and those apply only to the 
MCPM-MK-HD. 

A router pre-select mechanism extends the number of main sources to hundreds or thousands. 

Do you need to handle analog video input? Do you need to handle analog audio input?

Do you need to handle video with embedded audio? 

Do you need to output discrete (non-embedded) audio?

An MCE is almost certain to require a control panel that has preview buttons and aux buttons. 
The panels that support MCE features are the CECP, CECP GUI, FECP, iMC-Panel-200, iMC-Panel-
300, and iMC-Panel-GUI. An automation system might be sufficient to control an MCE. 
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The panels that can control Imagestore 750s are the iMC-Panel-200, iMC-Panel-300, and iMC-
Panel-GUI.

An important difference between GUIs and hardware panels — one that is easily overlooked — is 
the way GUI configurations are “loaded.” A hardware panel requires its configuration to be 
uploaded from the MCS Panel Configuration Editor. A GUI, on the other hand, requires a specifi-
cally named configuration file in the same folder as the GUI executable program.

For router pre-selection, master control can use up to 10 NV9000 device categories and the 
indexes within those categories. It does not recognize NV9000 category suffixes. The NV9000 
configuration must accommodate this minor limitation of the master control software. 

Although an NV5100MC frame allows up to 8 (new) SWB output cards, the older NV5128-MC 
frame also allows only one. 

If you have an MCPM-HD2 or -SDHD, MasterConfig can configure their (optional) wing outputs 
to follow program video/audio. The wing outputs on the -SDHD have more options than on the 
-HD2. There are 16 independent outputs on every wing card, but the HD2 supports these 
options only in wing slot 1. 

These are the configuration options for the wing outputs:

SDHD HD2
Router controlled Router controlled
Program video Program video
Preset video Preset video
Program audio
Preset audio

Configurers might note that MasterConfig shows “Aux Bus 1” and “Aux Bus 2” as choices. 
These are invalid options. 

An SMS7000 control system requires the master control frame to have a router control card with 
an added mezzanine SMS support card (and jumper settings). See Control Card Jumpers on 
page 178.

The tally processor functions as if it were a control panel and the presence of one or more tally 
processors limits the number of actual control panels that can control a single MCPM or MCE. 
(An MCPM or MCE can communicate with a maximum of 4 panels.)

MCEs do not accept analog video input. SD MCPMs do. Analog video input is not defined for HD, 
so HD MCPMs do not. 

DIN-to-BNC breakout panels are available. The part number for these 1RU panels is NV5100MC-
BOP. Each BNC connector on the panel is coupled to a 2 m cable with a 1.0/2.3 DIN connector.

Power Cords
Power cords differ depending on your location. Note that the power cords supplied with this 
equipment provide the only means of AC power disconnection. The socket (outlet) must be 
near the equipment and must be easily accessible.
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Power Cords
The North American power cords supplied with this equipment have a molded grounding plug 
(NEMA 5-15P) at one end and molded grounding receptacle (IEC 320-C13) at the other end. 
Conductors are CEE color-coded: 

Operation of this equipment at voltages exceeding 130VAC will require power supply cords 
which comply with NEMA configurations. 

The International power cords supplied with this equipment have a molded grounding recep-
tacle (IEC 320-C13) at one end and stripped conductors (50/5 mm) at the other end. Conductors 
are CEE color-coded: 

Other IEC 320-C13 type power supply cords can be used if they comply with the safety regula-
tions of the country in which they are installed.
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Async AES, 
Sync AES

Synchronous AES occurs when all AES signals are tied to a common 48kHz reference signal. 
Asynchronous AES signals are not. 

AVC Analog Video Conversion. Certain NV5100MC devices perform simple conversion to create an 
SD-SDI digital output signal from a composite analog video input.

The term also means the conversion of an SD-SDI signal into an analog composite video output 
signal. Path delay and subcarrier phase might not be precisely maintained in an AVC conversion 
path within an NV5100MC frame. 

AVC coding provides a cost-effective method to provide feeds to picture monitors without 
requiring an external conversion device. AVC modules are not a substitute for professional-
grade format converters.

Backplane Modular, rear-mounted assemblies containing NV5100MC input and output connectors.

Clean Feed An output that contains program content minus some or all of the program layering. The clean 
feed signal is directed to a clean feed output at the rear of the MCPM.

CECP Compact Enhanced Control Panel. 

CFCP Compact Full-Function Control Panel. 

Control sur-
face

An inclusive term representing any control panel, hardware or software. 

DARS Digital Audio Reference Signal.

DB25 A common 25-pin subminiature D connector.

DC21 A third-party device (1RU) used by master control systems to execute device control functions.

DE9, DB9 A common 9-pin subminiature D connector.

EIA-422 Sometimes called RS-422 or TIA/EIA-422-B. A bidirectional serial communications standard. The 
use of this term implies that Miranda references to the latest standard in effect at the time the 
product was developed.

FECP Full-size Enhanced Control Panel. 

FFCP Full-Function Control Panel. 

HD, HD-SDI HD and HD-SDI are equivalent terms in our documents. An HD-SDI signal is a high-definition, 
serial digital video format that conforms to the SMPTE 292M standard.

Imagestore 
750

A 1RU master control transition processor. 

iMC-Panel-
100

A 3RU rack-mountable control panel with separate display. 

iMC-Panel-
200

Compact control panel. 

iMC-Panel-
300

Full-size control panel. 
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iMC-Panel-
GUI

Software control panel. 

Intuition XG Intuition XG is a combination of a video, audio, and graphics processor and Xmedia software. 

IP address A 32-bit number that identifies a device on a network. The address is usually expressed as 4 
octets, in decimal notation, joined by periods (e.g., 192.168.7.20). (Although IP means “internet 
protocol,” here we just mean network address.)

Key, keyer A video image (called the fill) generally coupled with another video image (the “cutter”) to be 
overlayed, possibly with transparency, on the program output. The cutter is a mask that hides or 
reveals pixels in the fill according to the brightness of the pixel in the cutter. Some keyers do not 
have separate key images. These keyers self-key, that is, the image is masked according to the 
luminance values in the fill image itself. Keyers are subject to transition type and transition rate.

Layer One of the video output components (main source, 2 logos, 3 keyers, and squeezeback). The are 
called layers because of their visual priority. Functions to the right, on the control surface, have 
priority.

Logo A graphics file (static or animated) that either contains a distinct key (or cut) layer or can “self-
key” from its luminance data. Logo files acceptable to an MCPM are converted from files in 
common graphic formats (TIF, GIF, JPEG, TGA, BMP, PNG). Animation source files must be Targa 
(TGA) files.

MCE Master Control Engine, an advanced MCPM model. The MCE is modular, occupying from 1 to 3 
card slots. 

MCPM Master Control Processing Module. A master control switcher. There are several models: MCPM-
SD, MCPM-HD, MCPM-HD2, MCPM-SDHD, MCPM-MK-SD, and MCPM-MK-HD, and MCE.

Module In the NV5100MC, modules are input cards, output cards, or control cards that fit in the slots of 
the NV5100MC frame. Modules are inserted from the front of the frame and are distinguished 
from backplanes which are mounted at the rear of the frame.

Reference 
Signal

A timing signal used to synchronize events such as the switching of video signals during a 
specific portion of the vertical interval. Reference signals are externally applied. In their absence, 
signals generated internally (by a control card) are used to sustain operation.

RJ45, RJ-45 Registered jack, type 45. A common 8-pin modular plug and/or jack used in the telecommunica-
tions and broadcast industry to transport Ethernet or machine control signals.

SD, SD-SDI SD and SD-SDI are equivalent terms in our documents. An SD-SDI signal is a standard definition, 
serial digital video format that conforms to the SMPTE 259M standard.

SDI Serial digital interface. 

Squeezeback A process in which the program video is either (1) reduced in size or (2) cropped and possibly 
repositioned so that an additional video image (the background) can be displayed in the 
program output. Squeezeback is subject to transition type and transition rate.

Sync AES See Async AES.

Transition The process by which the MCPM moves the content of the preset bus (source and layers) to the 
program bus. Transitions are governed by transition type and transition rate. In flip-flop mode, 
the contents of the buses swap; In flip-only mode (so called), the buses are identical after the 
transition.

Vertigo XG A single- or dual-channel HD/SD graphics processor.

XG Dash-
board

Configuration tool for Intuition XG. 
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XMedia A collection of configuration and creative software used with Intuition XG. 

Xbuilder “Template population” and “promo timeline control” software for Intuition XG. 

XPlay A “media event sequencer” used to configure the Intuition XG and to manage clips. Xplay must 
be running on the Intuition XG processor for correct operation under master control.

Xstudio “Template creation” software for Intuition XG. 
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Contact Us
Miranda Technical Support
For technical assistance, please contact the Miranda Technical Support center nearest you:

Corporate Head Office
Miranda Technologies Inc.

3499 Douglas-B.-Floreani, St-Laurent, Quebec, Canada H4S 2C6

Telephone: 514-333-1772

Fax: 514-333-9828

Web: www.miranda.com

Americas
Office hours: 9:00 a.m. – 9:00 p.m. (EST)

Telephone: +1-800-224-7882

Fax: +1-514-335-1614

E-mail: techsupp@miranda.com

Europe, Middle East, Africa, UK
Office hours: 9:00 a.m. – 6:00 p.m. (GMT)

Telephone: +44 118 952 3444 

Fax: +44 118 952 3401 

E-mail: eurotech@miranda.com

France
Office hours: 9:00 a.m. – 5:00 p.m. (GMT+1)

Telephone: +33 1 55 86 87 88

Fax: +33 1 55 86 00 29

E-mail: eurotech@miranda.com

Asia
Office hours: 9:00 a.m. – 5:00 p.m. (GMT+8)

Telephone: +852-2539-6987

Fax: +852-2539-0804

E-mail: asiatech@miranda.com

China
Telephone: +86-10-5873-1814

E-mail: asiatech@miranda.com
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